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INTRODUCTION 
 
Welcome 
 
We are pleased to present the latest edition of the DT Max user's manual. 
 
This guide comprises various sections designed to simplify the learning curve for 
newcomers and to give experienced users a reliable reference tool. 
 
This preamble is followed by a brief look at the main components of DT Max while the 
sections that follow deal more thoroughly with the specifics of installing, setting up 
and running the program, including an overview of some of the program's most 
valuable features. 
 
Next is a series of tax-related training guides. This section now contains a third 
component in light of the recent addition of the T3 trust program to our range of tax 
compliance products. 
 
The last section of this manual pertains to software support. It explains how to get 
assistance with any problems or questions you may have regarding the program, and 
introduces the most important support tool of all, the DT Max knowledge base. This 
manual is an abridged version of our online knowledge base, which is the most 
complete and up-to-date resource at your disposal. It is the core of our software 
support service and serves as an information database, a training tool and a help 
resource all at once. We strongly recommend that you take the time to familiarize 
yourself with the DT Max knowledge base and make it your preferred method of 
support. 
 
Our knowledge base includes a wide variety of frequently asked questions (FAQ's), 
some of which have been integrated into this manual and are identified by a small 
arrow in the left-hand margin. 
 
We also recommend that you sign up for the Dr Tax email list to be notified of 
program updates and other important news.  
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About DT Max  
 
The About DT Max option on the Help menu provides you with copyright, version and 
licence information. As per Windows standards, it identifies the copyright holder, tells 
you what version of the program you are using, and allows you to review the rights 
and obligations associated with your licence.  
 
From there, select the option Read licence agreement to see the Dr Tax limited use 
software licence agreement. 

 
The three screens  

 
When using DT Max, there are three screens to monitor.  
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In the program, these three windows are represented by the following three tabs:   
 

 
 

 The first tab displays the client list. This list comprises all the clients that 
you have on this database. These may be individuals, corporations, or trusts. You may 
customize this list per your preferences, within the options available in the 
customization feature.  
 

 The second tab is the data entry screen for your client's tax information. 
Note that if you check your client list, the cursor will be sitting on the name of that 
particular client. This is where all the tax information is entered for this client's file. It 
includes the annual tax information entered by the tax preparer as well as the 
permanent data, and the historical and carryforward information entered automatically 
by DT Max for reference in future years.  
 

 The third window displays the tax return, thus allowing you to see the 
results of the tax calculations. To refresh the results, simply click that window. If you 
are not using a large monitor, you may prefer working in full-screen mode. To do so, 
click the box in the upper right-hand corner of the screen.    

 
Customization  

 
When DT Max is first shipped, a number of customizable features are preset in order 
to enable users to get started as quickly and smoothly as possible, the user’s defaults.  
 
To use the program efficiently, ensure that these settings meet your preferences. 
Some can be changed by using a keyword in a client's file but this way of proceeding 
should be exceptional. To view or change the preset default values, select User's 
defaults from the Preferences menu, or press [Alt+F2].  
 
Client information 
When preparing tax returns, certain fields require the entry of the same value. To 
eliminate the need to make the same entry repeatedly, some of them appear as client 
information settings. These can always be changed with the proper keyword in a 
client's file, as required.  

                                                                                                                       3
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They are:  
 
� Province of residence (T1) 
� Province or jurisdiction of head office (T2) 
� Type of corporation (T2) 
� Province of residence of trust (T3) 
� Type of trust (T3) 
� Language of client (T1, T2, T3) 

 
 
Tax calculations 
The Tax calculations tab is where DT Max enables you to select settings in compliance 
with your firm's requirements. These features are:  
 
� Calculation of instalments / overpayments (T1, T2) 
� Processing of March instalments / overpayments (T1) 
� Select EI earnings default (T1) 
� Automatic calculation of old age security pension (T1) 
� Claim ITC refund if possible (T1, T2) 
� Optimize provision for taxes (T2) 
� Automatic conversion - $US to Can. $ (T1) 

 
Tax return 
The Tax return tab enables you to select what you want DT Max to print and in what 
manner. Choose appropriate settings for your firm in the following categories:  
 
� Mailing address (T1, T2, T3) 
� Phone number (T1, T2) 
� Authorization form (T1, T2, T3) 
� Type of preparer of tax returns (T1) 
� Print balance due in "amount enclosed" field (T1, T2, T3) 
� Print refund code to claim refund (T2, T3) 
� CRA allowed to share information with Elections Canada (T1) 
� Print address of firm on client letter and invoice (T1) 
� Print current date wherever a signature is required (T1) 
� Number of prior years to show on summaries (T1, T2, T3) 
� Display the tax planning summary (T1, T2, T3) 
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Miscellaneous 
 
� New client number range (T1, T2, T3) 
� Verification requirements (T1, T2) 
� Enable sorting where possible (T1, T2, T3) 
� Display format of numbers (T1, T2, T3) 
� Display company logo (T1, T2, T3) 
� Show as “Inactive” (grey) any files not accessed in past 2 years (T1, T2, T3) 

    
 

The client list  
 

The client list is a list of all the clients appearing in a database.  
 
The list of T1 clients defaults to viewing clients by family unit, whereas the list of T2 
clients defaults to viewing clients by corporation and the list of T3 clients defaults to 
viewing clients by trust. In either case, simply make a selection from the options 
offered in the drop-down box to change the way in which clients are displayed.  
 
You can also click the drop-down menu titled Filter list to view clients by groups, 
assembled by DT Max according to your filter setup.  
 
You may customize the items that appear in the client list by clicking the Customize 

client list icon  or by selecting this same option from the Preferences menu. Note 
that you may only customize the client list when it is active (title bar highlighted).  
 

Data entry  
 

Enter all your client's information in his/her tax file through the data entry screen.  
 
All information is entered with keywords, which are like index abbreviations designed 
to help identify the information.  
 
When you create a new file, you are taken to the SmartStart input assistant where you 
simply tick the sections (tax topics) that are relevant to your client and then work 
through the data entry keywords displayed in each of these sections.  
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Tax return display 
 

When DT Max displays a tax return, it first runs the calculations using the keyword 
data that has been entered, and then places the return on the print queue. Once a tax 
return is on the print queue, it can be displayed on the screen in exactly the same way 
that it would be printed. This enables you to do most of your verification on screen 
before investing the time and cost of printing the return. You must however ensure 
that all the documents you print for filing purposes meet the governments' respective 
requirements.  
 

Efiling tax returns  
 

Efile (electronic filing) is the transmission of a tax return in electronic format to the 
government. It is basically an alternate way of filing income tax returns, which enables 
you to transmit a return directly from your computer. There is no need to print a 
paper copy of the tax return for the government.  
 
The main benefits of efile are:  
 

• Costs reduction from savings on paper, printing, photocopy and mailing.  
 
• Decreased investment of time and energy with assembly being virtually 

eliminated from the process.  
 
• Increased accuracy in the tax return data. In effect, the main source of rejection 

consists in data entry errors at the CRA and RQ levels. With efile, data entry 
errors are inexistent. Furthermore, the efile system performs a series of 
computer checks and balances intended for greater accuracy. It also allows the 
preparer to detect and fix errors before assessments are generated.  

 
• Speedy acknowledgment of the reception of the tax return. Acknowledgments 

confirming that the tax return is accepted and currently being processed are 
normally available between three to 24 hours after the transmission.  

 
• Efile returns are processed more rapidly than paper returns because fewer steps 

are handled manually. Refunds are usually sent within two weeks.  
 
• Efile is an electronic, environment-friendly system, which shows that your firm 

cares about avoiding paper waste.  
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T1 – individuals 
Efile is currently available for the filing of personal tax returns to the CRA (T1) and to 
Revenu Québec (TP1).  
 
T2 – corporate 
Efile is also available for the filing of corporate tax returns to the CRA and RQ (T2), 
and diskette filing ("D-File") is currently mandatory for the filing of Ontario CT23 
returns for corporations subject to corporate minimum tax (CMT).  
 

 
Printing tax returns  

 
DT Max offers the sophisticated and flexible printing system you need for your tax 
practice. With it, you can print  
 

• client keyword data to use as an interview checklist 
• customized information from the client list 
• tax returns for production 
• mailing labels 
• blank copies of all forms supported by DT Max 

 
 
Exiting DT Max  
To exit DT Max, you may follow the Windows convention of selecting Exit from the File 
menu, or click the "X" located in the top right-hand corner of your screen. If you are 
more comfortable using hot keys, you may also exit the program with [Ctrl+Q]. If you 
attempt to exit while you have unsaved data, you will be prompted to decide whether 
or not you wish to save prior to exiting. You must never quit the program by simply 
turning the computer off, nor reboot while the program is still running. Otherwise, you 
are liable to lose data, damage your database or lock files, which may prevent others 
from using DT Max efficiently. 
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INSTALLATION AND SETUP 
 
Setting up and running the program 
 

System requirements  

 
The reliability that users demand from their operating systems and applications can 
only be obtained by ensuring that their computer system is up-to-date and meets 
certain requirements.  
 
The following are the minimum system and software requirements for DT Max:  
 

Computer / Processor 
• Pentium 133 or subsequent model  

 
Memory 
For Windows 98 

• 32 Mb of RAM minimum  
• 64  Mb of RAM recommended  

 
For Windows NT  

• 32 Mb of RAM minimum  
• 64 Mb of RAM recommended  

 
For Windows XP, Windows 2000 

• 64 Mb of RAM minimum  
• 128 Mb of RAM recommended  

 
Approximate disk usage 
1 year  

• 20 Mb  
• + 4 Mb per year installed  
• + 10 Mb for the knowledge base, per language, for the current year 
• + 3 Mb for the knowledge base, per language, per additional year 
• Additional space is required for the client database.  
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Display 
Settings  

• 16-bit colour (65536 colours) and 800X600 resolution or better required 
• 1024X768 resolution recommended  
 

Printer 
Windows compatible, with graphics capability  
 

• If printing less than 120 tax returns:  
Fast inkjet or laser printer with minimum 2 Mb of RAM, 4 Mb 
recommended   

 
• If printing between 120 and 300 tax returns:  

Workgroup style laser printer with minimum 8 Mb of RAM                   
 
• If printing more than 300 tax returns:  

Network-ready laser printer with minimum 16 Mb of RAM                   
 

Modem (for efile only) 
Windows compatible 28.8 K or faster, quality internal modem recommended. 
Internet access is highly recommended.  
 
Software 
• Windows 98, Windows NT 4.0 (with Service Pack 6a), Windows 2000, Windows 

XP, Windows ME (Millennium Edition) or subsequent. Note that DT Max will not 
run under Windows 3.1 or prior, nor under Windows NT 3.51 or prior.  
 
In order to be fully functional, the current version of HTMLHelp requires 
Microsoft Internet Explorer version 5.0 (IE5) or higher to be installed. Internet 
Explorer 6 (IE6) is included on the DT Max CD-ROM. Internet Explorer is more 
than just a browser. It is a key element of a complete and healthy operating 
system and serves as the portal to any Windows Update. You can continue to 
use Netscape or any other Internet browser of your choice.  

 
• DT Max application CD-ROM  
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Virus protection  
Many virus-protection software packages include a memory-resident protection 
program that constantly monitors your hard disk, watching for any changes made to 
executable programs.  
 
This may interfere with or prevent the proper installation of DT Max and all its 
components (including HTMLHelp) because during installation, many if not all of the 
DT Max executable files and DLL files (applications with an .EXE suffix, or application 
extensions with a .DLL suffix) are modified or replaced.  
 
It is therefore strongly recommended that before installing or updating DT Max, you 
exit all other Windows applications and disable any virus-checking program that might 
be running in the background.  
 

Installing the program  
 

In most cases, as soon as you insert the DT Max CD into the computer's disk drive, 
the install program will start to run. If this AUTORUN facility is not enabled on your 
computer:  
 

1. Click the Start button  
2. Select Run 
3. Type "D:\SETUP" and click OK. 
 

(If your CD drive is not "D", remember to substitute the appropriate letter in the 
command string above.) 
 
The install program will prompt you to indicate where you want DT Max to be installed 
and to select the features you would like among the options offered. Standard 
installation is preferable if you have no specific needs. 
 
Network installation 
In a network environment, it is preferable to install DT Max on the local hard drive of 
each workstation as installing onto a network drive would have a significantly adverse 
effect on the performance. Client databases can be located on a network drive and 
shared amongst many DT Max users. Note that a Dr Tax network licence is required.  

 
Uninstalling 
If, later, you wish to remove DT Max from your system, use the Add/Remove 
programs feature appearing in the Windows control panel. 
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Installation options  
When installing DT Max, the following options are presented to you: 
 

Language selection 
This is the language of installation only. The language chosen here will not prevent 
you from running DT Max in the other language. Currently, the language options 
are English (United States) and French (Canadian).  

 
Licence agreement 
DT Max will only run if you agree to the terms of the licence agreement.  

 
Destination folder 
You can choose the default destination folder (C:\Program Files\Dt Max) or any 
other folder you prefer.  

 
Setup type 
The option Typical determines the setup specifications for you whereas Custom 
enables you to customize them per your preferences. 

 
Components 
The following components are available for installation: 

 
T1: You can install the personal tax program for 1996 onwards. Please do so 
only if you have a valid T1 licence. If you do not, these features will only run in 
demonstration mode.  
 
T2: When installed, the corporate tax program covers years 1994 onwards. 
Please only install it if you have a valid T2 licence. If you do not, the corporate 
tax program will only run in demonstration mode.  

 
T3: If you are a licensed T3 user, you can install the trust tax program for 
years 2003 onwards.  
 
Knowledge base: The knowledge base, which includes all the DT Max help 
documentation, is available in both languages. It should be installed in at least 
one of the two. Note that if installed in only one language, DT Max help will 
not be available in the other.  

 



DT MAX USER’S MANUAL                                                             Installation and setup           
 

                                                                                                                       13
 

Demo database: Up to three demo databases can be installed: one for the 
personal tax program (T1), one for the corporate tax program (T2) and one for 
the trust tax program (T3). Please note that once installed, a demonstration 
database cannot be installed again. 
 

Desktop shortcut 
You can choose to have the install program place DT Max on your Windows 
desktop.  
 
Installing IE6 
DT Max uses the HTMLHelp system for all its online help and knowledge base 
information. In order for this help to appear as it should, Microsoft's Internet 
Explorer 4.01 or greater must be installed on your computer. You can install it from 
Microsoft's Web site or you can install a customized version from the DT Max CD.  

 
User ID and password  
Whenever you start DT Max, you are prompted to enter your user ID. This enables   
DT Max to read your user profile and recognize you as an authorized user. The user ID 
entered at the last session is remembered by DT Max, and automatically appears when 
restarting the program. If it is yours, you may proceed; otherwise, substitute your 
own user ID to the one being displayed.  
 
If the DT Max security system is operational, you may also be required to enter a 
password. The use of a password would prevent other users from logging on using 
your user ID alone. The user ID is a code of up to four characters, which differentiates 
you from the other DT Max users on the same database.  
 
If your firm requires the use of passwords, user ID's will be allocated by the system 
supervisor and set up with certain rights and privileges. Most frequently, your user ID 
will consist of your initials. The password is up to you, and you can change it whenever 
you want. If passwords are not required and you enter a new user ID, DT Max will 
consider this a request to create a new user ID and will ask you to confirm whether 
this is what you want.  
 
If you only have access to your own clients but need to be able to enter data for the 
clients of another staff member in your firm, you will be able to do so if the user ID of 
that particular staff member is marked as an accessible user ID in the security system 
setup.  
 
Because user ID's and passwords are tied to a database, you can have different ones 
for different databases, and also for the T1, T2 and T3 programs.   
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The DT Max update policy 

 
DT Max updates are released from time to time to incorporate changes in tax law, new 
forms and other program improvements.  
 
Registered users can download updates from the Internet as soon as product testing 
and government certifications have been completed.  
 
Major updates are also mailed on CD-Rom two or three times per year. Due to the 
time required for manufacturing and shipping, these updates are normally available on 
the Internet two weeks before the CD-Rom is delivered. 

 

Installing updates 
 

To install a DT Max update, download the appropriate file from the Dr Tax Web site or 
use the CD-ROM that you received.  
 
Downloading" simply means that you are transferring the program from its location on 
the Web to your own computer system. There are three ways to obtain available      
DT Max downloads: 
 
� Directly from the Dr Tax Web site;  
 
� From the DT Max program by selecting DT Max on the Internet from the Help 

menu, then clicking Downloading from our Web site; or 
 
� From the DT Max updater program by selecting Check for program updates from 

the Help menu. 
 
When you are ready to download an update, follow the steps below: 
 

1. Click the underlined link for the version you wish to download.  
 
2. A dialogue box will appear prompting you to enter your username and 

password:  
� your user name is your licence number 
� the password requested is your Dr Tax password  
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These two pieces of information can be found in your current version of DT Max by 
selecting About DT Max... from the Help menu. 
 

Click OK.  
 

If using the CD, insert it into the proper drive and let the automatic install program 
take over.  
 
At this point, simply follow the instructions displayed on screen by the DT Max 
installation wizard. DT Max remembers what location you chose when you last 
installed the program or an update, and will prompt you to select the same location 
when you need to install again. Ensure that nobody is using DT Max at the time. 
 
You will need to restart DT Max once the install process is completed.  
  

The DT Max updater program 

 
DT Max comes with a sophisticated updater program that will enable you to download 
and install updates and patches quickly and efficiently.  
 
Using the DT Max updater you can check for updates from DT Max or set it to 
automatically check for new releases at regular intervals, so you know you are always 
using the most current DT Max products. Either way, you will always be able to choose 
which updates you want to download and install.  
 
To use the DT Max updater, select Check for program updates from the Help menu.  
 

• Check for updates now 

Hit the Check for updates now button to start the update process right away.  

• Check automatically 

Tick this box if you want the DT Max updater to check for new releases at 
start-up. Select how many days should pass between each request is made.  

 
The installation of updates with the DT Max updater is completed in three steps.  
 

1. Before any download or installation is performed, the DT Max update program 
will show you the most recent releases that are available and relevant to your 
setup. Select only the updates you want by ticking/unticking them.  



Installation and setup           DT MAX USER’S MANUAL 

                                                                     16   

2. Hit "Download". Each update you selected will be downloaded to your 
computer. During the transfer, you may still work with DT Max as you would if 
you were downloading from the Dr Tax Web site.  

3. Finally, to ensure proper installation, you will be required to save your changes 
and quit DT Max. Then you can hit "Install". After the installation, the DT Max 
updater will allow you to restart DT Max with the most recent files.  

 
Tips and tricks 

• Updates marked with a star are required by at least one other selected update 
and cannot be unticked unless that other update is not selected.  

• Updates marked with the warning symbol "!" are currently unavailable. You 
may tick their respective boxes for more detailed information.  

• Updates that you have downloaded but not installed are saved on your hard 
disk so that they will not be downloaded more than once.  

 

Installing an updated licence key 

The DT Max T1, T2 and T3 tax programs are available on a 12-month subscription 
basis. Every year you are required to install a new licence entitling you to produce tax 
returns for the current tax year.  

When installed without a valid licence key, DT Max will operate in "demo" mode, which 
allows you to evaluate the software by producing tax returns for prior years. Please be 
advised that a 'DEMO' watermark will appear on all printed returns until you purchase 
a valid licence to use a fully functional version of the product.  

You will receive your licence key in the mail and/or via email after your product order 
or renewal has been processed.  

In DT Max, select Install licence key from the Tools menu. Provide the licence key 
information by entering all values (licensee name, efile number and licence key) into 
each DT Max database (T1, T2, T3) you wish to activate. 

By installing your licence key in a database, all users will be granted access to the 
program as well as all optional features for which you are licensed. Please note that if 
you are working in a network environment, you will not have to install a licence at 
each individual workstation but only for each database (T1, T2, T3).  
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If you are renewing a DT Max product with the same licensing options as the previous 
year and your licensee name has not changed, you may update your licence key via 
the Internet. Only one Internet licence download is permitted per licensee.  

Note that if you choose this option, DT Max will attempt to make an Internet 
connection to the Dr Tax server. Any required network or modem connections should 
be in place before selecting this option. Firewall software, if any, will detect that this 
Internet connection is taking place and prompt you for your permission to allow it to 
continue.  

The Internet method uses your DT Max client number and password from your existing 
licence file. If you are using a demo version of DT Max you will not be able to 
download a new licence file unless you have made prior arrangements with Dr Tax 
client services and obtained your own client number and password. 

Once a new licence key has been installed DT Max will automatically restart so that the 
new licence terms can take effect.  

To review your licence information select About DT Max in the Help menu at the top of 
the screen. If the licensee name or efile number is incorrect, if you wish to add or 
change licensing options, or should your key ever be compromised, please contact    
Dr Tax client services as soon as possible at cliservices@drtax.ca or 1(800) 663-7829.  
  

Running DT Max  

 
To start DT Max, double-click the DT Max icon on your desktop or select DT Max from 
your Windows Start menu. The logon splash screen will be displayed, with the options 
selected the previous time you ran DT Max already ticked or highlighted. These 
options are:  
 

Program 
Click the radio button corresponding to the program you want (T1 personal, T2 
corporate, or T3 trusts). If you have omitted to install a program or do not have a 
valid licence for it, that particular option will be grayed out.  

 
Language 
Select English or French as the language in which you want to run the program.  

 
Year 
Select a year among the choices available. For T1, this refers to the tax year of the 
individual whereas for T2 or T3, this refers to the calendar year of the fiscal year-
end for the corporation or trust. The years listed are the only ones available.  
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Database location 
The database locations listed will be the ones previously used by DT Max. If you 
want to use another location, type it in the entry field or click the browse icon to 
locate it and DT Max will subsequently remember it as a valid database location. To 
create a new database, enter a new location (e.g. c:\clients). DT Max will do the 
rest.  
 
User ID 
The very first time you log on, enter your user ID. When prompted to create a new 
user ID, simply click Yes.  
 
Password 
If this particular feature of the security system is enabled, DT Max will prompt you 
to enter your password. In order to prevent security violations, it will not remember 
your password from one time to the next.  

 
Help 
This button brings you to the present help document, which is part of the DT Max 
knowledge base and help system.   

 
Customization 

You can customize certain aspects of the user interface by selecting User interface 
from the Preferences menu.  

 

Client list 
Select the number of recently accessed client files that should appear on the File 
menu, from zero to 16.  
 
Data editor 
Select the colour scheme you wish to use. 
 
Keyword display 
Tick the box Always show keywords in UPPERCASE to change the default (mixed 
case). 
  
GIFI totals (T2) 
To disable this feature, untick the box Show automatically calculated GIFI totals in 
the editor.  
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SmartStart defaults 
Click Reset SmartStart default sections to restore the SmartStart sections to their 
original status. 
 
Method to select pages 
Typically, the program defaults to the method Always show index at side. If you 
wish to change the method, the following alternatives are available in the Tax 
return frame: 

• Always show index at side 

• Show index at side - auto-hide after selecting the page (recommended with 
a 800X600 screen resolution) 

• Use pop-up mode to select page pages - do not show index at side  

 
Use of colours 
By default, DT Max uses background colours to differentiate between report types, 
that is between federal and Quebec returns, diagnostics, client letters, etc.  
 
However, you can also use background colours to differentiate between family 
members, that is between family heads, spouses and dependants, or between plans 
or tax years.  
 
If you wish to change the default, simply tick the appropriate box.  
Similarly, if you do not want the tax return displayed with coloured background, 
select the radio button never - always use white background.  
 
Location of knowledge base files 
If you do not want the knowledge base path to be a subdirectory of the program 
path, which is where DT Max will place it by default, enter your designated path in 
the box.  
 
This is preferable if you want all members of a tax group or all users on a network 
to access the knowledge base from a central location. This will slightly reduce 
access speed but save significant disk space.  
 
Once this preference is entered, DT Max will remember it (a mark will be set in your 
registry) and subsequent updates will be installed in that same location.  
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Language of use 
 

DT Max is a bilingual program that you can use in either English or French. You choose 
the language in which you wish to use the program on the opening splash screen. This 
choice will be remembered by DT Max so that the next time you run the program, it 
will automatically be set to the language last chosen. In DT Max, to change the 
language of use from English to French, choose Switch languages in the File menu, or 
press [Ctrl+L]. To switch from French to English, the option is Changer de langue.  
 
The language in which you use the program does not prevent you from printing a 
return in the other language. This is governed by the language of your client, as 
defined in the client file. The default language is determined in the Preferences menu 
under User's defaults - Client information - Language of client. 
 
When displayed on the screen, a client's tax return will be in your language, that is the 
language currently chosen by the user to run DT Max, which may or may not be that 
particular client's language. Correspondence intended for the client will be displayed in 
his/her language.  
 
DT Max does not translate your entries. They remain in the language in which they are 
originally made.  
 
There are entirely different sets of keywords and options in English and in French 
because the keywords represent abbreviations of the purpose they serve. While 
entering data, the keywords are only available in the language in which you are 
running the program (you can see the corresponding keyword in the alternate 
language by pressing [Alt+K] on the keyword). If someone else uses the program in 
the other language and edits the keywords in the same client file, the keywords will all 
appear in the language currently being used.  

 

Tax preparer information  
 

This feature comprises three options that allow you to set up the identification profile 
of the individual or firm preparing the tax returns. The name and address of the tax 
preparer will appear exactly as entered on the client letter, the invoice, the 
authorization forms and the efile forms, if any.  
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The address will also be used as the "c/o" address on page 1 of the T1 tax return (see 
the keyword CARE-OF), if the option selected for the keyword MAIL-ADDRESS was the 
accountant's address. (Note that MAIL-ADDRESS can be used in a client's data to 
override the address entered in this setup.) This same address will be printed on the 
fourth page of the T1 and TP1 forms if you selected Professional tax preparer as the 
setting for the Type of preparer of tax returns option of the printing defaults, within 
the user's defaults menu.  
 
The address information setups are intended to provide you with default values. These 
may be overridden on an individual basis using the FIRM-ADDRESS keyword, which 
incidentally can also be set to Never show address of firm.  
 
You may set up two distinct addresses for the tax preparer, namely the main address 
and an alternate address.  

 
Main address of tax preparer 
This should be the address used most frequently. Simply enter all available 
information in the fields provided to that end.  

 
Alternate address of tax preparer 
This allows you to set up a different address to be substituted to the main address 
at your convenience. Fill out the alternate address information in the same fashion 
as for the main address then select the condition under which you would like the 
alternate address to be used.  

 
In Identification numbers, enter all information available, where applicable.  

 
If there are several trustees in your firm, the trustee number entered as the default 
may be overridden in a particular client's data by using the keyword TRUSTEE-NUM in 
the BANKRUPTCY group.  
 
For tax preparers who are discounters, the DISCOUNT keyword may also be used to 
indicate which address is appropriate.  
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User’s defaults 

 
Print address of firm on client letter and invoice  
For the T1 program only, this box should be checked in order for DT Max to print the 
address of the firm on the client letter and invoice. However, be sure that it is not 
checked if you intend to print these documents on company letterhead, or if for any 
reason you do not want to use the name and address of the firm as entered in the 
Identification option of the Preferences menu.  
 
Authorization form  
This setting tells DT Max whether you want the authorization form (T1013 for T1 and 
T3 or RC59 for T2) printed with the tax return. It allows you to indicate the periods for 
which the authorization will apply. You can change this setting in the client's file, if 
necessary, using the keyword AUTHORIZE. The default value, however, must be 
changed in the User's defaults.  
 
New client number range  
This refers to the range of client numbers that DT Max will assign your new clients 
when you create new client files.  
 
If you run DT Max on more than one computer, or if you have more than one DT Max 
databases on your computer, it is important that you set different, non overlapping 
ranges of numbers for new clients, for each computer or database. This will ensure 
that new clients added to any of your databases have a unique client number. If you 
wish to merge different databases together, there will be no risk of different clients 
having the same client number.  
 
If you efile, it is also essential that all clients have a unique client number since the 
client number is used to build the efile document control number (DCN) for the client. 
The CRA will reject any client with a duplicate DCN.  
 
When selecting a client number range, simply enter the lowest number you want as 
the start number and the highest as the end number, keeping the above rules in mind. 
The range set pursuant to these directions only applies to new client numbers 
generated automatically by DT Max. You can always select a client number yourself 
when creating a new client file. In such a case, however, be sure to use a client 
number that will not conflict with those used in your other databases.  
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Automatic conversion of $US to Can $ (T1) 
This box should be checked if you want DT Max to automatically convert US dollar 
amounts (which it will recognize as such) to the corresponding amount in Canadian 
dollars, based on the CRA's average conversion rate. (A table of rates appears at the 
right of that dialogue box.) If the box is not checked, DT Max will assume that the 
amounts were entered in Canadian dollars. This value can be changed in a client's file, 
if necessary, using the keyword US-CONVERT. You can also modify the exchange rate 
in any group using the appropriate EXCHANGE keyword in the group. 
 
Type of corporation (T2) 
The type of corporation defined here will be the default type for all new clients. This is 
the value used for the keyword CORPTYPE. You can change it in the client's file if 
necessary. The default, however, must be changed in the User's defaults.  
 
Type of trust (T3) 
The type of trust defined here will be the default for all new clients. This is the value 
used for the keyword TRUST. You can change it in the client’s file if necessary. The 
default, however, must be changed in the User’s defaults. 
  
Print current date wherever a signature is required  
Check this box if you want DT Max to print the current date wherever a signature is 
required on personal tax returns. If you leave this box unticked, no date will appear 
unless you use the keyword SIGN-DATE in the client's file.  
 
Select EI earnings default (T1) 
For the T1 program only, this option should be used to select a default setting for 
employment insurance insurable earnings. If specific EI earnings are not entered, you 
may want DT Max to assume that they amount to T4 earnings (a typical employee 
situation) or to zero (a typical self-employed situation). However, you may also choose 
not to have a default setting, which would make DT Max prompt you to enter an 
amount. This is appropriate for users who have many clients of both types and are 
willing to enter amounts individually for every client. You can change this value in a 
client's file with EIC-EARN, but the default must be changed in the User's defaults.  
 
The CRA allowed to share information with Elections Canada (T1) 
For the T1 program only, this option tells DT Max that you want to specify whether or 
not the CRA may provide the taxpayer's name, address and date of birth to Elections 
Canada over the next 12 months in order to help keep the National Register of 
Electors up to date. If you wish to efile you must select Yes or No, as leaving the box 
blank will make you ineligible for efile. The selection can be changed in the client's file 
at any time, if necessary, using the keyword ELECTIONS. The default setting, 
however, must be changed in the User's defaults.  



Installation and setup           DT MAX USER’S MANUAL 

                                                                     24   

Print balance due in "amount enclosed" field  
This tells DT Max what you want printed in the "amount enclosed" field on the return.  
 
Calculation of instalments and overpayments (T1) 
This feature allows you to select the method you want DT Max to use when calculating 
instalments and overpayments. You can change this value in a client's file, if 
necessary, using the keyword INSTALMETHOD in the personal tax program and the 
keyword INSTALMETH.R in the corporate tax program. The default value, however, 
must be changed in the User's defaults. 
 
Claim ITC refund if possible (T1, T2) 
Check this box if you want DT Max to claim the refund of unused eligible investment 
tax credits, provided that your client is entitled to such a refund. The selection can be 
changed in the client's file, if necessary, using ITCREFUNDOV in the personal tax 
program and ITCREFUND in the corporate tax program. The default, however, must be 
changed in the User's defaults. 
 
Province or jurisdiction of head office (T2)  
This is the province or jurisdiction of the head office of your corporate client, on the 
last day of its fiscal period. DT Max will use it as a default value in the tax file of any 
new corporation, for the keyword JURISDICTION. You can change this entry in the 
client's file, or add additional jurisdictions, as required. To change the default value 
itself, however, you must make the change in the User's defaults.  
 
Province of residence of trust (T3) 
This is the province or territory of residence of the trust at the end of the taxation 
year. DT Max will use it as a default value in the tax file of any new trust for the 
keyword RESIDENCE. You can change this entry in the client’s file if need be. To 
change the default value itself, however, you must make the change in the User’s 
defaults. 
 
Language of client  
This is the language in which the material for most of your clients will be printed. Such 
material includes tax returns, diagnostics, letters to client and invoices. This value is 
used as a default for the keyword LANGUAGE in the personal tax program, the 
corporate tax program and the trust tax program. Incidentally, there are different 
settings for T1, T2 and T3, which are independent of one another. This value can be 
changed in a client's file but the default must be changed in the User's defaults.  
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User-defined logo  
You can choose to have your company logo displayed and printed on certain pages of 
the tax return. These are typically the pages which are given to your client, the 
taxpayer, and do not form part of the return which is filed with the government. Your 
company logo must be created (or saved if you already have one) as a Windows 
bitmap file (i.e. with the ".bmp" extension). To do so, you may use the Paint program, 
which comes with Windows, or any other commercial graphic software at your 
disposal. The logo will automatically be scaled to fit the available height. It is 
suggested that the height be set between 100 and 200 pixels, at 16 or 256 colours. 
 
Mailing address  
This selection tells DT Max what you want printed as the default mailing address, 
whether it will be the client's, the accountant's or another. In special cases such as 
bankruptcy and discounting, where a government does not allow you to make a 
choice, DT Max will ignore the default value selected, and print the address in 
compliance with the government's requirements. You can change this setting in a 
client's file, if necessary, using the keyword MAIL-ADDRESS in the personal tax 
program, and the keyword MAILADDRESS in the corporate and trust tax programs. 
The default value, however, must be changed in the User's defaults.  
 
Processing of March instalments and overpayments (T1) 
In the T1 program only, this feature allows you to select how you want March 
instalments and overpayments to affect the calculations made by DT Max. You can 
change this value in a client's file, if necessary, using the keyword INST-EXCEED. The 
default value, however, must be changed in the User's defaults.  
 
Currency format  
Select how you want numbers formatted on the data entry screen. You can make 
different selections depending on whether data entry is done in English or French, and 
whether the tax return is printed in English or French. The formats available are:  
 

• 12345.67  
• 12345,67  
• 12,345.67  
• 12 345,67  

 



Installation and setup           DT MAX USER’S MANUAL 

                                                                     26   

Automatic calculation of old age security pension (T1) 
For the T1 program only, check this box if you want DT Max to automatically calculate 
the amount of old age security pension received, for those of your clients who have 
reached the age of pension. If this box is not checked, you will have to enter manually 
the amount of old age pension received, for each client, using the keyword OAP-OV or 
T-SLIP. This value can be changed in a client's file, if necessary, using the same 
keywords. The default, however, must be changed in the User's defaults.  
 
Number of prior years to show on summaries  
This option enables you to select the number of prior tax years to which you wish to 
refer for comparison purposes, up to a maximum of four prior years for the T1 and T3 
programs and two prior years for the T2 program. Note that the comparative data can 
only be displayed if it is still present on the print queue.  
 
Display the tax planning summary (T1, T2, T3) 
This box must be checked if you want DT Max to display the tax planning summary 
when one or several tax plans are available. 
 
Province of residence (T1) 
For purposes of the T1 program only, this is the client's province or territory of 
residence on December 31 of the taxation year. DT Max will use it as a default value 
for every client file, for the keyword PROV-RES. This value can be changed directly in 
the client's file, and will remain until changed again. The default value, however, must 
remain unchanged for other client files being opened for the first time.  
 
Printing refund code to claim refund (T2, T3) 
For users of the T2 and T3 programs only, if an amount is refundable, use this option 
to tell DT Max how you want to claim the refund.  
 
Prevent reprinting of government copies  
In the Printing options of the Preferences menu, this selection enables DT Max to know 
at what stage of the tax preparation process you deem the tax return to be final and 
therefore want DT Max to prevent the reprinting of copies to government destinations. 
Please note that if you choose "after collating" or "after mailing", these options will not 
take effect until you provide this information to the program.  
 
Enable sorting where possible  
In the T1 program, this box must be checked if you want DT Max to sort alphabetically 
the entries that can be sorted. These include DONATIONS, MEDICAL expenses, and 
other keywords involving both a dollar amount and a description of source.  
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Show as "Inactive" (grey) any files not accessed in past 2 years (T1, T2, T3) 
Check this box if you want DT Max to show as being inactive any client files that have 
not been accessed in the past two years. These files will appear in grey.   
 
Optimize provision for taxes (T2)  
For the T2 program only, check this box if you want DT Max to determine the optimal 
amount of the provision for taxes that should be reflected in the financial statements 
of the corporation.  
 
A schedule indicating the proposed adjustments for purposes of the optimization will 
be produced. The selection can be changed in the client's file, if necessary, using the 
keyword OPTIMIZE. The default setting, however, must be changed in the User's 
defaults.  
 
Phone number (T1, T2) 
This selection tells DT Max what you want printed as the default phone number for the 
client, if applicable. You can change this setting in a client's file, if necessary, using the 
keyword PRINT-PHONE in the T1 program, and the keyword PRINTPHONE in the T2 
program. The default value, however, must be changed in the User's defaults.  
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SELECTED FAQ’S ABOUT INSTALLATION AND SETUP 

  
¾ My screen turns partially black in DT Max. You may experience some colour 

problems in DT Max if your current display values are set to 256 colours only. Most 
of today's display adapters can support 16-bit (65536) or 32-bit colour settings.  
 
It is also very important to have the most recent driver installed.  
 
To rectify this problem most efficiently, it is best to get specific instructions from 
the Web site of your adapter's manufacturer, where you can download the most 
recent adapter driver available. To find out what brand of display adapter you are 
using,  

 
1. click the Start button  
2. select Settings 
3. select Control panel 
4. select System 
5. click the Hardware tab  
6. click the Device manager tab  
7. select Display adapter. 

 
For more assistance, visit www.driverguide.com.  

 
 
¾ What is Windows Update? Windows Update is the online extension of Windows 

that helps you get the most out of your computer. It contains a catalog of fixes, 
updates and enhancements to Windows and to many programs operating with 
Windows. The catalog allows you to "shop" for components that will make your 
computer perform better.  
 

Be sure to download any Critical Updates recommended for your system. These 
critical updates will fix known problems (such as security issues) specific to your 
computer.  
 

Users of Windows 98, Windows 2000 and Windows XP 
Start the Windows Update service from the link on your Start menu.  
 
Users of Windows NT 4.0 
Visit the Microsoft Windows Update Web site. 
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¾ How do I update my device drivers? Most hardware manufacturers regularly 
release updates of these drivers to fix problems or improve performance. These 
updates are normally available on the manufacturers' respective Web sites.  
 

Procedure  
1. Highlight the My computer icon on your desktop, then click the right mouse 

button.  
 

2. Select Properties from the menu displayed.  
 

3. Click the Hardware tab.  
 
4. Your hardware devices will be listed under the Device manager tab. Click the 

"+" sign next to the type of device, then select the relevant product.  
 

5. The Driver tab provides more information about the hardware, such as the 
manufacturer's name. Write this information down as manufacturers and model 
numbers may vary even for one model of computer.  

 
6. Click Update driver and follow the instructions on the screen. Note that some 

devices don't have a Driver tab. In this case, you may be able to view 
information about the driver by selecting the icon that is specific to that 
particular type of hardware in the Control panel (e.g. the modem icon).  

 
See your hardware documentation and Windows help for more information. 

 
 
¾ How can I find out which Microsoft Windows version I am using? To find out 

which particular version of the Windows operating system you have, proceed as 
follows: 

  
1. Highlight the My computer icon on your desktop, then click the right mouse 

button.  
 
2. Select Properties from the menu displayed.  

 
Your Windows version should be indicated under the General tab, below System. 
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¾ When I open the DT Max help, why does the HTML Help viewer display the 

error message "Action cancelled" in the topic pane instead of displaying 
the desired topic? Microsoft's Security Update 896358 restricts execution of 
HTML Help files to the local machine. To correct the problem, select one of the two 
alternatives below:  

A - Install the DT Max knowledge base files (.CHM) on the local drive 
(preferably in the default installation directory C:\Program Files\DT Max\KB\). 

B - If you prefer not to install them locally, you must re-enable the execution 
of HTML Help files for the "Local Intranet" zone.  

We have compiled the fix into a registry excerpt that you can download and 
install with a simple double-click of the mouse.  

1. Download the file available at 
http://www.drtax.ca/download/public/DTMaxKB_FIX.zip.  

2. Unzip it and save it.  

3. Open the file "DTMaxKB_FIX.reg" on every computer concerned. 
Windows will merge the registry setting contained in this file into the 
registry of the computer.  

You must perform these steps on every client computer in your organization in 
order to enable HTML Help for your office.  
 
More details on this topic are available in the Microsoft knowledge base article 
found at http://support.microsoft.com/kb/892675/. 

 
 

 
Please refer to the DT Max knowledge base for more information. 
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PROGRAM FEATURES 
 
Managing the client list 
 

The client database  
 

When tax information is entered into your client's file, it is stored in the client 
database. The DT Max database is independent from the program itself. This is why 
you must indicate the desired database location on the DT Max splash screen, thereby 
telling the program where to go find it so that you can access it.  
 
You can choose the location of your database and create it in the directory of your 
choice. For instance, in the relevant field on the splash screen, you could simply enter 
"C:\Clients" and DT Max would automatically create the new directory named "Clients" 
on your hard drive.  
 
Within a database, each taxpayer has his own unique client number and is managed 
independently from the other taxpayers present in the same database.  
 
In the T1 program, the notion of family comes into play to create groups of clients 
brought together using the keyword RELATION. The database keeps not only the tax 
information pertaining to your client but also that of each of his family members. 
Then, in the client list, when you select the option Family in the drop-down menu 
located in the upper-left area of the screen, you can see the name of the family head, 
with the name of the spouse slightly to the left, and the names of dependants to the 
right. DT Max uses all the tax information available with respect to a family unit in 
order to optimize the tax results for the entire family.  
 
This data is what you will see when displaying the tax return, although some of it may 
be used in financial or tax planning.  
 
Information about a client's processing status, i.e. where the client stands in the tax 
preparation process, is also stored in the client database.  
 
The client database is a permanent record of such information. You can access it at all 
times to check up on the tax data, see what status a client has reached in the tax 
preparation cycle, verify your investment advice, or even just to locate a client's 
address and phone number or notes added to a client's file.  
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There is no maximum number of databases that can be created, used and managed. 
The only limitation stems from the fact that a client belonging to database X cannot 
be merged into database Y unless his client number in X is not currently in use by 
another client already present in database Y.  
 

The client list  
 

 
 

Three tabs  appear on all screens while working in       
DT Max.  
 

 is the first tab. It takes you directly to the client list.  
  
The fourth item on the toolbar is a drop-down box which specifies the type of display 
that is being requested. You can also indicate that you only want the print queue or 
the efile queue displayed.  

 enables you to add a new client to your database using the dialogue box that 
appears in the centre of the screen.  

 enables you to locate a client in the client list.  

 is used to show processing status information. It will bring up a dialogue box 
indicating everything you need to know about the processing status of your 
client.  

 enables you to mark the keywords and tax return as verified.  

 enables you to print the client list.  

 is used to efile a client's tax return. Personal efile (T1) and federal corporate 
efile (T2) are currently available. 

 is a customization feature used to select the items you want to appear in the 
client list.  
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The next item is a drop-down box where you can select which filter you want to use.  
 

 provides context-sensitive help which, in this case, brings up the main help 
screen for the client list.  

 

Customizing the client list  
Select Client list settings… from the Preferences menu or click that icon on the client 
list toolbar. The items that will appear on the client list may be selected by ticking the 
appropriate boxes. You may customize the client list by choosing the items that you 
want without even having to access a client's file.  
 
Some of the most popular choices for customization are the social insurance number, 
home and work telephone numbers, and processing status. Language is equally 
important if you have clients from both English and French linguistic groups, whereas 
birth dates enable you to conveniently "remember" a client's birthday. Of course, if 
numerous choices are selected, you may have to scroll to the right of the screen to 
view some of them.  
 
The order and width of each field in the list are adjustable. Click the line between two 
field names to make it wider or narrower. Drag a field title to another position to 
change its location.  
    
Family unit  
Grouping clients by family unit is essential to proper T1 optimization. It enables       
DT Max to know what income, deductions or credits can be moved from one person to 
another. The RELATION keyword specifies the relationship between a family member 
and the head of the family, whereas the keyword OPTIMIZE can be used to specify 
how you want optimization to take place within a family unit. Therefore, the T1 client 
list defaults to viewing clients by family unit.  
 
Note that when entering client information or displaying a tax return, you can click 

Open family member's file . This dialogue box enables you to go to the data entry 
screen or to display the tax return of another family member without having to return 
to the client list first.  
 
You can also create a file for a new member of the family unit, who will then be set up 
with the default values of the family. These settings are usually those of the family 
head. Then again, they can also be those of another family member if that new person 
is linked as their dependant.  
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The family grouping capabilities of DT Max have their limits and will not enable the 
entry of extended family units unless the link is made via the family head or the 
spouse.  
  
Marked clients  
Many batch processes provide you with the option to apply a particular operation to a 
selection of marked clients only. This requires you to previously scroll through the 
client list and use the Windows marking features to select every client you wish to 
include in the batch. To select a range of clients, hold down the [Shift] key and click 
the first and last items desired. To select multiple, non consecutive clients, hold down 
the [Ctrl] key and click each desired item, one at a time.  

 

Changing the accountant code  
You can change the accountant code shown on the client list by selecting the option 
Change accountant from the Management menu. Simply type in the new accountant 
code (up to four letters) that you wish to start using. Should the responsibilities of a 
staff member change (e.g. an individual leaves the firm), you can change the 
accountant code manually through the keyword ACCOUNTANT in the files of affected 
clients. If, for instance, you want the clients currently assigned to ABC to be 
reassigned to XYZ, use a filter to list ABC's clients, mark those clients, and then 
change the accountant code as explained above. Incidentally, such a change can be 
made as a batch selection for the current family, marked clients, your own clients or 
all the clients on the database.  
 
Note that it is also possible to blank out the accountant code for selected clients. In 
this case, the next accountant to access the file of one such client will automatically be 
set as the new accountant assigned to that particular client. 

 

Changing client numbers  
When you need to change client numbers, select Renumber client from the Advanced 
utilities option of the Tools menu. To change the client number for the current client, 
enter the new number you wish to assign and click OK. If the number entered is 
already in use, an error message will appear.  
 
You can change client numbers for a batch of clients such as the current family, 
marked clients, your own clients or all clients on the database. For these batch client 
selections, you will have to enter a new number range then click OK. The outcome of 
the renumbering process will be summarized in the DT Max results log.  
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Adding clients  
 

The DT Max T1 program treats all clients as members of family units in order to 
efficiently optimize their respective taxes. One member of any given family unit must 
be designated as the family head. The particular identity of the family member 
designated for that purpose is of very little importance. Note, however, that the family 
head must be entered in the database prior to the spouse and dependants. 
Incidentally, for purposes of its T2 and T3 programs, DT Max treats all corporations 
and trusts on an individual basis.  
 
Generally, clients are added to the client database from the client list. When viewing 
the list, click the right button of your mouse and choose Add new client or press [F3]. 
In the dialogue box that appears, select the type of client you wish to add depending 
on whether it will be a family head, a spouse (married or common-law) or a 
dependant. If you are adding a spouse or dependant, make sure that the cursor is 
placed on the family head.  
 
DT Max will suggest a client number to be assigned to this new client but you may 
change this recommendation freely as long as the number that you wish to use is not 
already being used for another client currently on the database.  
 
If your new client is not a member of an existing family, DT Max will treat that person 
as the head of a new family unit.  
 
The client addition is implemented by clicking OK. The program then creates an outline 
data record for this new client and puts it into the data entry screen, waiting for you to 
enter the rest of this client's tax information.  
 
Adding a spouse or dependant  
When adding a spouse or dependant to the database, DT Max will insert for you, in the 
proper fields, all the information that it can enter automatically. These are standard or 
default values. Please make sure that you verify these entries before accepting them. 
For purposes of the spouse's file, these fields are LASTNAME, RELATION, STATUS, 
SEX, PROV-RES and LANGUAGE. In the file of a dependant, no entry will be made in 
SEX. However, a blank SIN (000-000-000) will be used for that person.  
 
In addition to a family head and a spouse, DT Max allows each family unit to have up 
to 15 dependants. Because DT Max assumes that all members of a family unit reside 
at the same address, you are only prompted to enter the address for the family head 
and not for the spouse or the dependants. However, if the spouse or a dependant has 
a different address, it may be specified in that person's own file at any time.  
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Avoid entering the same address separately in the individual files of several family 
members as this would make your work difficult if a family moves. It might also cause 
mistakes to occur in the tax calculations in certain cases where you may have entered 
an address slightly differently for family members who actually reside at the same 
address.  
 

Removing clients  

 
To remove a client from the database, go to the Client list and place the selector bar 
on the client you wish to remove. From there, you may either choose Delete marked 
client from the File menu, right-click and choose Delete this client, or simply press 
[F4]. It is important that you use caution when deleting clients in order to avoid 
improper or accidental deletions. To that end, DT Max will prompt you to confirm 
whether you really want to delete the selected client.  
 
Note that if you delete a client to whom a spouse and/or dependant is attached, you 
will delete them as well. If this is not what you want, be sure to separate them prior to 
deleting. The message prompting you to confirm the deletion is most helpful in such 
cases as it indicates whether you are about to delete a single client or a whole family.  
    

Finding a client  

 
To find the client you are looking for, you can scroll through the client list but it is 

usually more efficient to use the Find client icon  (T1),  (T2, T3) or press 
[Ctrl+F], then enter the client's name, the client number or the SIN in the Find client 
dialogue box and launch the search. (Note that this search utility is automatically 
activated when you type numeric or alphabetical characters in the client list.)  

 
Searching by name 
Type in the last name of the T1 client, the company name of the T2 client or the trust 
name of the T3 client you want to locate, and make sure that the Name option is 
selected. Then, click OK or press [Enter]. If this client's name is there, the selector bar 
will place itself directly on it. If more than one client have the same name, the selector 
bar will go to the first family head having that name if the client list is displayed by 
family, or to the first person on the list having that name if the client list is displayed 
by individual. If the client name is not on the list, the selector bar will move to the 
client directly following that name in alphabetical sequence. This search starts at the 
top of the file.  
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Searching by client number 
Type in the client number of the client you want to locate and make sure that the 
Client number option is selected. Then, click OK or press [Enter]. If this client number 
is in the file, the selector bar will go directly to it. If the client number is not on the 
list, the selector bar will move to the client directly following that number in sequence.  
This search starts at the top of the file.  
 
Searching by SIN (T1) 
Type in the social insurance number of the client you want to locate and make sure 
that the Social insurance number option is selected. Then, click OK or press [Enter]. If 
the SIN is valid and appears in the file, the selector bar will go directly to it. If it is not 
a valid SIN, you will get an error message. If the SIN is valid but does not appear on 
your list, the selector bar will stay put. This search by SIN starts where the selector 
bar is positioned. To abort a search, click Cancel or press [Esc].  
    

Client filters  
 

The DT Max filter system enables you to filter your client list so that only those clients 
who match a certain set of criteria are displayed. From the Tools menu, you can select 
and define a number of different filters thereby creating a powerful system for 
accessing your client database.  
 
When a filter is in use, its name appears in the drop-down menu located at the top 
right-hand corner of the client list. This menu can be used to apply previously defined 
filters or to disable the application of a filter. By switching to the individual client list, 
all clients passing the filter will be shown. By staying in the current family list, only 
families whose heads pass the filter will be shown.  
 
Note that if your database is rather large and you are using a filter which does not let 
many clients pass through, the program's operations will run more slowly. In such a 
case, it would therefore be preferable to only use filters when necessary.  
 
Client list filter selection  
When you select the option Filter the client list from the Tools menu, a list of available 
filters is displayed. Nine different filters are available, eight of which are customizable 
while the other is predefined as Your clients only and can be applied on a permanent 
basis through the access rights granted with respect to the security system. If you 
select a filter which has previously been defined, you may choose to apply or edit that 
filter. If the filter you have selected is not yet defined, then you will only be able to 
edit it.  
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When a filter is applied, the client list will only show those clients who have passed 
through the filter, that is those who have met the criteria set for filtering purposes.  
 
To disable the filters and list the contents of all of your client database, from the Tools 
menus, select Filter the client list followed by No filter and then Apply filter, or select 
Do not filter from the drop-down menu appearing in the top right-hand corner of the 
client list.  
 
Filtering on keywords  
You can filter on up to four keywords at a time so that only the clients whose data 
contain any of these keywords will pass through the filter. For example, if you want a 
list restricted to the clients whose data include the keyword RRSP, simply enter this 
keyword for one of the filter settings and leave the wildcard symbol (*) for the other 
three.  
 
Inversely, you can use the symbol "!" in front of a keyword in order to find clients 
whose data do not contain a certain keyword. For example, entering !ELIG-ROOM as a 
filter setting will give you a list of all clients who do not have any RRSP contribution 
room available. Keywords must be typed in exactly as they exist. Abbreviations cannot 
be used.  
 
Filtering on processing statuses  
You can select up to five processing statuses to filter the client list so that clients 
whose data indicate any one of the specified statuses will pass through the filter. Click 
the Change processing status filters button to add, change or remove a status that 
was previously selected. If the wildcard symbol (*) appears on all five selection fields 
for processing status filters, no such filtering will take place as wildcards let all clients 
through with respect to the criteria for which they are used. The drop-down box titled 
These processing statuses apply to... offers additional conditions designed to limit the 
status search to federal and/or Quebec returns.  
 
Filtering on calculated tax data  
This is an advanced feature that enables you to search for clients who meet certain 
criteria respecting their tax results. The method used for defining the desired criteria 
consists in writing logical expressions using predefined variables that match specific 
values in the tax return.  
 
In filter conditions, use variables corresponding to amounts or numeric codes only. Do 
not use variables that correspond to words such as a name. At present, the variables 
and fields that can be used are those available in the client letter and in the feature 
Show fields on tax return, i. e. numbers to which you want to compare the values of 
the variables and the following operators: 
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• Mathematical and relational operators 
 

 +       add 
-        subtract 
*       multiply 
/        divide 
=       equals 
!=      does not equal 

   <       less than 
   >       greater than 
   <=     less than or equal to 
   >=     greater than or equal to 
   ( )      brackets containing an expression 

             
These operators enable DT Max to compare amounts. 

 
• Logical operators 
 

%AND  logical AND 
%OR    logical OR 

 
Examples: 

 
� To find clients with a federal balance owing greater than $1, use the client letter 

variable "%42" with the operator ">" as follows:  %42 > 1 
 

� To find clients with net income greater than $30,000 who did not have an RRSP 
deduction this year, the relevant fields are found using the Show fields on tax 
return feature and the T1 federal summary:  

 
            E11:236   net income 
       E11:208   RRSP deduction this year 
 

Use the "%AND" operator to add the second component of the filter (i.e. RRSP 
deductions equal 0):  

 
            (%E11:236 > 30000) %AND (%E11:208 = 0) 
 

Remember that the condition appearing on either side of the "%AND" operator 
must be enclosed in brackets. 
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� To find clients with self-employment income greater than $100,000 and to 
whom a capital gains deduction (super-exemption) is still available, the relevant 
client letter variables are: 

 
   %30       business income 

%31       professional income 
%32       commission income 
%33       farming income 
%34       fishing income 
%53       capital gains deduction (super-exemption) available 

 
Add up the income variables to get the total, and use the ">" operator to ensure 
that the total is greater than $100,000, as follows:  
 
   (%30+%31+%32+%33+%34 > 100000) %AND (%53 > 0) 
 
Remember that the condition appearing on either side of the "%AND" operator 
must be enclosed in brackets.  

 
It is important to note that this particular type of filter can only be used for clients 
whose tax return results are on the print queue. Incidentally, it is advisable to restore 
a backup of your current database in a "dummy" database, then recalculate all your 
clients, and apply your filter. This will keep your current database from changing the 
date under Last activity for all the clients on the client list.  
 
At the beginning of a tax season, there are few, if any, tax return results on the print 
queue for the relevant tax year. Therefore, if you wish to apply this type of filter at the 
beginning of the season, you might want to change the tax year to the previous one, 
where you should have complete tax return results. 
 
Filtering on accountant codes  
The accountant code is the four-character entry made in the keyword ACCOUNTANT. 
Filtering on any given accountant code will produce a list of all the clients matching 
this code and for whom this staff member is responsible.  
 
If you enter a wildcard (*) as a setting for that type of filter, clients with any 
accountant code whatsoever will pass through the filter. If you leave this setting blank, 
only the clients to whom no accountant code has been assigned yet will pass through. 
If your access level in the security system only allows you to work on the files of your 
own clients, you will not be able to change the setting for the accountant code filter.  
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Filtering on client birth dates (T1) 
This type of filter focuses on a specific range of client birth dates. If you wish to list all 
clients over a certain age, enter 01-01-1870 for one of the settings and enter the 
applicable date for the other one in accordance with the age range you wish to target. 
The order in which you enter the two dates does not matter.  
 
If you wish to list all clients born on a specific day or month, enter the applicable 
month and day, followed by the wildcard year 1867 in both date ranges (dd-mm-
yyyy). Having wildcards (*) as settings will let all clients pass through so long as birth 
dates appear in their files.  

 

Filtering on days since last activity  
You can use filters to identify the clients whose files have not been modified for a 
certain period of time. To that end, you may indicate the period of time you wish to 
target by specifying the applicable number of days.  
 
For example, if you are only interested in those clients whose files have been active 
during the last year, indicate "between 0 and 365 days" in the filter settings. The order 
in which you specify the two entries does not matter. Note that the range "between 0 
and 0" would refer to the current day. To filter an unspecified period of time, simply 
leave the wildcards (*) as filter settings.  
 
Editing filters  
The filter editing options are all displayed on one screen. Begin by giving the filter a 
name, preferably something unique and self-explanatory. On the client list screen, 
when that filter is applied, its name will appear in the drop-down menu located in the 
top right-hand corner of the screen. This is the name by which this filter will be 
referenced on the client list filter selection window, accessible from the Tools menu. 
When you have finished editing the filter, press [OK] to save your data. Then, you 
may apply it from the client list filter selection window or from the drop-down menu on 
the client list screen.  
 
You can create a filter using any or all of the following criteria:  
 

• Accountant code 
• Processing status 
• Days since last activity 
• Client birth dates 
• Keywords 
• Language 
• Calculated tax data 
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Helpful filter uses  
The filter system can be very useful for a variety of tasks, both during the tax season 
and year-round. Below are a few examples of practical filter uses.  

 
List your own clients or those of another ACCOUNTANT in the firm 
In a larger firm, it is useful to be able to list only your own clients, not only to 
speed up your operation of the program but also to avoid overlooking clients. This 
is particularly important on a network where many users are accessing the same 
database.  

 
List clients whose data processing is overdue 
During the tax season, you can filter out all the clients who have not yet been 
processed in order to schedule work sessions on their files.  
 
List all clients who will turn 65 years old this year (T1) 
This enables you to generate a list of clients to contact in order to discuss 
retirement income investment plans.  

 
Use filters in combination with other features  
Filters can be used with any procedure that picks up marked clients in the client list 
in order to make that particular procedure selective. For instance, filters can be 
used for:  
 

• Batch calculations 
• Printing client list data 
• Printing mailing labels 
• Printing keyword data 
• Changing accountant codes 
• Changing processing statuses 
• Extracting client data. 
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Processing tax data 
 

The data entry screen 

 
The data entry screen is divided into several sections (tax topics). All information is 
entered by using keywords, which are like index abbreviations designed to help 
identify the information.  On the status bar at the bottom of the screen appears a 
short one-line explanation of the information that the keyword is meant to bring up.  
 

 
 
Enter client information using the keyword system. When displaying a client's previous 
year information on the right-hand side of the screen, most of the keywords are 
awaiting the current year's annual information. The previous year's information 
remains on the right-hand side to enable you to compare data and make sure that you 
are aware of significant differences, if any.  
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The DT Max SmartStart input assistant 

The SmartStart input assistant is available in the DT Max keyword data editor starting 
in tax year 2003. From a client profile screen, simply tick the sections (tax topics) that 
are relevant to your client, and then work through the data entry keywords displayed 
in each of these sections. The SmartStart input assistant enables new users to become 
productive right away by instantly creating a customized input list for new clients.  

Client profile 
The client profile screen appears when you click the Client profile icon on the toolbar 
or whenever you create a new client, unless you disabled this feature. On the left 
panel of the client profile screen, select the sections that you believe to be relevant to 
your client. When you click Continue, these sections will appear in the keyword data 
editor to create a data entry page customized specifically for that client.  
 
The right panel of the client profile screen is designed for information purposes only. It 
lists the keywords available in the section highlighted on the left, thereby allowing you 
to determine whether you really wish to select that section. If you require more 
information about a keyword you see on the right, double-click it to link to the 
corresponding keyword help in the DT Max knowledge base.  
 
Certain common sections are pre-selected in the client profile when you create a new 
client. Note however that there are different pre-ticked sets for family heads, spouses, 
dependants, corporations and trusts respectively. If you wish to modify which sections 
are pre-ticked when you create a client, set up the pre-selections the way you want, 
then tick the box labelled Save as default selection for new ... (this box applies to 
family heads, spouses, dependants, corporations and trusts, as the case may be). 
Then, the next time you create a new client, you will get your own pre-ticked 
selections.  
 
If you are a seasoned DT Max user and do not want the client profile screen to 
automatically appear for new clients, simply untick the box labelled Use the 
SmartStart input assistant that appears in the new client dialogue window.  
 
SmartStart mode and data review mode 
The keyword data editor has two modes: SmartStart mode and data review mode. 
Click the SmartStart toggle icon on the toolbar to switch back and forth between these 
modes.  
 
In SmartStart mode, the keyword data editor displays the section headers that you 
ticked in the client profile. Each section header can be expanded (by clicking it) to 
show the keywords available in that section. Remember that for each section, you 
need only enter information for the keywords that are relevant to your client. Just 
leave the other ones blank. 
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You can add or remove sections at any time by clicking the client profile icon and 
ticking or unticking more sections. Note however that unticking a section will have no 
effect if that particular section already contains keyword data.  
 
The data review mode shows the client's complete keyword data without the 
SmartStart section heading. In review mode, you can still modify data and use the 
[F11] or [F8] functions to add new keywords.  
 
Compatibility with classic DT Max 
In both SmartStart mode and data review mode, you can still use [F11] to directly 
type the keyword you need. When in SmartStart mode, keywords typed in directly will 
automatically open the corresponding section. Keyword aliases and the [F8] keyword 
help are fully integrated into the SmartStart input assistant.  
Seasoned users who do not wish to use SmartStart should do the following:  

1. In the dialogue box that appears for new clients, untick the box labelled Use 
the SmartStart input assistant. 

2. Click the SmartStart toggle icon in the toolbar to put DT Max into data review 
mode. 

 
Data entry toolbar 
 

 
 

Three tabs  appear on all screens while working in       
DT Max.  
 

 is the second tab. It will bring you to the data entry screen.  

 enables you to add a new keyword to a client's file in a dialogue box that 
appears in the centre of the screen.  

 will tell you what a particular keyword does, and how it is used by DT Max.  

 allows you to activate and disable the SmartStart sections.  

 allows you to select the required SmartStart sections. 
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 enables you to zoom out.  

 enables you to zoom in. 

 is used to show processing status information. It will bring up a dialogue box 
indicating everything you need to know about the processing status of your 
client.  

 enables you to mark the client's keyword data as verified.  

 enables you to print the keywords for the client whose data is being entered.  

 is used to save information you have just entered. This is only necessary when 
you want to make sure that your latest changes to a client's file are saved 
immediately.  

 enables you to see what errors and warnings are present in the data you have 
entered. Note that this icon is highlighted only when warnings or errors are in 
fact present in your client's keyword data.  

 is used to add a new client to your database (T1 only).  

 appears only in the T1 program. It enables you to go to the data entry screen 
of another family member quickly without having to return to the client list 
first.  

 
Below the toolbar you will find two drop-down boxes. The first one specifies the type 
of return being displayed. Choose the type of return you want by clicking the desired 
selection. The second box is where you select information to be displayed on the right-
hand side of the screen.   

 provides context-sensitive help which, in this case, brings up the main help 
screen for data entry.  
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The keyword system  
 

The keyword system enables you to enter a client's tax information by using a variety 
of keywords and the options that they offer, and letting the software take 
responsibility for the calculations and decisions that need to be made in order for a tax 
return to be properly prepared. The keywords that you use tell DT Max what kind of 
tax information you have, and the options you choose (where required) make this 
information more specific and, consequently, more useful.  
 
When using keywords, you don't have to worry about identifying the proper field or 
line number where to enter the tax information.  
 
Data is entered on a single screen, in any order you like. You never need to search 
through hundreds of forms. The program organizes and manages the data for you, 
thereby optimizing the tax payable for any given family unit.  
 
Family members are grouped together as a unit in order to enable optimization and 
simplify client management for the tax preparer. An individual file is created for each 
member of the family unit, where all relevant data is entered, respectively.  

Keyword help (activated by clicking the Keyword help icon  or by pressing [F8]) 
allows you to quickly find the applicable keywords for any tax information. The most 
commonly used keywords soon become familiar. However, because previous year 
information is available for comparison on the right-hand side of the screen (as on a 
financial statement), you should not have to enter new keywords very often.  
 
Also, when creating new client files, you can display the file of a similar client, existing 
or fictitious, on the right-hand side of your screen to eliminate the need to enter new 
keywords.  
 
The keyword help system, together with features such as the text macros and the 
"ditto" key, give you superior speed and convenience in data entry.  
 
Displaying the keyword data of a client's spouse or any of the client's tax plans on the 
right-hand side of the screen will help tax planning as well as verification of data 
entry. You can also enter data from plans by selectively marking data on the right-
hand side and copying it into the tax file.  
 
After all data is entered in this compact format, you are just one mouse-click away 
from viewing the complete tax return on the screen, exactly as it would be printed. 
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Types of keywords  
The DT Max database stores client information in a flexible format using keywords. 
This method enables the program to keep a vast amount of data of all kinds in a 
compact and efficient manner.  
 
Each keyword is an abbreviation or mnemonic expression of the information it 
represents. The different types of keywords used are described below:  

 
Numerics 
These keywords are followed by a single number. If the number is a dollar amount, 
a "$" is shown to the right of the place where the amount is to be entered. If it is a 
whole number (integer) then a "#" sign is shown.  

 
Alphanumerics 
These keywords are followed by text (a letter, one or several words). Each keyword 
has a limit as to the maximum length of the text.  

 
Options 
These keywords are followed by a word or phrase which can only be selected from 
a list of options.  

 
Compounds 
These keywords are followed by any two of the types listed above.  

 
Paragraph keywords 
Paragraph keywords enable you to enter large amounts of text, up to one full 
screen at a time. The data entry screen shows the keyword and the first line of text 
followed by three dots (...) to indicate that this text is continued.  

 
Group keywords 
Some keywords are gathered in groups. These are cases where several pieces of 
data are linked together. A framing bar on the left of group keywords indicates 
which keywords belong to the same group.  

 
Carryforward and historical amounts 
Carryforward and historical amounts entered into a client file by DT Max are 
indicated as such by the "^" mark to the right of the calculated amount. 
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Group keywords  
Some keywords are gathered in groups. These are cases where several pieces of data 
are linked together. One example is the information found on a T4 slip, where various 
tax amounts and contributions are all tied to the income amount. To start a new 
group, just type in the keyword for the first item in that group (group header). After 
you have entered the data and pressed [Enter], the next relevant keyword will 
automatically appear on the input line, ready for you to enter data. If no data is 
available for that keyword, just press [Enter] to skip to the next keyword. While a 
group is still open, a dotted line appears to the left of all the keywords that belong to 
that group. Once you have been through all the keywords in that group, the group can 
be closed and you can continue entering data in the usual way. 
 
To open a group, use either of the following three methods:  
 

• Click the left framing enclosing the group keywords  
• Press [F6], or  
• Place your cursor on one of the keywords, right-click and select Expand group.  
 

To close a group: 
 

• Click any dotted line to the left of the group; 
• Press [F6] or [Shift+F6]; or,  
• Right-click and select Contract group.  
 

There are also groups within groups. For instance, the CCA-CLASS group exists within 
the BUSINESS group (T1, T3). These behave in a similar manner.  
 
Paragraph keywords  
Paragraph keywords allow you to enter large amounts of text, up to one full screen at 
a time. If you need to enter more than one screen of text, you can use the same 
paragraph keyword repeatedly. Paragraph keywords can be used to enter notes, to 
answer questions about a tax return or its forms, or even to create customized 
schedules. Enter as much text as you need. When finished, click Save to close the 
window and return to your client's data entry screen.  
 
When viewing the client database, you will see the keyword and the first line of text 
followed by three dots (...) to indicate that this text is continued. To edit or view the 
entire text, click that particular field or move the cursor to that keyword and press 
[Enter]. To delete text, click Clear. The screen of text will reappear, ready to be edited 
further. 
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Identifying the appropriate keyword  
As soon as you have entered a keyword, DT Max displays a brief one-line description 
of what the keyword represents, on the status bar at the bottom of the data entry 
screen. (If the status line is not there, make sure that the Display status bar option on 
the View menu is checked.) This will help you ensure that you are entering the data 
correctly. If you input an invalid keyword, an error message will appear. Online help is 
available to guide you with the use of the keywords.  
 
The [F8] function key displays a menu offering several methods to find keywords:  
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• Topic - provides an alphabetical index by tax topics  
• Jacket order - provides an index arranged in the order in which items appear on 

the jacket of the tax return 
• Form number - provides an index of the various tax return schedules and forms 

by number  
• Alphabetical list - provides an alphabetical index by keyword 
• Secondary keywords - shows a list of all the keywords 

 
Select the method you want to use, then move the cursor to the item you are 
interested in and press [Enter] to display the candidate keywords for this subject. 
When you find the keyword you need, click Paste keyword and press [Enter] (or 
double-click the keyword) to paste the marked keyword directly into the data input 
line.  
 
Context-sensitive online keyword help 
More information about the use of the keyword and what it is intended to do is also 
available online from within the program. From the data entry screen, simply place 
your selector bar on any keyword you want and press [Ctrl+F8]. When searching for a 
keyword, click the icon Keyword help index. In the window displayed, select More 
information about this keyword. Or, select Keyword help from the Help menu.  
 
Repeating keywords 
Some keywords can be repeated several times in a client's file, while others are 
intended to be used only once. If you try to re-enter a keyword which can only be 
used once, DT Max will warn you of the error and ask you to correct it.  
 
Abbreviations 
DT Max will recognize keyword abbreviations provided that the first letter of the 
abbreviated keyword is correct. This enables you to enter data with a minimum of 
effort while displaying the data with explicit descriptions. If the abbreviation keyword 
entered is unambiguous, the full length keyword will automatically be shown 
underneath (together with a short description on the status bar). If the abbreviation 
entered is ambiguous, a list of keywords matching your abbreviation will be displayed 
for you to select the one you want.   
 
Aliases 
Aliases allow you to type words that are easy to remember, as well as actual 
keywords. For example, typing the common term WELFARE (T1) prompts the DT Max 
keyword SOCIAL-ASSIST to appear, and the T-slip name T4PS (T1) prompts the 
keyword  T-SLIP with the cursor sitting on the option T4PS ready to be selected. 
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Finding a keyword in a client's file  
When you are looking for a particular keyword in a client file that contains a large 
amount of information, it can be very helpful to have DT Max find the keyword for you. 
To do so, press [Alt+F7] to bring up the following dialogue box:  
 

 
 
Type in the keyword you want to search for and click OK or press [Enter]. If the 
keyword is in the file, the selector bar will place itself directly on it. To abort a search, 
click Cancel or press [Esc].  
 
Note attached to a keyword  
You can attach notes to any keyword entered in a client's file by clicking your mouse's 
right button and choosing Attach note to keyword, or by choosing this same option 
from the Edit menu. A keyword note can also be edited by pressing [Ctrl+N]. Enter as 
much text as you require. When finished, click OK or press [Esc] to close the window 
and return to the client's data entry screen.  
 
A keyword to which a note is attached appears with a paper clip symbol to its right. 
This is how a reviewer, for instance, would know that such a note exists. The notes 
can be viewed later by simply clicking the paper clip.  
 
Keyword properties  
If you wish to view the properties of a keyword, select Keyword properties from the 
Edit menu, or right-click the keyword and make that same selection. 
 
The keyword properties dialogue box contains such information as the current data 
entered for this keyword, a description of the keyword, the applicable type of keyword 
entry, the possible minimum and maximum values of the keyword as well as the 
maximum length allowed. The properties also indicate whether the keyword is a 
calculated carryforward, whether it has a note attached and whether it has been 
checked individually.  
 
The keyword help provides the context-sensitive information about the use of that 
particular keyword.  
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Adding a keyword  
If the keyword you are adding belongs to a keyword group, DT Max will prompt you to 
enter the parent keyword (group header). Clicking Index is akin to pressing [F8] when 
the data entry screen is active (title bar highlighted). It brings up the Keyword help 
index dialogue box. At the bottom left, choose which of the indexes you wish to 
consult. Selecting an item from an index will bring up the relevant keyword. When a 
keyword is highlighted, you can either paste the keyword into the client's file (also 
possible by double-clicking), or get more information about the use of this keyword.  
 

Macros editor  

 
DT Max enables you to store up to 26 commonly used pre-defined words or phrases 
which can be recalled with only three keystrokes when entering data into your client's 
file. Each macro can be up to 40 characters long. Any phrase which you find yourself 
entering repeatedly is a candidate for a text macro. Common examples of macros are 
the names of banks or financial institutions, charitable institutions supported by many 
of your clients, companies issuing dividends, etc. However, macros cannot consist of 
keywords, or keywords combined with numeric or alphanumeric information.  
 
Setting up your text macros 
To customize your list of text macros, press [Alt+F1] or choose Text macros in the 
Preferences menu. Then, change the default set of text macros to those you find most 
useful. A letter from A to Z is used to label each macro in order to help identify the 
macros when entering them in your clients' files.  
 
There are two basic sets of macros, one for English-speaking clients and one for 
French-speaking clients. When entering the macro for a client whose LANGUAGE is 
designated as English, DT Max will use the English set of macros. Similarly, the French 
list is used for clients whose LANGUAGE is French. Note that the text of the macro will 
remain as entered even if you change the language of the client afterwards.  
 
If you have both English and French clients, it will be easier to manage the macros if 
the same keystrokes are used for the same text in both sets.  
 
Using text macros when entering information in a client's file 
To enter information in a client's file using text macros, the active window must be the 
data entry screen. Then, activate the macros editor by pressing [Alt+M] and the letter 
matching the macro you wish to use. For example, to enter the name "Royal Bank of 
Canada", which could be labeled with the letter "R" in your list, you would press 
[Alt+M] followed by R. DT Max would then insert the words Royal Bank of Canada into 
your client's file, exactly as if you had typed them in yourself, manually.  
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DT Max function key summary  

Below is a summary of the function keys most commonly used in DT Max.  
 
F1   Context-sensitive help 
[Alt+F1]   Add / edit a text macro 
F2   Open data entry screen 
[Alt+F2]   Show user's defaults 
[Shift+2]  Repeat the last entry (on French keyboards) 
F3   Add a new client to the database 
F4   Delete marked client from the database 
F5   Mark the beginning / end of a range of lines 
[Alt+F5]   Clear marks 
F6   Expand / contract the current keyword group 
[Shift+F6]  Contract the current keyword group 
F7   Access to the DT Max knowledge base 
[Alt+F7]   Find a keyword in the client's data 
F8   Display the keyword index 
[Ctrl+F8]  Display keyword help 
F9   Display the tax return 
[Alt+F9]   Recalculate the client's tax return 
F10   Open client list screen 
F11   Add a new keyword 
F12   Jump to a selected page in the tax return 
[Alt+C]   Copy from the right to the left-hand side 
[Alt+F12]  Switch to the file of the spouse (T1) 
[Alt+J]   Enter a different amount for another jurisdiction 
[Alt+K]   Translate a keyword 
[Alt+M]   Select a text macro 
Page Up  Move ½ page up 
Page Down  Move ½ page down 
[Ctrl+C]   Copy the selected data 
[Ctrl+F]   Find a client in the client list 
[Ctrl+L]   Switch languages 
[Ctrl+N]   Attach / edit a keyword note  
[Ctrl+P]   Settings for production printing  
[Ctrl+Q]   Save data and exit DT Max 
[Ctrl+V]   Paste the selected data 
[Ctrl+X]   Cut the selected data 
[Ctrl+Backspace] Delete the selected keyword  
[Ctrl+PgUp]   Come back to previous page 
[Ctrl+PgDn]   Move ahead to next page 
Home   Move up to the top of the first page 
[Ctrl+Home]  Move up to the beginning of the new file  
End   Move down to the bottom of the last page 
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[Ctrl+End]  Move down to the end of the current file 
" or '    Repeat the last entry (English keyboards) 
=   Mark this keyword as checked 
[Alt+F3]  SmartStart client profile 
[Alt+F8]  Use SmartStart sections 
[Alt+F6]  Collapse all SmartStart sections 
 
 
The Windows Search utility  
This tool will help you locate files and folders in your system directories:  
 

1. Click the Start button  
2. Select Search 
3. Select For files or folders 
4. In the field titled Search for files or folders named, type all or part of the name 

of the file you wish to locate.  If you do not know the name of the file, or if you 
want to refine the search, click Search options and provide whatever information 
you can to help the search process. If you want to indicate the location from 
where to start the search, select one in the Look in drop-down list.  

5. Click Search now.  
  
Windows marking conventions  
You can use Windows marking conventions to mark selected clients, lines of data, or 
pages to print.  
 

• To select a range of items, hold down the [Shift] key and click the first and last 
items desired.  

• To select multiple, non consecutive items, hold down the [Ctrl] key and click 
each desired item, one at a time.  

• To unmark all items, click anywhere in the active window (after ensuring that 
the [Shift] or [Ctrl] key is released).  

• To unmark a single item, hold down the [Ctrl] key and click the item you wish to 
unmark. Repeat with as many items as necessary. 

 

Selecting a tax year  

 
DT Max supports tax years 1996 onwards for the T1 program, whereas the T2 
program can process fiscal periods from 1994 onwards and the T3 program supports 
tax years 2003 onwards. You may thus select a year among those installed, on the 
opening splash screen, and prepare tax returns for the chosen year.  



Program features           DT MAX USER’S MANUAL 

                                                                     56   

This option is intended primarily for early entry of next year's data, if available, and to 
allow you to look at next year's carryforwards, if you wish to do so. To switch to a 
different tax year while using DT Max, select Change tax year in the File menu. The 
tax year and version number in use are always displayed on the top line of the screen 
when the program is running.  
 

Carryforwards from previous years  

 
A carryforward amount calculated by the program appears with a caret symbol (^) to 
the right of the value, thus letting you know that this amount was not entered 
manually. If you edit a carryforward, the caret is dropped, indicating that the value 
was entered manually rather than calculated automatically.  
 
If you enter a client's tax information for this year and launch the calculations, you 
have used the carryforward information that was available at the time. If, afterwards, 
you enter information for the same client in the previous year and recalculate, the 
newly calculated carryforwards will not be written into the active data for this client. 
Instead, they will be made available for display and comparison in a separate area on 
the right-hand side of the screen. They will not overwrite the active carryforwards 
because the latter have been used in preparing a tax return.  
 
A message will appear to remind you that the calculated carryforwards may have 
changed, and DT Max will offer to display the new carryforwards on the right-hand 
side. You may then compare and make the changes you deem appropriate.  
 
The carryforward amounts appearing on the right-hand side can be marked (by 
pressing the [^] key, usually above the number 6 on the keyboard) and copied into 
the client's current year data.  
 

Comparing data / Right-hand side display  
 

In the data entry screen, the information appearing in your client's current file is listed 
on the left-hand side, by keyword and option. On the right-hand side of the screen, 
you can display this client's information from the previous year, from a tax plan, for 
his/her spouse or for any other client in the same database. You can also display 
carryforwards to a stub or post-bankruptcy period (T1), carryforwards from the 
previous year and carryforwards to the next year. In this context, entering current 
year information for a client is fast and easy because the keywords needed are at your 
fingertips. Comparison with previous year amounts also enables a quick basic check of 
your input.  
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Choose what to display on the right-hand side by clicking the Right-hand side display 
drop-down menu in the data entry screen. Of course, you can always choose No right-
hand side display.  
 
Data entry templates 
Sample clients can be displayed on the right-hand side of your current client's data 
entry screen. Several templates of sample clients have been designed to show how to 
enter particular types of tax situations. They include sets of keywords to help speed up 
and simplify data entry.  
 
You can bring up the list of sample clients by selecting Data entry template from the 
right-hand side display drop-down menu, in the data entry screen. From this list, 
highlight the template that you wish to use, then click OK to have it appear on the 
right of your screen.  
 
Entering different jurisdiction amounts  
In most cases, DT Max assumes that the amounts to be reported on a provincial 
return will be the same as those on the federal return. This prevents you from having 
to enter the same amounts twice. When the amount reported for provincial purposes 
differs from the amount used on the federal return, the provincial jurisdiction amount 
must be entered separately. To that end, press [Alt+J] and DT Max will provide a 
specific field for this different amount. In cases where several different amounts are 
required, as for a corporation filing returns for several jurisdictions, the keyword 
JURISDICTION will provide as many possibilities as necessary.  
 

The "ditto" key  

 
When you need to enter the same keyword or portion of text repeatedly (e.g. medical 
expenses paid to the same pharmacy), the "ditto" key is very useful. To repeat the 
previous keyword, press the "ditto" key (single quote ['], or double quotes ["]). On a 
French keyboard, press [Shift+2]. Press the "ditto" key again and the text data from 
the previous keyword will be repeated as well.  

 

Customized input sheets  
 

If you wish to print a customized input sheet, select the previous year's data for right-
hand side display and print the client's keyword data for the year. In this way, the 
previous year's amounts will appear on the right, for reference, and blank input fields 
will be available on the left for you to enter new data. You can also print the keyword 
entry order list, which can serve as a useful reminder of the keywords or as a 
complete input sheet.  
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Verification system  
 

Since you are responsible for the tax returns you generate, verifying the results is an 
important task. DT Max can be configured to require verification of a client's tax data 
prior to the client's file moving ahead to the next stage of processing. You can require 
verification of the information either in the file before the tax return is generated or on 
screen before the tax return is printed, or both. Having DT Max monitor the process of 
producing tax returns is very helpful. When verification is required, DT Max will make 
sure that each tax return is checked by a person who is identified in the security 
system as having authority to verify tax returns. This way, you can rely on a certain 
level of quality control.  
 
Setting a requirement for verification 
Set your preferences on the requirement for verification by choosing User's defaults 
from the Preferences menu, or pressing [Alt+F2]. Select the Miscellaneous tab. Ensure 
that the requirement for verification is set to the same value for all users. If the       
DT Max security system is active, its setup must identify all users who will be 
authorized to verify returns so that they are able to mark clients as verified.  
 
Verifying keyword data 
To verify the information entered in a client's tax file, go to the data entry screen. 
When you (the verifier) are satisfied that the information is complete and correct, click 

the Verify keywords icon . Your client's information will then be tagged as verified, 

which you can monitor by looking at the client's processing status . 
 
Verifying the tax return 
To verify a client's tax return, display the return on the screen. When you (the verifier) 

are satisfied that the tax return is correct, click the Verify return icon . Your 
client's tax return will then be tagged as verified, which you can monitor by looking at 

the client's processing status . 
 
If the verification process does not seem to work properly, make sure that the 
requirement for verification is set correctly and that you have been designated as an 
authorized verifier in the security system.  
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Checking individual keywords  
When you verify keyword data, you can individually mark each entry as checked. To 
do so, when you are satisfied that the entry is correct, mark it by either right-clicking 
and choosing Mark keyword as checked, or by pressing the "=" sign. A small check 
mark will appear on the right of the amount that has been verified.  
  

Deleting data   

 
You can delete a single item of data from the data entry screen when it is active 
(highlighted) by moving the cursor (selector bar) to that item, as represented by a 
keyword, and then right-clicking and choosing Delete this keyword, or by pressing 
[Ctrl+backspace]. Similarly, you can delete larger batches of data from the data entry 
screen when it is active (highlighted) by marking the data that you wish to delete, 
right-clicking and choosing Delete marked keywords.  
 
Mark (or unmark) single items of data by moving the cursor (selector bar) to that 
item, holding down the [Ctrl] key and clicking the left mouse button. Mark blocks (in 
groups) by pressing [F5] on the first item of the group, scrolling down to the last item, 
and pressing [F5] again. Remove marks either by clicking the right mouse button and 
choosing Clear marks, or by pressing [Alt+F5].  

 

Calculating data  

 
You can perform simple calculations involving certain data as it is being entered in the 
dollar-amount entry fields. The results alone will be remembered by DT Max. If you 
require the details and wish to proceed with more extensive calculations, use the 
keyword CUSTOM-SCHED.  
 
When calculating, you can use the following symbols for the operations described:  
 

+  plus  
-  Minus 
*  multiply  
/  Divide 
( )  brackets (to control order of calculation)  

 

 



Program features           DT MAX USER’S MANUAL 

Tax calculations  
When calculating a T1 tax return, DT Max takes into account the possibilities for 
transfer of data between spouses and from dependants to their supporters. However, 
DT Max can only do this if all the information is available in the database. If spousal or 
dependant data is missing, DT Max's calculations may be erroneous. Therefore, it is 
important for all members of a T1 client's family to be entered in the database. The 
corporate tax return is optimized as well, although the information from related 
corporations is not taken from their respective tax files. The same applies to trust 
returns. 
 
To see changes in calculations when entering data for a tax return, click the Display 

tax return tab  on the grayed out return, or press [F9]. In case of data 
errors,   DT Max will not be able to recalculate until these errors are corrected. DT Max 
will not display tax returns that are not required (e.g. certain dependants). If you want 
to see a return or schedules that are not being displayed, enter the keyword DISPLAY-
OV in the client's file. If you wish to recalculate a tax return even though DT Max does 
not deem it necessary, select the option Recalculate current client from the Tools 
menu, or press [Alt+F9].  
 
Calculating a batch of clients 
If you want to run calculations for a large batch of clients, mark the clients you want 
calculated in the client list, and choose Batch calculations from the Tools menu. 
 

Saving data  
 

DT Max systematically saves the information entered in a client's file when a 
calculation is performed or when you exit the data entry screen. If you do not want 
the information saved, select the option Close without saving from the File menu.  
If you want to personally make sure that data is being saved, click the Save data icon 

 or select Save in the File menu.  
 
Note that if you were to turn your computer off or sustain a power failure before the 
latest data entered is saved, this data would be lost.  
 
Errors / warnings in data  
When you update a client's data, DT Max may produce one or several error and/or 
warning messages for that client. These error or warning messages can be viewed at 
any time from within the data entry screen by clicking the Error and warning 
messages icon on that toolbar or by selecting the Show errors/warnings option from 
the Edit menu.  
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Errors that prevent calculations must be fixed or the data cannot be calculated and, in 
the client list, the client will appear with a processing status indicating Data errors. 
Errors that prevent filing (T2) will occur if information that is required by the CRA is 
missing. As long as such an error remains, no RSI's, for instance, will be generated.  
GIFI errors (T2) are errors that have been detected with respect to the GIFI data 
entered. Such errors must be rectified in order to paper-file the federal RSI's or efile 
the federal or Quebec return. Warnings, however, are intended to bring potential 
problems to your attention. If deemed unimportant or irrelevant, you can ignore a 
warning and resume calculations after clicking the Close button.  
 
In order to resolve errors and/or warnings, select the warning or error from the list, 
click the Go to keyword button and DT Max will bring you to the problem area in the 
data. Warnings that are ignored will also appear on the diagnostics report.  
 
Show messages…  
The options available for the feature Show messages… are the following:  
 

Always 
This is the default setting. Each time you update or calculate, this will prompt the 
display of the warning box, listing the warnings that remain unresolved.  

 
New messages only 
The warning box will only be displayed if new warnings have arisen since the last 
update or calculation. Previous unresolved warnings will still be listed.  
 
When requested 
This option prevents the automatic display of the warning box, which must 
therefore be requested by the user when required. This is done by clicking the 
Show errors/warnings icon on the data entry toolbar or selecting this same option 
from the Edit menu.  

 
Note that the options available for Show messages… will not affect in any way the 
display of errors that prevent calculations.  
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Tax return display  
 

 
 

Three tabs  appear on all screens while working in       
DT Max. 
 

 is the third tab. It enables you to display the tax return.  
 
The fourth item on the toolbar is a drop-down box, which specifies the type of return 
that is being displayed. Choose the type of return you want by clicking the appropriate 
selection.  

 will show the page selection index. 

 will take you to the previous page of the tax return.  

 will take you to the next page of the tax return.  

 will take you back to the last page viewed. 

 will take you back to the next page viewed.  

 enables you to view more of the tax return by making it smaller.  

 enables you to see a section of the tax return better by making it larger. 

 gives you access to the processing status information. It will bring up a 
dialogue box indicating everything you need to know about the processing 
status of your client.  

 enables you to verify the tax return displayed on the screen.  

 enables you to print the page of the tax return that is displayed on the screen. 

 enables you to print the entire tax return or any portion of it, as you prefer.  
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 is used to save the pages displayed as a PDF file, and email them if need be.  

 is used to efile a client's tax return (T1, T2).   

   enables you to display the tax return of a family member of the T1 client 
whose return is currently displayed on the screen.  

 provides context-sensitive help which, in this case, brings up the main help 
screen for displaying tax returns.  

 
Scrolling through the tax return 
You can use the Windows scroll bars to move through the return. However, it is much 
easier to use the Page selection index to choose the page of the return you wish to see 
displayed.  
 
Zoom in / zoom out 
You can see the return more clearly by zooming in on it. To do so, you may click the 

icon titled Zoom in  on the toolbar. In the same manner, you can zoom out  to 
make the text smaller.  
 
Modifying the tax return 
To modify the tax return, go back to the data entry screen by clicking the Data entry 
tab on the toolbar or by pressing [F2].  
 
Verifying plans 
Note that when verifying returns and comparing plans, you do not have to scroll up 
and down the tax return to compare results. Your marker will be set at the same place 
on all of your clients' tax returns and plans for that year. All you have to do is choose 
the plan you want in the Type of return box on the toolbar.  
 
Export or email tax return pages  
You can export or email a selection of pages of the tax return as a PDF file by selecting 
the Save/email PDF file icon from the displayed tax return toolbar.  
 
Select to Save as a PDF file or to Email the selected pages directly and fill in the 
relevant information. If you select Email the selected pages..., the Email recipient 
entry will be filled in automatically using the client's EMAIL keyword data. Otherwise, it 
will be remembered from the last session.  
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Note that in order to use this email feature you must have a MAPI client enabled (an 
attribute of your email program). Some advantages of exporting pages of a tax return:  
 

• A tax preparer can email pages of the return to the taxpayer for verification.  
 
• The authorization forms can be emailed to the taxpayer, then printed, signed, 

and mailed or faxed back by the taxpayer.  
 

• Parts of the tax return can be emailed (or sent on a diskette) to banks, trustees 
or government agencies on behalf of the client even though these parties do not 
have DT Max installed. 

 
Note that emailing a PDF file containing confidential information is not recommended 
as this format can easily be read by third parties. 
 

The client letter (T1) 
 

DT Max provides you with a client letter, which can be used by any tax practitioner as 
it offers the flexibility to customize it to suit your preferences.  
 
The T1 program automatically generates a customized client letter in accordance with 
the contents of the taxpayer's return (and the returns of his family members, if any). 
In it, you can find the areas where the taxpayer's signature is required, an indication 
of the balance due or refund payable, and various other tax-related information 
pertaining specifically to the taxpayer (e.g. the maximum RRSP deduction eligible for 
the following year.)  
 
DT Max's default client letter is located in the DT Max sub-directory under 
DT1WLET.YYE and DT1WLET.YYF (where the "YY" part represents the last two digits of 
the applicable tax year), for the English and French versions respectively.  
 
Do not edit the default client letter as your changes could be overwritten upon 
installing a subsequent version of DT Max.  
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Customizing the client letter 
Customization of the client letter is enabled for the sole purpose of fulfilling your 
needs. This feature should only be used if needed, as maintenance of customized 
client letters is rather demanding.  
 

• If you need or want to edit it during the tax season, you will have to find out 
which clients were sent the letter already.  

 
• You should verify the customized client letter when you receive a new version of 

the program that may contain relevant changes, to ensure that it remains 
accurate. 

 
• You will have to check that the syntax is correct (i.e. the required control codes 

are used in the proper places).  
 
Despite these warnings, there are several excellent reasons for customizing the client 
letter. For instance:  
 

• You can translate the letter to a language other than English or French for a 
particular client.  

 
• You can expand the letter by adding conditions that will enable you to give your 

client a more detailed analysis of the tax return.  
 

• You can modify the margins to fit your company's letterhead.  
 

• You can adjust the level of formality in the language.  
 

• You can use it to identify what documents to get from your client, based on 
what was provided the previous year.  

 
• You can use it as a reminder to submit instalments to the governments.  
 

Exporting the client letter 
You can export the T1 letter generated for a particular taxpayer. To do so, right-click 
the tax return screen, then click the icon Save client letter as RTF file. This feature 
enables you to make any final changes you deem necessary using a word processor 
before printing and mailing the letter. 
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Archiving tax returns in PDF format  

Archiving allows you to preserve an electronic copy of your clients' tax returns, 
thereby reducing the paper clutter in your office. DT Max archiving uses the PDF 
technology developed by Adobe.  
 
When a client's tax return is archived, DT Max enters the information about the 
archiving of that return in the client's file using the PROGRESS keyword, as in the 
example below:  
 

PROGRESS 21/04/2005 Archived 
NOTE Archive file: C:\DATA\T1DATA\ARCHIVE\T1\2005\77788877.PDF [ABC] 

 
DT Max records when the file was archived, which user archived it (per the user ID), 
the location of the archive file and it's name. You can enable and specify both the 
location and the naming convention used for the files by selecting Archiving from the 
Preferences menu. It is important to ensure that a different location has been specified 
for each different database and that all users of the database have the same archiving 
configuration.  
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 SELECTED FAQ’S ABOUT THE PROCESSING OF TAX DATA  

 
¾ How do I copy selected keyword data from a spouse (or from another 

client)? On the right-hand side of the screen, display the keyword data that you 
want to copy by selecting the option Spouse or Other client in the drop-down menu 
titled Right-hand side display, in the keyword data editor. Mark the data that you 
wish to copy by using the [Ctrl] key with your left mouse button for single 
keywords or [F5] for a block of selected keywords. From the right-click menu, 
select Copy to left-hand side. 

 
¾ How can I obtain more information on a keyword? Pressing [Ctrl+F8] in 

the keyword data editor provides online help for the keyword that is highlighted. 
[Ctrl+F8] works for keywords located in the keyword help listings as well as for 
keywords found in the client data.  

 
¾ How do I enter a Quebec amount that is different from the federal 

equivalent? After you have entered the federal amount for a keyword, press 
[Alt+J] and DT Max will prompt you to enter the Quebec amount. Remember that 
you only need to do this when the Quebec amount is different. 

 
¾ How do I delete a keyword? In the keyword data editor, place the cursor on the 

keyword you want to delete and press the 2-key combination [Ctrl+Backspace]. 
 
¾ How can I find the keyword that will insert an amount on a specific 

line number? The [F8] key or the Keyword help index icon, in the keyword data 
editor, gives you access to the keyword help system. After pressing [F8], select 
Jacket order under Index by. From the listing of the line numbers that appears, 
move the cursor to the line number that you require. The keywords that are 
relevant for that line number will then appear on the screen. 

 
¾ How can I restrict a group of users' access to certain clients in the 

database? The DT Max security system can restrict authorized users to their  
own clients or include the clients of other users whose ID's are accessible. To that 
end, the security system level must be set to Password and user ID mandatory. 
Users will then have access to their own clients AND to those of other users, as 
long as a right of access has been granted. Access to some of those clients can be 
restricted further with the keyword RESTRICT. Such restricted clients can only be 
accessed by the person who is responsible for them, as identified by the user ID. 
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Utilities 
 

Processing statuses 

 
As each client file progresses through the stages of income tax return preparation,   
DT Max maintains a current processing status for the clients in the database. This 
status is used by the program to ensure that a client has correctly reached a certain 
stage before moving on to the next stage.  
 
DT Max automatically records data entry, tax calculations, printing and efile statuses 
for all clients. It also enables you to keep track of manual tasks such as verification, 
assembly, mailing and reception of assessment notice for each client's return.  
 
The current processing status for a client is shown at all times in the client list.  
 
In DT Max, a variety of other features provide useful client management tools when 
considered in light of processing statuses.  
 

• The processing status summary gives a breakdown of the number of clients 
having reached a particular stage.  

• Using the client filters together with the status summary will give you a good 
idea of the progress and workload of each tax preparer. The filter system can 
help you identify the clients who have reached a particular processing stage 
such as, for example, those who are ready to be verified.  

• The verification system ensures that tax returns are verified by key personnel.  
• The DT Max security system can apply restrictions as to which users are allowed 

to carry out tasks such as setting the status of a client to "verified".  
• The keyword BLOCK can be used to stop the processing of any client.  

 
Status information  
The current and historical status information of a particular client can be viewed at any 
time by selecting Status information from the Management menu or clicking the Status 
information icon on the toolbar.  
 
The dialogue box shows you which stage of income tax return preparation the client 
has reached and how he got there. Use this dialogue box to select and annotate 
manual processing statuses. For example, tick the Tax documents received status and 
enter the date, your initials and whatever notes you deem necessary.  
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All changes made here will show on the client list and, where applicable, in the data 
entry screen for the client. If necessary, you can reset the current client file to its 
initial status by clicking the Reset statuses button.  
 
Changing processing statuses for a batch of clients is possible with the Change 
statuses option of the Management menu.  
 
Listing of individual processing statuses  
The processing statuses available are listed below. The codes shown in round brackets 
indicate how the status can be set or changed according to the following:  
 

A status set automatically by DT Max 
M status set manually by the user 
B status set manually by the user for a batch of clients 

 
No data this year (AMB)  
The client exists on your database but no data has yet been entered in his file for 
the current tax year. When you begin a new tax year, each of your clients will have 
this status, which will be advanced by the program as soon as data is entered for a 
client for the current year. 
 
Inactive (MB)  
The client is not expected to require tax calculations in the near future. As soon as 
you edit the data of a client with this status, it will be updated accordingly. You 
might use this status for someone who is no longer a client.  

 
Blocked (M)  
Some data has been input for this client for the current year but the file has been 
blocked from further processing by the preparer. This might occur, for example, if a 
client has provided you with some tax information but forgot an important slip and 
had to return later. You would then block his/her file from processing and note the 
reason using the keyword BLOCK. The only way to change this status is by deleting 
the BLOCK keyword from the client's file in the data entry screen, or by reactivating 
the client when prompted by DT Max.  
 
Review required (AMB)  
This status is set when a tax return from a previous year is recalculated. In this 
case, the new carryforwards for the current year may have changed. Once a client 
with the status Review required is updated, DT Max assumes that the review has 
taken place and the status is changed to Data OK.  
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Tax documents received (MB)  
This status is available to indicate which client files are ready to proceed into tax 
production. Later, when tax data is entered, the status automatically changes to 
Data OK.  

 
Errors in data (A)  
Data has been entered for the client for the current tax year but for some reason, it 
has been saved with errors. This may happen if, for instance, DT Max has pointed 
out an error in the data (such as a missing date of birth) and you had to refer to 
that client for further information prior to fixing the error.  

 
Data OK (AMB)  
This shows for any client file with current year data that was saved without errors.  

 
No return required (A)  
This client's tax calculations were run and DT Max has determined that the client 
does not require a tax return. Dependants in a family unit often get this status.  

 
Ready for verification of keywords (A)  
This client's keyword data has been entered and is ready to be checked before 
printing or efiling. This status and other verification statuses only appear if the 
verification system has been enabled in the Miscellaneous tab of the User's 
defaults, in the Preferences menu.  
 
Keywords verified (MB)  
Keyword data for the client has been verified by designated personnel.  

 
Ready for verification of return (A)  
This client's tax calculations were run and they are ready to be checked before 
printing or efiling. This status only appears if the verification system has been 
enabled in the Miscellaneous tab of the User's defaults, in the Preferences menu.  

 
Ready for efile (A)  
The client is on the efile queue, ready to be marked for efile and transmitted.   
 
Transmitted by efile (A)  
The client's return has been efiled to the government but no acknowledgement has 
yet been received.  
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Efile errors (A)  
The client's return that was efiled to the government contains errors. The errors 
found are in the keyword EFILE-RESULT. In the client's file, you will have to correct 
the errors and retransmit.  

 
Efile acknowledgement OK (AM)  
The client's tax return has been efiled and an acknowledgement file has been 
received from the government. When the acknowledgement is received, the entry 
Efile acknowledgement received for the keyword PROGRESS is automatically placed 
in the client's file.  

 
Ready to print (A)  
The client's return is on the print queue, ready to be printed.  
 
Printed (AMB)  
The government destination for the client's tax return has been printed. When this 
destination is printed, the keyword PROGRESS automatically shows Printed in the 
client's file. If you do not want DT Max to consider the client as "printed", remove 
the PROGRESS entry from the client's keyword data.  

 
Collated (MB) 
The various components of this client's tax return have been collated and the 
information slips have been attached.  

 
Mailed (MB)  
The client's tax return has been mailed to the taxation center.  

 
Assessed (MB)  
The assessment notice for this client has been received.  

 
File closed (MB)  
The client's tax file has been closed for the current taxation year.  

 
Quebec processing statuses  
For clients requiring Quebec TP1 returns, separate processing statuses are maintained 
for the federal and provincial returns.  
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Changing processing statuses  
DT Max enables you to change the processing statuses for a single client or for a batch 
of clients.  
 

Single client 
You can change the processing status of a particular client  

• by using the Progress keyword in that client's file, in the data entry screen, or  
• by viewing and editing the contents of the Status information dialogue box.  

 
Batch of clients 
You can change the processing statuses for a batch of clients by using the Change 
statuses option from the Management menu. This feature enables you to move 
statuses forward or backwards through the various processing stages.  

 
New carryforwards  
The message "New carryforwards" appears automatically when you try to access the 
data entry screen of a client whose processing status indicates Review required. This 
status takes place, for example, after a previous year's tax return has been 
recalculated. Those new carryforwards may have been generated by the recalculation 
but they were not written directly into the current year's file because the status was 
other than No data this year. In order for DT Max to automatically write carryforward 
data into the current year, the processing status must be No data this year.  
 
If you wish to review those new carryforwards, select Yes to have them displayed on 
the right-hand side. After review, if you wish to copy them into the current year's 
data, use the Windows marking conventions and select Copy to left-hand side from the 
Edit menu or from the menu prompted by right-clicking in the data entry screen. If 
you do not wish to review these new carryforwards, simply select No.  
 
Remember that in the DT Max T1 program, all family members may have to be 
verified individually to prevent the error message indicating that "There are errors in 
the input data...".  
 
Summary of processing statuses  
When you select Status summary on the Management menu, DT Max determines how 
many clients have reached any given stage of processing. For each processing status, 
the program calculates the number of family heads, spouses and dependants, and the 
total number of clients having reached that particular status. Status summary reports 
can be printed by clicking Print. You can also set up client filters so as to get a status 
summary for any given filter. The summary of processing statuses is only available 
when viewing the client list.  
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Back up and restore 

 
Loss of information stored in computers can be very costly because of the large 
investment in time that it represents as much of the data may be irreplaceable. Loss 
of data may be due to a variety of causes, e.g. hard disk failure, theft of equipment, 
careless copying or deletion of files, fire or water damage, etc. Therefore, we 
recommend that you back up your files regularly, especially if the information is 
sensitive for your client, or before any major change such as re-indexing or installing a 
new version of the program. You must have a backup that will be able to cope with 
any of these disasters, one that will be reliable and available for you when you need it.   
 
Back up regularly enough that the amount of data that you stand to lose since the last 
backup is acceptable. This may mean backing up every day, or every week. It depends 
on your particular circumstances and the amount of fresh data being entered daily. 
You should also store your backup files in a location that is physically remote from 
your computer to prevent potential losses due to fire or other disasters.  
 
To back up with DT Max, choose Backup from the Tools menu and follow the 
instructions on the screen. To restore a database, insert your first diskette into the 
floppy drive, choose Restore from the Tools menu, and follow the instructions.  
 

Extract and merge  
 

Extract and Merge are utilities that enable you to transfer client information for specific 
clients in a DT Max database from one computer to another. They can also be used to 
build a master database from separate databases on different machines. The extract 
and merge features can be used to  
 

• Retrieve certain DT Max client information from your office computer's database 
in order to work on it using your home computer  

• Bring previous year and carryforward information to a client's office in order to 
enter current year information  

• Update your office database with the work done at home or at a client's  
• Merge the databases of two or more firms that are amalgamating  
• Separate clients or databases of firms that are splitting up  
• Update printing or efile information to a designated database  
• Update information to an archive database  
• Create a selective backup of your client files.  

 



Program features           DT MAX USER’S MANUAL 

When using the extracting utility, you select information for specific clients from your 
database and write it to a disk file, i.e. the extracted file. Because the material is 
copied, no data is removed from the database. To extract, select the option Extract in 
the Tools menu. The extracted file is then taken to another computer where the data 
will be merged into an existing DT Max database located on this other computer. To 
merge data, select the Merge option in the Tools menu. This database will then be 
updated in such a way as to include new data for the merged clients as well as original 
information for other clients.  
 
Extracting client information  
When you select Extract from the Tools menu in the T1 program, DT Max brings up 
the following dialogue box:  
 

 
 
You can extract one or several marked families, your own clients (that is the clients 
marked with your user ID) or the entire database. Note, however, that you cannot 
extract one single client without his family members because the information of the 
entire family unit is treated as a whole.  
 
The choice of Data to extract enables you to choose between the current years and all 
years available for the clients selected. Select the current years when you want to 
temporarily move information from one computer to another, and select all years 
when you need to permanently move a client's complete set of records to another 
computer. You should avoid selecting All years unless truly necessary as it can turn 
into a long process on busy networks or slow computers.  
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The backup and restore features may be better suited for All years and All clients.  
 
An extract file can include print and efile data (output) along with entered data 
(input). This is particularly useful if the destination computer or database is to be used 
for printing or efile processes. After extracting, DT Max creates a results log which you 
can save or print. This record of what you have done can let you know whether or not 
the latest data is on the database that you are consulting.  
 
The extract and merge utilities can be used to transfer data between groups. If, for 
instance, one group of users has an old printer that performs very slowly, they could 
have printing done by the other group with a better printer. Similarly, one group may 
be in possession of the computer used for efile, which the other group would need to 
use as well. In both cases, extract/merge would enable the necessary data transfer. 
 
Merging client information  
When you choose Merge from the Tools menu to merge extracted data into a DT Max 
database, DT Max brings up the dialogue box titled Select file to merge from where 
you will choose the desired extracted file. You will then see the dialogue box below: 
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You can merge some or all the clients from the extracted file. It is useful to be able to 
merge selectively, thereby selecting files from a master database and allocating clients 
to different members of your firm.  
 
Using savelevels 
DT Max relies on internal logic to decide whether or not each client should be merged. 
To that end, DT Max maintains an internal savelevel number for each client file. Each 
time a client's file is updated or saved, this savelevel is incremented by 1. Therefore, a 
copy of a client's file that has recently been worked on will have a higher savelevel 
than old data for the same client on another database. Under most circumstances, 
using savelevels ensures protection against inadvertently overwriting new data with 
old data during a merge. Problems in using savelevels will occur where one given file 
has been worked on from different databases simultaneously, since DT Max will always 
search for the highest savelevel. In such circumstances, DT Max may not know which 
is the most up-to-date file. However, DT Max can merge selectively by keyword. 
 
Forcing a merge 
If you force a merge, all client files on the diskette will be merged into the database 
regardless of savelevels and the merged information will overwrite any existing data 
on that database for the merged clients. You may still choose to do so if you know for 
a fact that the desired information resides in the extracted file, even though the 
source file may have been saved more frequently and show a higher savelevel.  
 
Duplicating client numbers 
Client numbers in a DT Max database must be unique. Therefore, if the same client 
number exists on the extracted file and in the database but for different clients, the 
merge will fail. If the client on the database has not been replicated elsewhere, you 
may renumber this client to enable the merge to succeed.  
 
Warning: If you have already merged your databases but found only a few duplicate 
numbers, do not re-number an entire database and attempt to merge again. You 
would end up with two copies of each client from the merged database. Instead, 
delete the unnecessary clients. You can use your log file to know which client numbers 
are the ones you wish to retain.  
 

Cloning family members (T1) 

The cloning feature available in the client list by selecting Tools and Clone family 
members is used to create a copy of one or more family members. This is useful in the 
following situations:  
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• Splitting up a family to prepare the return of a separated or divorced spouse  

• Preparing the return of a dependant who has moved out of the family 
household  

• Copying joint-custody dependants to a spouse who is separated or divorced 
from the family head  

Cloning makes a copy of the selected family member, and assigns them a new client 
number. This copy (the clone) appears as a separate entry in the client list. Note that 
only the current year data is copied for the clone. 
 
Once the copy is made, there is no more link between the original member and the 
clone, i.e. changes affecting one of them (including changes to permanent data such 
as the address, for example) will not be applied to the other.  
 
To clone a family member: 
 

1. In the client list, place the cursor on the family member you wish to clone.  

2. Select Tools then Clone family members.  

3. In the dialogue box that appears, verify that the options Current individual 
only and Add to a new family are selected.  

4. Check (or uncheck as relevant) the option Make cloned family member inactive 
in original family.  

5. Click OK.  

The program will create a new family with the clone as the family head. 
  
If Make cloned family member inactive in original family was ticked the family member 
will be inactive in the original family. The tax data of inactive family members do not 
take part in the tax calculations of the family for the years that they are inactive, but 
continue to take part in the tax calculations for other years where they remain active 
(e.g. prior years). This is useful for instance in the case of a separated or divorced 
spouse as it excludes the ex-spouse from the original family after the split, while 
retaining the correct family makeup before the split. 
  
You can clone more than one family member into a new family: 

1. Mark the family members to be cloned in the client list (using the spacebar).  

2. Proceed per the cloning instructions above except in step 3, select Marked 
individuals only.  
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You can also clone one or more family members into an existing family:  
 

1. Proceed as above but in step 3, select Add to an existing family.  

2. In the field provided, enter the client number of the head of the family to 
which the clone(s) should be added.  

Note that the program will not allow you to produce a family with more then one 
spouse.  
 
Do not use the cloning feature to duplicate families for the purpose of creating "What 
if" tax scenarios as you need to avoid the confusion resulting from having two or more 
sets of information. Instead, us the tax plans which are available specifically to that 
end.  
 

Advanced utilities  
 

The advanced utilities featured in DT Max are operations that should only be carried 
out by users with a very good understanding of computers generally, and of DT Max 
more specifically, or under the direction of Dr Tax technical support staff. Since none 
of these functions are essential to the normal operation of DT Max, it is preferable to 
avoid using them unless you have sufficient knowledge and the authority to do so.  
 
The DT Max advanced utilities are:  
 

• Renumbering clients 
• Synchronizing the setup files 
• Unlocking client files 
• Rebuilding database 
• Reindexing efile archive 
• Analyzing efile archives 
• Viewing the system logs 

 
Synchronizing the setup files  
Synchronization of setup files is carried out to ensure that other members of the firm, 
or a team using the same DT Max database, all operate with the same preference 
settings. To launch this utility, select Synchronize setup files under Advanced utilities 
from the Tools menu, tick the level of synchronization you wish to use and click OK. 
The different levels of synchronization available are the following:  
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Company setup 
This will target all new users, who will then start with identical settings to those 
currently in force for the firm. 

 
All users and company setup 
With this option, all users will start with identical settings to those in force for the 
firm. Any different settings a user may have will be reset accordingly. 

 
Selected users 
Only the users you select, with the Windows marking conventions, will by targeted 
by the synchronization process. This is useful in order to synchronize specific 
settings for a particular group of users or a particular task. For example, you may 
want to synchronize your forms manager settings with those used by staff 
members responsible for final production printing. The settings targeted by the 
synchronization process are:  

 
• Identification 
• User's defaults 
• Forms manager 
• Customized destinations 
• Billing 
• Macros 
• Filters 

 
This process does not affect printer settings, the fields shown on the customizable 
client list, or the user interface settings, which are all stored in the Windows registry 
together with various other items.  

 
Multiple users of the same database  
 
Certain DT Max tools and utilities cannot be used while other staff members are using 
a database. These include rebuilding a database and restoring a database. Others can 
be used in such circumstances, but only with great caution. These include unlocking 
client files and synchronizing setup files. It is obviously important to know who is using 
the DT Max database before attempting to use any of these tools. To find out, choose 
List other users from the Tools menu and you will see the following dialogue box:  
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This will indicate the user ID and name of each person using the same database at 
that particular time. Click Print list if need be.  

 
Special attributes 
 

The security system  
 

DT Max features a multi-level security system which enables users to set up the 
program so that only authorized personnel are allowed to use certain specified 
attributes.  
 
When DT Max is first installed, all users can access any program feature as passwords 
are not required until the security system is activated.  
 

                                                                     80   



DT MAX USER’S MANUAL                                                                   Program features           
 

                                                                                                                       81
 

The user ID and password concept is tied to the DT Max database. If you use different 
databases on different disks or sub-directories, each database must have its own 
security system setup. If a user wishes to input a confidential set of clients, a new 
database can be set up in a separate sub-directory, defining that particular person as 
the system supervisor and sole authorized user of that database.  
 
To activate the security system, you must follow the steps below:  
 

1. Choose a system supervisor 
2. Assign system supervisor status to someone in DT Max 
3. Make passwords mandatory for using DT Max  
4. Assign access rights for all other DT Max users  

 
When running DT Max, a user is first required to enter his/her user ID, that is a unique 
code typically consisting of the user's initials.  
 
If the security system is active, DT Max will check to see that the user ID and 
password are authorized. If not, the user will be prompted to enter the user ID or the 
password again, as the case may be. For security reasons, the password is not visible 
on the screen while being typed in. Once the correct user ID and password have been 
entered, DT Max will only allow that user to access those parts of the program for 
which they were given authorization, as assigned by the system supervisor in the 
security system. Users can see what rights they were granted by selecting the change 
password option.  
 
If your environment does not warrant relying on a security system, there is no 
obligation to use such a feature. A password requirement that was previously set can 
be disabled.  
 
Assigning access rights to DT Max users  
If the security system is active and passwords are required to access DT Max you, as 
system supervisor, must register the DT Max users onto the system and assign 
individual rights to each of them. To that end, select Individual users' passwords and 
rights...  from the Security system option in the Preferences menu. If a DT Max user is 
already listed, double-click the user ID or highlight it, then select Edit.  
 
If you wish to remove someone from the list of authorized users, highlight that 
person's name or user ID and select Delete. To add a new user, select New. 
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When editing existing users or adding new users, you will be presented with the 
access rights dialogue box. There, you can change a user's name, user ID, password 
and individual access rights.  
 
It is important to keep in mind that, in order to properly assign the required access 
rights for each user, the whole picture must be taken into account with respect to your 
personnel's use of DT Max. Be sure to understand the implications of giving or taking 
away access rights. The various access rights available are described below.  
 

System supervisor (full rights) 
The system supervisor has access to every area and feature of the program and 
has the power to add, remove or edit authorized users. In order for passwords to 
be mandatory in DT Max, at least one person must be designated as system 
supervisor.  
 

Access all clients in database 
If ticked, the user can access all client files on the database. If this box is not 
ticked, in principle, the user can only access his own clients' files. However, by 
clicking the Add button located beneath the box of accountant codes accessible, 
you can add accountant codes to which you want this user to have access.  
 
Data entry 
If this box is not ticked, the user cannot enter data in client files, display or print 
client keyword data, or extract clients from the client list.  
 

Delete clients from the database 
If this box is not ticked, the user cannot remove clients from the database.  
 
Change processing statuses of clients 
If this box is not ticked, the user cannot change the processing statuses of marked 
clients in the client list nor add or edit the PROGRESS keyword when entering client 
data.  

 
Display tax returns 
If this box is not ticked, the user cannot display the tax returns of any clients.  

 
Production printing of tax returns 
If this box is not ticked, the user cannot print tax returns in production mode.  
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Change preferences and setup 
If this box is not ticked, the user cannot edit setup features such as the user's 
defaults, the text macros or the efile setup. 

 
Back up a database 
If this box is not ticked, the user is not allowed to back up database files using the 
Backup option of the Tools menu.  

 
Restore database from backup 
If this box is not ticked, the user is not allowed to restore database files from a 
backup using the Restore option of the Tools menu.  

 
Verify data and completed tax return 
If this box is not ticked, the user will not be registered as a verifier in the 
verification system and will not be entitled to set a client's status to Keywords 
verified or Return verified.  
 
Extract and merge client data 
If this box is not ticked, the user will not be able to extract client data to a diskette 
to work on that file at home or to bring it to a client's offices. Similarly, he will also 
not be able to merge new information into the DT Max database.  

 
Efile tax returns 
If this box is not ticked, the user will not be able to access the program's efile 
features in order to electronically file tax returns.  

 
DT NetLink 
If this box is not ticked, the user will not be able to access DT NetLink material. 

 
Confidential databases and files  
When entered in the file of a client, the keyword RESTRICT prevents unauthorized 
users from accessing that client's file. More specifically, the file can then only be 
accessed by the person whose user ID matches the ACCOUNTANT code for that 
particular client. In the client list, there may be a [R] next to this client's name, 
depending on the customization options selected for the list. To remove the restriction, 
the designated user (whose user ID matches the ACCOUNTANT code) must edit that 
client by deleting the RESTRICT keyword.  
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Note that this can only work properly if the DT Max password feature is enabled. If 
password control is not active, any user aware of the appropriate user ID will be able 
to log on and access the restricted client file.  
 

Tax planning   
 

DT Max has a variety of built-in features, which enable you to carry out tax planning 
for the clients in your database. These features are fully integrated into the program 
and can be used at any time. They are designed to help you analyze the tax 
implications of various scenarios so that you can make sound recommendations to 
your clients.  
 
Using your current database, you can devise up to six simultaneous plan versions for 
each client in order to identify, for example:  
 

• The fiscal incidence of selling a small business, property, or stock 
• The relative advantages of various tax shelters 
• The fiscal incidence of increased dividends 
• RRSP limits 
• Donation limits 

 
When creating tax plans, DT Max proceeds in the same manner as when preparing 
production returns, using a few additional features. We recommend that you 
familiarize yourself with entering data and running tax calculations with production 
returns before using these other options, listed below:  
 

• Selecting and copying plans 
• Entering data and calculating plans 
• Displaying the planning summaries and full returns 
• Deleting plans 
• T1 planner 
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Entering data and calculating plans  
After selecting a plan, you are now ready to enter and edit the data for this plan. The 
letter identifying the current plan appears after the client number, at the top of the 
screen. Enter keywords and data the same way you would for production returns. You 
can easily switch between plans using the drop-down menu titled Type of return on 
the data entry screen toolbar. The keyword PLAN-TITLE can be used to help manage 
your plans.  
 
Tax planning calculations can be run either from the data entry screen or from the 
client list in the same way as for production returns.  
 
Viewing plans 
Pressing [Alt+F9] in the data entry screen will bring you to the tax return display, 
where you may switch to another plan using the drop-down menu located at the left of 
the screen.  
 
Printing plans 
You can either click the Production printing icon, or select Tax return in the Print 
option of the File menu. This will bring you to the Printing of tax returns dialog box 
from where you can select the plan you want printed.  
 
Selecting and copying plans  
You can select which plan you want to work with by choosing Plan in the View menu. 
You can also select plans through the Type of return drop-down menu, on the data 
entry screen toolbar.  
 
The six available plans are listed as A through F. Unused plans are listed as blank and 
plans which have been created earlier will be identified by the names they were given 
using the keyword PLAN-TITLE. If you have selected a blank plan, a menu will appear 
for you to select existing data to copy into the plan. The option Previous year will copy 
the data from the year prior to the current tax year whereas the option Current year 
will copy this year's data, and Next year will copy next year's data or carryforwards.  
 
When using the DT Max T1 program, the "Copy from..." feature will automatically copy 
the selected information for all members of the family unit.  
 
If you want to copy selected data only, choose Keep blank, use the Right-hand side 
display and the Windows marking conventions, then select Copy to left-hand side from 
the menu which appears when right-clicking in the data entry screen.  
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Displaying planning summaries and full returns  
When tax calculations involving planning information are run, a planning summary of 
the results is generated along with a completed tax return.  
 
You can easily switch between a client's returns using the drop-down menu titled Type 
of return on the displayed tax return toolbar. This allows you to choose from all the 
plans currently existing for this client and the regular production return (subject to 
their being present on the print queue).  
 
Deleting a plan  
From the data entry screen of the client for whom you wish to delete plans, select 
Delete plans... from the File menu. In the next window, select All plans or only the 
letter identifying the specific plan version that you wish to delete.  
 
In the T1 program, you can also choose to delete the selected plans for the current 
client only or for the entire family unit. You can abort this procedure at any step by 
clicking the Cancel button.  

 

The annual T1 planner  
 

Shortly after the end of the tax season, Dr Tax Software releases a version of DT Max 
referred to as a the "planner", which constitutes a preliminary version of the program 
for the current tax year, intended for the next tax season.  
 
The planner features calculations based on information obtained from budget 
announcements and other such sources. Of course, it does not yet feature the official 
forms prescribed by the governments, which are only made available at the very end 
of the year.  
 
With the T1 planner, the preliminary tax planning for your clients is fully integrated 
with the rest of the program. You can toggle between the different tax years (i.e. the 
recently completed tax year and the current one) using the Change tax year option 
from the File menu.  
 
All the planning features are available in the program at all times and may be useful to 
you both before and during the tax season.  
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Deceased or bankrupt taxpayers 
While the planner version is not suitable for filing the returns of living taxpayers, it can 
legally be used to file returns on behalf of deceased taxpayers. Upon calculating, tax 
plans will appear with our preliminary updates of tax forms for the new tax year but 
returns of deceased taxpayers will appear on approved forms from the previous tax 
year, pursuant to the CRA's instructions.  
 
This also applies to the filing of bankruptcy returns.  
 

The billing module (T1, T3)  

 
The DT Max billing module is designed to generate invoices automatically for tax 
returns prepared using the DT Max T1 personal tax program or T3 trust tax program. 
The rate card method enables you to invoice your clients easily and consistently, in 
accordance with the services performed. The default values entered in this setup will 
determine how the billing system will process your data.  
 
Billing defaults 
The billing defaults are located under the Options and Tax information tabs. To enter a 
value for a billing default, click the entry field for that particular default and select the 
appropriate option from the drop-down menu by clicking it or pressing [Enter] after 
using the arrow keys to highlight it. These defaults may be overridden in any client file 
using the billing keywords.   
 

Under the Options tab, the first default value that you need to set up will determine 
which type of invoice you would like to produce: 
 

No automatic invoice 
The tax preparer will be using the billing keywords to produce an invoice. 

  
Automatic - itemized tasks and costs 
DT Max will produce an itemized invoice according to your billing setup. Each item 
on the rate card that generates an amount will be printed on the invoice along with 
the total charge for that item.  
 
Automatic - total only 
The invoice generated by DT Max will not provide any particular details with respect 
to the actual charges it comprises.  
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Automatic - itemized tasks only 
DT Max will produce an itemized invoice showing each item on the rate card that 
generates a charge but without indicating the charge.  

 
The second and third default values pertain to the returns of the client's spouse and 
dependants, if any. Again, there are three options to choose from which will determine 
the billing method applicable to each: 
 

No invoice - tasks not charged 
The spouse/dependant will not be billed nor included in the invoice generated for 
the family head.  

 
Individual invoice 
The rate card amounts will apply to the spouse/dependant as well as to the family 
head, but separate invoices will be generated.  

 
Charges added to invoice of family head 
The rate card amounts will apply to the spouse/dependant as well as to the family 
head and all charges will appear on a single invoice, addressed to the family head.  

 
The fourth billing default requires you to choose one of the following options for the 
invoice numbers:  
 

• Do not show an invoice number  

• Leave space for the number to be manually added  

• Allocate automatically based on client number  
 

Note that the keyword INVOICE-NUM can be used to assign a specific invoice number 
to any invoice.  
 
The fifth billing default enables you to specify whether the client's phone number will 
appear on the invoice.  
 
Under the Tax information tab, another billing default requires you to determine 
whether or not the service taxes for each invoice (GST, PST and HST) are to be 
itemized or included in the charges: 
 

Not included 
DT Max will add any applicable taxes to the total of the invoice and will show them 
as separate entries.  
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Included 
The amounts entered on the rate card will include any applicable taxes.  

 
Rate card 
The rate card is used by the program to assign a charge to each return or schedule 
produced and/or to certain keywords used in creating the tax return. In other words, 
your client can be charged either per schedule produced or per keyword used 
(corresponding to each receipt or dollar amount) or both.  
 

The rate card lists a large number of schedules, as well as other items referring to 
keywords and the efile service. Each item may be assigned a charge.  
 
Note that when displayed for the very first time, the rate card is empty as no values 
have been entered yet.  
 
Entering charges 
Each item listed on the rate card, whether systematically produced by the program or 
used by the tax preparer at the time of calculation of a client's tax return, is called a 
"unit". To set up the rate card, you must first determine a cost for any units that you 
wish to charge for, and the number of units which will be charged at that cost.  
 
For example, in the T1 program, you may wish to set up the rate card on a household 
basis so as to charge $75.00 for the first tax return produced and $25.00 for each 
additional return, in order to fairly charge the case of a couple with teenage children.  
 
You may also wish to set up the rate card so as to not charge anything for the first two 
T4 slips input into the data and $2.00 for every additional T4 slip input for this client, 
so as to reflect the additional work required to prepare time-consuming returns with 
several sources of employment income. There are three types of entries for each unit 
listed in the rate card: 
 

A = base cost ($0 - $500) 
To assign a cost to a unit, click the entry field of the unit to be charged and enter 
the appropriate amount, between $0 and $500.   

 
B = number of units included in base cost (0 - 99) 
Use this field to specify the number of units to which the base cost will apply, 
between 0 and 99.  

 
C = cost per additional unit ($0 - $500) 



Program features           DT MAX USER’S MANUAL 

                                                                     90   

Enter the amount to be charged on a per unit basis for any additional unit 
exceeding the number previously entered in B.  

 
Care must be taken in assigning the amounts to be charged as duplication should be 
avoided. When determining charges, keep in mind the billing defaults you have set, 
especially regarding how spouses and dependants are to be invoiced. It is important to 
remember whether your rate card reflects a client or a household. You must ensure 
that you will not be billing the same individual twice, or charging for the same service 
twice (once as a schedule and again for each entry on that schedule). If you prefer to 
charge your client based solely on the preparation of the tax return and efile services 
that you provide, excluding any other schedule or input, you may enter amounts as 
unit costs for those items only and ignore all other items listed. DT Max provides 
flexibility, but the tax preparer must remain cautious.  
 
Negative amounts cannot be entered, and the maximum amount that can be entered 
is $500. 
 
Once you have completed your billing setup, click OK to save your entries and exit the 
module. Once the setup is completed, billing takes place together with the tax 
calculations. Therefore, if you make changes to the rate card after calculating a client's 
tax return, you will have to force recalculation in order for the new rates to take effect.  
 
Whichever billing method you choose, GST, PST and HST registration numbers and 
rates should be entered in the Identification section of the program, under 
Preferences, before you begin generating invoices.  
 
Billing keywords (T1, T2, T3) 
The following billing keywords may be entered into the client database in the usual 
manner. If no data is entered in those keywords, then billing will proceed according to 
the user's setup or default setup, as the case may be.  
 

BILL-CODE   billing code or reference number to be printed on the invoice 
BILL    amount and text of client's invoice to be generated  
BILL-TEXT   text to be printed at the bottom of the invoice  
BILL-TYPE-OV  billing type override for file of family head  
BILLSPOUSEOV  billing type override for file of spouse  
BILLDEPENDOV  billing type override for file of dependant  
BILL-ADJUST$  adjustment to client's invoice in dollar amount  
BILL-ADJUST%  percentage adjustment to client's invoice  
BILL-NOTE   internal note regarding billing  
INVOICE-NUM  invoice number  
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DT NetLink (T1) 

  
DT NetLink allows your clients to enter their own tax information on our secure Web 
servers. You can then import the completed interview information straight into your 
DT Max database. No more tedious inputting, and with DT Max's display of the current 
year and DT NetLink data side-by-side, review is a snap. Here's how it works:  
 

Start-up 
Dr Tax will create a database for your clients only. The welcome pages and 
database will be fully "branded" with your firm's name and logo. All the instructions 
and tools necessary to set up DT NetLink on your Web site can be found on the   
DT NetLink tools page. In order to follow-up on DT NetLink files, you may want to 
customize the client list to include the DT NetLink status, DT NetLink user ID,      
DT NetLink password and DT NetLink email address. Filtering on the keyword 
DTNETLINK-ID will also help you monitor the progress of the DT NetLink files 
throughout the tax season.  
 
STEP 1 - Export  
Use the DT NetLink setup option from the Tools menu to determine how you wish 
the DT NetLink user ID's to be created, and for details on how the passwords are 
generated. Use the DT NetLink export feature to upload your clients' data to your 
online database. The DT NetLink status on the client list will show as "Waiting for 
TP" (taxpayer).  

 
STEP 2 - Invitation 
Inform your clients of this new service and invite them to visit your site and log 
onto DT NetLink using the user ID and password that you have created for them in 
step 1 above. A sample invitation email is available from the DT NetLink tools 
section of our Web site. 

 
STEP 3 - Interview  
Using any computer with an Internet connection, your clients may access            
DT NetLink from anywhere in the world just by going to your Web site. DT NetLink 
uses the QuikClik interview process, which enables your clients to go through all 
available screens in a logical order, or skip directly to the input screens they 
require. The DT NetLink status on the client list will show as "WIP client" (work in 
progress). Once they have completely finished entering their tax information and 
do not intend to return to the data collector, your clients click the "Submit tax file" 
button to let you know that they are done. This will also lock their files to ensure 
that they will not be able to edit the information any further while you are 
processing their tax data. The DT NetLink status on the client list will show as 
"Ready to import".  
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STEP 4 - Import 
Use the DT NetLink import feature to download your clients' data to your DT Max 
database. The DT NetLink status on the client list will show as "Ready to merge".  

 
STEP 5 - Display DT NetLink data 
Select DT NetLink data from the drop-down menu of the right-hand side display 
feature. The tax data entered in DT NetLink will appear on the right-hand side, 
ready to be copied to the left. Once data has been copied from the right to the left-
hand side, the DT NetLink status on the client list will show as "Merged". Note that 
in order to comply with the CRA’s third party liability rules, you will need to receive 
the taxpayers tax slips and have an original T183 duly signed on file before efiling 
any tax returns. 

 
STEP 6 - DT NetLink file management  
Use the DT NetLink file management features to manage your DT NetLink files 
during the tax season. You can unlock and delete DT NetLink files, and update     
DT NetLink statuses at any time. 

 
 

Please refer to the DT Max knowledge base for more information. 
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ELECTRONIC TRANSMISSIONS 
 
Electronic filing of tax returns (efiling)  

 

Overview  

The procedure for filing tax returns electronically involves the steps described below: 
 

STEP 1 
Register and obtain approval to use the governments' electronic filing systems. 

 
STEP 2 
Complete the DT Max efile setup according to your chosen efiling method. This 
must be done separately for each government to which you intend to file returns 
electronically. 

 
STEP 3 
Prepare and review the tax returns. Have in your possession any required efile 
authorization forms (e.g. T183) duly signed by your clients.  

 
STEP 4 
Transmit the electronic returns and pick up the acknowledgments that are 
available. 

 
STEP 5 
View and print the efile reports (acknowledgments), then correct and re-transmit 
any returns with efile errors.  

 
Complete the returns that have been acknowledged. You should hold on to all 
documents used to prepare the return for six years, and only send them to the 
government if requested. Submit payment where applicable.  
 
Help from the government and Dr Tax Software is available at all stages of the 
process.  
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Efile registration  
 

Registration for efile is the first step in the process. Once you are fully registered, call 
Dr Tax client services at 1 (800) 663-7829 to update your DT Max licence information 
accordingly. In order for the efile module to work properly, it is imperative that your 
Dr Tax client information includes the relevant licence information, efile rights, and 
efile number(s). When you are ready to begin efiling, proceed to the efile setup. 
  

Efile setup  
 

Completing your efile setup within DT Max is the second step in the process. This is 
done only after you have properly registered and are ready to begin preparing and 
transmitting electronic tax returns. 
 

1. Select Setup from the Efile menu on the toolbar then select the government tab 
you require.  

 
2. Select the appropriate efile transmission method, either Transmitting via Dr Tax 

or Transmitting directly.   
 

Make sure that the efile number (preparer number) and password or access 
code entered are the ones you were assigned by the government for the current 
year. If the efile module is not accessible or your efile number is incorrect, 
contact Dr Tax client services at 1 (800) 663-7829 to obtain an updated licence. 
 

Refer to the following tips to complete your setup for each individual 
transmission method: 

Federal T1 

Option #1 - Federal T1 using the Dr Tax transmission service 

Select Transmitting via Dr Tax and then Dr Tax via Internet, or Dr Tax dial-up 
service if you do not have Internet access.  

Option #2 - Federal T1 sending directly to the CRA's Web site 

Select Transmitting directly and then Efile On-Line Plus - automated - batches 
up to 60 or Efile On-Line - manual - one return per session.  
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Quebec TP1 

Option #1 - Quebec TP1 using the Dr Tax transmission service 

Select Transmitting via Dr Tax and then Dr Tax via Internet, or Dr Tax dial-up 
service if you do not have Internet access.  

Option #2 - Quebec TP1 sending directly to the MRQ's Web site 

Select Transmitting directly and MRQ Web site. Enter the Web access code you 
were assigned by the MRQ.  

3. Select which returns you wish to efile by default. If you wish to override your 
default settings for any client, you can use the EFILE keyword in the data of that 
particular client's file. If information is missing in any entry field, this field will 
be displayed as a yellow box and you will be warned that your efile setup is 
incomplete.  

 
4. Click Save to end the setup and proceed to the next step, preparing returns for 

electronic filing.  
 

Preparing returns for electronic filing  
 

The actual preparation of tax returns for electronic filing is the third step in the 
process. This is done only after you have properly registered and completed your efile 
setup. 
 
Preparers deal directly with the taxpayer and are therefore responsible for checking 
supporting documents in order to ensure the accuracy of all information regarding 
income, deductions, and tax credits.  
 
Once you have finished preparing the tax returns you wish to transmit, display each 
return and perform one final review. Refer to the Notes and diagnostics page of the 
return to determine if it is eligible to be efiled. If it is deemed ineligible for efile, it may 
be that an internal logic failure prompted the ineligibility status, or that pursuant to 
the governments rules this client's return did not meet all of the efile criteria.  
 
Have any required efile authorization forms signed by your client before transmitting 
T1 returns to the CRA, namely Form T183 titled Information Return for Electronic 
Filing of an Individual's Income Tax and Benefit Return. 
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The Quebec equivalent for TP1 returns is Form TP-1000.TE titled Internet Filing of 
Personal Income Tax Returns: Statement and Authorization by Individuals. Note 
however that this form is not required if your client has provided you with his/her 
access code, entered in the keyword ACCESS-CODEQ.  
 
You are now ready for step 4, transmitting electronic returns. 

 

Transmitting electronic returns  
 

Electronic transmission of tax returns is the fourth step in the process. It takes place 
after you have properly registered, completed your efile setup, and finished preparing 
the tax returns.  
 
When ready to transmit, click the Efile icon or select Transmit and receive from the 
Efile menu. You can transmit the current client or several clients marked in the client 
list. 
 
Note that you may file to multiple jurisdictions at once by selecting the destinations 
accordingly.  
 
After you click OK, DT Max will generate the electronic returns for the clients and 
jurisdictions selected, transmit the returns to their respective destination, receive any 
acknowledgements available, and update the client statuses accordingly as either 
transmitted or acknowledged.  
 
To review and print your efile reports, select the relevant option in the Efile menu. 
Efile reports are discussed in greater detail in STEP 5 - Viewing and printing efile 
reports.  
 

Note: If using Efile Online - Manual - One return per session (T1) or 
Corporation Internet Filing (T2), the Transmit and receive option will simply 
create "efile-ready" files named XXXXXX.TAX for T1 or XXXXXXX.COR for T2, where 
XXXXXXX is the client number from the DT Max database. These files will be 
available from a sub-directory of your database named E_OUT. 
 
You will then launch your Internet browser and access the CRA's Web site for T1 
efile online or T2 corporation Internet filing, follow the instructions, and upload 
your files one at a time using your efile number and access code. The files will be 
processed in real time, meaning that the acknowledgements will be generated 
almost instantly.  
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Your DT Max database statuses will not be updated under these transmission 
methods but this task can be done manually by using the feature Move statuses 
forward and selecting Efile acknowledgement. It is highly recommended to print 
these real time acknowledgements from your Internet browser, for your records.  

 

Viewing and printing efile reports  
 

Viewing and printing efile reports is the fifth and last step in the process. It takes place 
after you have properly registered, completed your efile setup, finished preparing the 
tax returns and proceeded with electronic transmission.  
 
Efile reports can be viewed and printed by selecting View/print reports from the Efile 
menu. All transmissions sent and received are listed in the efile reports screen, and 
are classified by control number, date and report type. Simply scroll through the list 
and mark the reports you wish to view or print, then select View/print reports. Note 
that reports which have been received but have not yet been viewed are identified as 
"NEW" in the control number column. All the reports selected will then be displayed for 
review. You can use the Windows scroll bar to move through the reports. Use your 
mouse's right button to choose the page or report you wish to display or print. 
  
Types of transmission reports 
 

TSR 
After transmitting your returns you will obtain a transmission status report (TSR). 
The TSR is simply a confirmation that your returns have been sent. You will obtain 
a separate report for each government. 
 

Acknowledgment file (151) 
An acknowledgment file indicating whether or not the return has been accepted will 
be available within 3 to 24 hours after transmission depending on the volume of 
returns that are being processed at a given point in time. The report will be 
retrieved automatically the next time you attempt to efile a return. If you are not 
planning to transmit again soon, you can still retrieve the reports by selecting the 
option None - just pick up acknowledgements under Transmit and receive. 

 
The status of all efiled clients will be automatically updated within the DT Max 
database as returns are being transmitted or acknowledgement reports are being 
retrieved.  
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Important: If you have a system that contains several databases and you are 
transmitting from two or more of them, DT Max will automatically attempt to update 
all your client files when you access the transmission service to retrieve any 
outstanding acknowledgment reports. As a result, if you retrieve acknowledgement 
reports from database X you will also be automatically retrieving any available reports 
that relate to database Y without properly updating the status of the clients that relate 
to database Y. Therefore, we strongly recommend that only one computer and 
database be assigned the task of handling all transmissions. This will ensure that all 
acknowledgment reports are properly processed within that one database. 
 
If a return has been successfully efiled, the keywords EFILE-RESULT and PROGRESS 
will appear in the client’s file. The keyword EFILE-RESULT will specify the document 
control number and the date of transmission whereas the keyword PROGRESS will 
indicate Efile acknowledgment OK. 
 
Note that once you have successfully transmitted a return, you cannot efile it again. If 
you subsequently locate an error in the tax information, you will have to file a paper 
copy of the amended return with reference to the efile confirmation number. You 
cannot efile an amended return.  
 
If the return has been rejected, the keywords EFILE-RESULT and ERROR-CODE will 
appear in the client’s file. You should first determine the cause of the error, then make 
the appropriate corrections to the client’s data. 
 
If using Efile Online - Manual - One return per session, no reports are generated in   
DT Max. Acknowledgments occur in real time and should be printed through your 
Internet browser. 
 

Correcting efile errors  
 

The preparer is responsible for correcting any efile errors in rejected returns. Once 
corrective steps have been taken, a return can be retransmitted.  
 
If, however, changes made to the return alter the refund or balance owing by more 
than $300, a new efile authorization form (T183 or TP-1000.TE) must be completed 
and signed by the taxpayer.  
 
Also note that if an efile error cannot be corrected, the return will have to be printed 
and filed on paper.  
 
Each government's efile program has its own list of efile errors. 
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Filing corporate tax returns electronically  

 
The DT Max corporate efiling module supports corporation Internet filing via the CRA's 
Web site. This method uses EDI, SSL encryption for security, and the Internet as the 
transmission method.  
 
Most corporate income tax returns can be filed electronically. The exceptions are: 
 

• Returns for insurance corporations involved in underwriting  

• Returns which include a claim for scientific research and experimental 
development (SR&ED) expenditures carried on in Canada  

• Returns for non resident corporations  

• Returns for the first year following an amalgamation  

• Returns which include the winding up of a subsidiary  

• Amended returns  

• Returns for any year prior to the 2002 tax year  

 
Visit the CRA's Web site for more details on corporation Internet filing. 
 
Note that you cannot use the corporation Internet filing service for the purpose of 
changing information such as a corporation's name, head office and/or mailing 
addresses, and direct deposit information (including new requests).  
 
For such inquiries, contact the business window in your tax services office, toll-free at 
1 (800) 959-5525 (English) or 1 (800) 959-7775 (French).  
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Corporate Internet filing with the Canada Revenue Agency (CRA)  

 
Step 1 - Completing the federal T2 efile setup 
To access the federal T2 efile setup, select Setup from the Efile menu. DT Max will 
display the Federal T2 menu by default. Select which corporate returns you wish to 
transmit and click Save.  
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Step 2 - Reviewing the eligibility requirements and legal obligations 
Prior to transmitting a corporate return, you must determine whether or not it is 
eligible for efile. Should a return be ineligible, DT Max will mention it in the Notes and 
diagnostics page. You may also visit the CRA's Web site for an up-to-date list of the 
exceptions and restrictions as well as go over your legal obligations. 
 

 
 
Step 3 - Obtaining client consent 
Prior to transmitting a return, you must print federal form T183 CORP - Information 
return for corporations filing electronically and have it signed by your client. 
If this form was not generated, please refer to the Notes and diagnostics page to 
determine why the return was deemed ineligible for efile (step 2 above).  
 
Step 4 - Transmitting 
To transmit a corporate return, click the Efile icon, or select Transmit and receive from 
the Efile menu. Then, under Jurisdictions to efile, choose Current client and the option 
Federal.  
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Please note that although the CRA will only allow files to be transmitted one at a time, 
DT Max does have the capability of generating multiple ".COR" files at once. To do so, 
simply mark the clients in question (using either the spacebar or the [F5] key) in the 
client list. 
 
Once completed, select Transmit and receive from the Efile menu and you will notice 
that the option Marked clients that are eligible for efile will be automatically selected.  
 

 
 
Once you click OK, an efile transmission log will be generated. This log will display the 
creation of any corporate files that are ready for Internet filing. All files will be named 
"XXXXXXX.COR" where the "XXXXXXX" denotes the DT Max client number (as 
specified within the DT Max database). These files will be saved within a subdirectory 
of the database. This subdirectory is named E_OUT. 
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Clicking Close will bring you to the T2 Internet filing menu. This menu allows you to 
connect to the CRA's Web site.  
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Once connected to the site, you will have to complete the identification area and 
attach the file itself (making sure to include the ".COR" extension). Note that the CRA 
will only upload files one at a time.  
The identification area will require: 

• the corporation's business number (BN)  

• the corporation's taxation year-end (TYE)  

• the transmitter's assigned Web access code (WAC) or Efile On-Line number 
and password  

 
If you are already registered to efile personal tax returns, then the same Efile On-Line 
number and password can be used to transmit corporate returns.  
 
Please note that when accessing the CRA's Web page and attaching the file, you will 
be required to input its location and name. This information can be obtained from the 
efile transmission log. Alternatively, you may copy the location from the T2 Internet 
filing menu and paste it onto the CRA's Web page. Once completed, you will then only 
have to manually enter the name of the ".COR" file. In the example above, the 
location and file name would be specified as follows: 
 

D:\Client\E_Out\9092.COR  
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Any files submitted will be processed in real time, meaning that the 
acknowledgements will be generated almost instantly. It is highly recommended that 
you print and retain such acknowledgments for your records. Once a corporate return 
has been successfully transmitted, you should delete the .COR file from your E_Out 
folder. This can be accomplished through Windows Explorer.  
 
You should also note that the processing statuses of transmitted returns will not be 
automatically updated by DT Max. They can be updated manually through the DT Max 
option Move statuses forward found in the Management menu by selecting Change 
statuses and selecting Efile acknowledgement, or using the PROGRESS keyword.  
 
 

Corporation Internet filing with Revenu Québec  

 
Step 1 - Completing the Quebec T2 efile setup 
To access the Quebec T2 efile setup, select Setup from the Efile menu and click the 
Quebec tab. After selecting which corporate returns to file via the Internet, you will be 
required to enter your Clic Revenu user code and password. If you do not want your 
password displayed in the efile setup, you may leave this field blank but this will 
require DT Max to prompt you for your password prior to transmitting any returns.  
 
Once the setup is complete, click Save.  
 
Note: If you do not have a Clic Revenu user code and password, you can apply within 
the efile setup by clicking RQ's Corporation Internet Filing Web site.  
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Step 2 - Reviewing the eligibility requirements 
Prior to transmitting a corporate return, you must determine whether or not it is 
eligible for efile. Should a return be ineligible, DT Max will specify it within the Notes 
and diagnostics page.  
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Step 3 - Obtaining client consent 
To transmit a corporate return, you must ensure that the corporation in question has 
granted you power of attorney. You can view a listing of the businesses that have 
granted you power of attorney when accessing the Clic Revenu site. 
 
If a corporation has not granted you power of attorney, it may do so electronically 
after having registered for Clic Revenu, or you may complete form MRW-69 Power of 
Attorney, Authorizaton to Communicate Information to a Person Registered for Clic 
Revenu Services, or Revocation. 
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Step 4 - Transmitting the return 
When ready to transmit, click the Efile icon or select Transmit and receive from the 
Efile menu. Although you have the option to transmit either the current client or a 
specified batch of clients, we recommend returns be transmitted one at a time.  
 
DT Max will transmit the CO-17 keying summary and GIFI information by efile, and 
submit all other schedules in PDF format. Any additional supporting documents that 
must be attached can be included through the keyword QCEFILE-ATTACH.  
 
After you click OK, DT Max will generate and transmit the electronic return, and 
retrieve any available acknowledgements. Although the transmission takes place in 
real time, you may notice a delay as DT Max builds and transmits the file in question.  
 

 
 
 
Step 5 - Viewing the efile reports 
Efile reports can be viewed and printed by selecting View/print reports from the Efile 
menu. All transmissions are listed in the efile reports screen. Simply scroll through the 
list and mark the reports you wish to view or print, then select View/print reports. 
(Note that reports that have been received but have not yet been viewed are identified 
as "NEW" in the control number column.) All the reports selected will then be 
displayed for review. You can use the Windows scroll bar to move through the reports. 
Use your mouse's right button to choose the page or report you wish to display or 
print.  
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If a return has been successfully efiled, the keyword PROGRESS will appear in the 
client's file indicating Efile acknowledgment - Quebec.  
 
Note that once you have successfully transmitted a return, you cannot efile it again. If 
you subsequently locate an error in the tax information, you will have to file a paper 
copy of the amended return with reference to the efile confirmation number. You 
cannot efile an amended return.  
 
If the return has been rejected, the keyword ERROR-CODE with a description of the 
error will appear in the client's file.  
 
 

Please refer to the DT Max knowledge base for more information. 
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PRINTING 
 
Printing tax returns  

 

Printer customization  
 

To specify the printer(s) you wish to use within DT Max, select the Printer selection tab 
from the Printing of tax returns window. Select Use the same printer for all printing of 
tax returns (recommended) if you will be using one printer and one tray only for all 
your printing requirements.  
 
Select Use different printers for different destinations if you wish to use several 
printers, or one printer only but with multiple trays. For each destination, specify 
which printer and tray (if applicable) you wish to use. The printing options described 
below are available as well:  
 

Reverse order (R) 
This will print all the pages selected in reverse collation order, which is helpful with 
printers that feed paper through to the output bins face up. Most inkjet printers do 
so in order to allow the ink to dry.  

 
Condensed (C)   
This will print four pages of the tax return on one sheet of paper only. Note that 
this option is disabled when printing government destinations.  

 
Double-sided (2) 
Also known as "duplexing", this enables printing on both sides of a sheet of paper. 
Most higher-end printers have a "duplexer" accessory for this feature. This option is 
also disabled for government destinations.  

 
 
Which clients  
In this area, you can select which client(s) you wish to include in your print job. The 
following options are available:  
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Current client 
The client whose file you last worked on is the current client. Note that if you 
attempt to print a current client who is not yet on the print queue, you will receive 
an error message indicating that there are "No clients to process".  

 
Current family 
With this selection (T1 only), you choose to print the tax returns of the current 
client and all his or her family members, provided they all appear on the print 
queue.  

 
Marked clients 
This option will only be available if you have previously scrolled through the client 
list and selected every client you wish to print in the batch, using the Windows 
marking conventions.  

 
Keep in mind that you can only print clients who appear on the print queue. 

 
Which versions 
In this area, you can select which type of returns you want to print (i.e. production or 
plan).  
 
Copies to print  
There are two basic methods of managing the copies to print:  
 

• through the final destinations of a tax return 
• through the number of copies desired  

 
Copies to each destination (recommended) – uses the forms manager 
This option enables the printing of all destinations for which certain forms have 
been requested using the form manager.  

 
Copies to selected destinations only – uses the forms manager 
This option enables the printing of the forms requested for the destination(s) that 
have been specifically ticked.  

 
Multiple copies – ignores the forms manager 
This allows you to indicate the number of copies you wish to print for the pages 
selected.  
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Note that specific destinations can be reprinted for any given client by resetting such 
destinations to Waiting in the Status information window for the client.  
 
Two customized destinations can also be added to the list for those users who require 
more flexibility. This can be done through Printing options in the Preferences menu.  

 

Forms to print  
In this area, you can select which forms you wish to include in your print job. The 
following options are available: 
  

Automatic selection (recommended) 
This option enables the printing of forms based on the settings selected in the 
forms manager and the processing status system.  

 
All forms 
This option enables the printing of all the pages you have defined in the forms 
manager for the destinations selected under the Copies to print section. You may 
also simply print a certain number of copies of all pages produced for the client 
selected, as entered under Copies to print.  

 
Certain types of forms 
This option allows you to print certain pages, which DT Max has defined into a 
package. Such packages include jackets, keying summaries, authorizations for the 
relevant jurisdictions as well as correspondence for the client selected. 

 
Selected forms 
This option lets you create your own package of pages to print for the client(s) 
selected. The Select forms... button enables you to make your selection from the 
DT Max form list. Select the form(s) you want by using the Windows marking 
conventions.  

 
Keep in mind that the pages selected can only be printed if generated as part of a 
client's tax return, which must appear on the print queue.  
 
Blank tax forms  
Blank tax forms can be printed within DT Max using the option View or print blank 
forms from the View menu.  
 
Select the form(s) you wish to print by using the Windows marking conventions. Then, 
select the appropriate printer and tray, indicate the number of copies of each form 
selected that you wish to print, and click Print.  
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Printing destinations  
 

While most of the destinations have preset names such as Federal CRA, Client and 
Office among others, which cannot be changed, two customizable destinations are 
reserved for users to designate as they wish. For example, if you want to generate two 
office copies, you could name one of the spare destinations "Office - 2nd copy". Or, 
you might need a "Bank copy".  
 
You must give a customized destination a name before you can begin using it. To do 
that, select Printing options from the Preferences menu, enter a descriptive name for 
each destination that you require and click OK to save.  
 
Once the destination is named, use the Forms manager to specify which forms you 
want sent to that destination and then adjust your printing setup to include this new 
destination in your next print job.  

 

Forms manager  
 

The forms manager is a feature that allows you to determine which forms will be sent 
to the various printing destinations. The managing chart lists all the forms that DT Max 
can generate for those destinations.  
 
To specify the printing condition of a particular form for any given destination, right-
click the appropriate cell and select a printing option from the drop-down menu. The 
options offered are described below.  
 
Note that the printing options available for any given destination are restricted to 
those that are relevant to this particular destination. For example, because no form 
can be efiled to the office, that specific option would not appear in the menu for that 
destination.  
 

Print if required (paper) 
The form will be printed only if without it, the tax return would be missing a 
required component or otherwise be considered incomplete. Note that DT Max will 
not print schedules with results of zero or less (except for income and expenses 
schedules and capital gains schedules). DT Max will also not print such forms when  
efiling.  
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Print if required (efile or paper) 
The form will be printed even when the client's return is being efiled. Typically, this 
form must be sent to the government even when efiling.  

 
Print if data exist 
The form will be printed not only if required to make a complete tax return, but 
also if it contains any information that may be useful in understanding or verifying 
the return. Keep in mind that DT Max will display all forms relevant to a tax return, 
regardless of the printing conditions selected for the various destinations. 
Therefore, if you want to print any of the forms displayed, for your client or for 
verification, this is the option to select.  

 
Do not print 
The form will not be printed for this destination.  

 
To apply the same printing condition to a block of destinations, a block of forms or 
both, hold down the [Ctrl] key, use the left button of your mouse to select a range of 
cells, and then choose the appropriate printing condition from the menu appearing on 
the screen when you right-click any of the highlighted cells.  
 
Once you have completed defining the printing condition for a form, click Save to save 
your changes and repeat the procedure for other forms, as required.  
 
Any changes made to this setup will become the current default settings until standard 
default values are restored. This can be done with the Form mapping reset button 
which gives you two options to choose from: 
 

Reset to company's defaults 
This will allow you to restore the default settings of your firm as previously set by 
your system supervisor.  

 
Reset to DT Max defaults 
This will allow you to restore the default settings originally incorporated in the     
DT Max program.  

 
The Print button appearing in the lower left corner of the window will allow you to print 
a complete or partial list of the forms generated by DT Max. Note that this feature will 
not enable you to print actual forms. 
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Printing or exporting client list data  
You can print or export basic client list data by selecting Print and then Client list from 
the File menu, or by clicking the Print icon on the client list toolbar.  
 
Client list printing or exporting can include the current client, the current family, 
marked clients, your own clients or all clients on the database.  
 
When printing, the data will be printed as displayed on the screen so feel free to 
customize the client list in accordance with your preferences. Note that using legal size 
paper with a "landscape" capable printer can maximize the data printed, but if too 
much data has been selected from the client list, it may cause the printed data to be 
truncated.  
 
When exporting, the data to export can first be chosen by clicking the Select data to 
export button, and then directed to a file of your choice. Select Export to file to create 
an ASCII file with the data arranged in columns. This option is useful if you want to 
get a list of client information which you can manipulate manually using an application 
such as NotePad. With this option, we recommend that you use a ".TXT" extension for 
your file. Select Export to file - comma delimited to create an ASCII file that you can 
later import into a spreadsheet. With this option, we recommend that you use a 
".CSV" extension for your file.  
 
For either export option, the first line of the exported file has labels to identify the 
data in the column. Note that there is currently no corresponding import facility in    
DT Max.  

 

Batch printing of keywords  
You can print a batch of keywords by selecting Print and then Keywords from the File 
menu. Keywords can be printed for the current client, the current family, marked 
clients, your own clients, or all clients on the database.  
 
You can also select which information you want printed on the right-hand side of the 
current year data. A printout that includes prior year information can serve as a useful 
tool when interviewing a client in order to make sure that you are gathering all the 
information and slips required.  



DT MAX USER’S MANUAL                                                                                 Printing           
 

Production printing  

 
There are two ways to print tax returns for production: 
  

• Clicking the Production printing icon  found on the Display tax return 
screen.  

 
• Selecting the options Print and then Tax return from the File menu.  

 
Before you print for the first time, review all the options available to tailor the DT Max 
printing system to your needs.  
 
For most users, DT Max's default printing setup will be adequate.  
 
However, if you have special requirements, you may be able to significantly reduce 
printing costs during production printing by assessing your printing requirements and 
customizing DT Max printing. 

 

Label printing  
 

DT Max provides a quick and easy way of printing great looking client labels, and also 
gives you the ability to customize labels per your specific requirements, such as labels 
for the taxation centres or district offices, for instance.  
 
Label definition 
The Label definition tab is where you can select the label you need, or customize one if 
what you require is not yet available in the list.  
 
The Standard layout option includes a drop-down menu where you can choose among 
many standard size labels, as well as numerous Avery labels listed with their 
respective universal product codes (UPC).  
 
The User-defined layout option enables you to set the number of labels you want 
printed per page, as well as horizontal and vertical dimensions.  
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You can see a preview of the layout obtained with the selections entered in the Layout 
of labels area, on the right-hand side of the window.  
 
Client labels  
To print client labels, you must first select and define your label print job according to 
the three following steps:  
 

• setup 
• text to print 
• label definition 
 

Once you have entered the required information, you may click Print in order to save 
the data and have it printed, or click Save followed by Cancel in order to save the 
current selection and print only at a later time.  
 
Client label setup 
The Setup tab is where you can select which clients you wish to include in the label 
print job, and which printer you wish to use for that purpose.  
 
You can print labels for the current client, the current family, marked clients, your own 
clients or all clients in the database.  
 
In the T1 program only, for purposes of the label print job, you also have the options 
to select family heads, spouses and/or dependants. This enables you to print one 
address label only for each family unit in your database simply by disabling spouses 
and dependants.  
 
Select the desired printer and tray then enter the Number of copies of each label you 
require, up to a maximum of 99.  
 
Text to print  
Under Client labels, the Text to print tab enables you to select what information you 
want printed on the label, and how it will be printed.  
 
The drop-down list titled Information to print on label offers many selections consisting 
of combinations of name, mailing address, phone numbers, etc.  
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The option All information consists of the entries made in the following keywords (T1):  
 

• LASTNAME 
• FIRSTNAME 
• STREET 
• CITY 
• PROVINCE 
• POSTCODE 
• BILLCODE 
• INVOICE-NUM 
• CLIENT-CODE 
• PHONE 
• PHONE-OFFICE 
• FAX 
• FAX-OFFICE 
• EMAIL 
• SIN 
• BIRTHDATE 

 
The other options allow you to easily change the layout (text centred or not), the font 
type (Arial or Times New Roman) and the font size (8, 10 or 12 point) with respect to 
the text to be printed on the labels.  
 
The Preview window lets you see a sample of your label prior to printing.  
 
If your label information is overflowing the edges, try one or several of the following:  
 

• Centre the text 
• Select the Times New Roman font instead of Arial 
• Select an 8 point font instead of a 10 or 12 point 
• Change the label size settings in the label definition tab 
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Customized labels 
To print customized labels, you must first select and define your label print job 
according to the three following steps:  
 

• setup 
• text to print 
• label definition 
 

Once you have entered the required information, you may click Print in order to save 
the data and have it printed, or click Save followed by Cancel in order to save the 
current selection and print only at a later time.  
 
Customized label setup  
The Setup tab is where you can select the printer and the tray you wish to use.  
 
You may specify the Number of copies of each label, with 9999 being the maximum.  
 
To avoid waste, you can also choose to Fill the sheet, in which case the program will 
automatically add just enough labels to fill up the last sheet printed.  

 

Text to print 
Under Customizable labels, the Text to print tab enables you to select what 
information you want printed on the label, and how it will be printed.  
 
The drop-down list titled Information to print on label offers many selections consisting 
of combinations of tax preparer's addresses, name of contact, and business card, and 
provides up to 12 fully customizable labels.  
 
If you select from the drop-down menu a previously customized label to which you 
want to make changes, click the Edit button to enter the text you require.  
 
The other options allow you to easily change the layout (text centred or not), the font 
type (Arial or Times New Roman), and the font size (8, 10 or 12 point) with respect to 
the text to be printed on the labels.  
 
The Preview window lets you see a sample of your label prior to printing.  
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If your label information is overflowing the edges, try one or several of the following:  
 

• Centre the text 
• Select the Times New Roman font instead of Arial 
• Select an 8 point font instead of a 10 or 12 point 
• Change the label size settings in the label definition tab 
 

Editing a customized label  
In the Edit option of the Text to print tab, use the Name of label field to identify the 
label for future reference. The name of the label will then appear in the drop-down list 
titled Information to print on label, found in the same tab. In the Text of label field, 
type in (or paste from another source) the text you want to appear on the label.  
 
Remember that the amount of text that a label can contain depends on the size of the 
label and the font you have chosen. The Preview window located in the Text to print 
tab allows you to see your customized label and make the necessary changes, if any. 
 
Helpful ideas for label printing  
It is important to be able to print client labels efficiently, but many other options for 
label printing are available as well.  By selecting the proper type of label for the job 
and, where applicable, entering the information you want printed on it, you can obtain 
such customized items as:  
 

• file folder labels indicating a client's LASTNAME, FIRSTNAME, and CLIENT-CODE 
• rotary cards listing all relevant client information 
• return address labels with the tax preparer's mailing address 
• business cards  
• shipping addresses labels  
• diskette labels (3.5)  
 

Enable printing of date on each page of tax return  
This feature enables the printing of the date in the header of each page of the tax 
return, where the mandatory client number, name and social insurance number are 
also shown. See, for example, page 4 of the T1 jacket where the date displayed is not 
the date the return was printed, but rather the date the return was calculated or the 
date entered in the keyword SIGN-DATE.  
 
To enable printing of the date on each page of the tax return, select Printing options 
from the Preferences menu and tick the appropriate box. Untick the box to disable this 
feature.  
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• Under Windows XP, click Start and select Printers and Faxes; 

Troubleshooting printing in DT Max  
 

When experiencing printing problems, always consider the following:  
 

1. Make sure that you are using the most recent driver available for your printer. 
Driver upgrades may solve specific printer errors, and they include features that 
are designed to enable optimal performance with the newer applications. The 
newest drivers are available on the manufacturers Web sites.  

 
2. Many printer properties can be adjusted to improve the speed and efficiency of 

print jobs. To access your printer properties,  
 

• Click Start; 
• Select Settings; 
• Select Printers; 

• Right-click the appropriate printer;  
• Select Properties.  

 
The next step depends on the specific problem you are experiencing. Below is a 
summary of various printing problems that you may encounter, followed by 
troubleshooting tips.  

 
The printer reports an error and then stops printing/problems occur 
when attempting to print large jobs In your printing preferences, if the 
Transmission Retry option is available, increase its value in the Timeout settings 
frame. 
 
Printing may be slow if print spooling is not enabled In the Advanced tab, 
select the options Spool print documents so program finishes printing faster and 
Start printing after last page is spooled. 
 
Printing may be slow due to the spooling format In the Advanced tab, click 
Print Processor. Then, in the Default Data Type drop-down list, select the 
alternate spooling format. The spooling formats available are EMF and RAW. 
EMF can free up your program faster but it requires more memory resources 
from your system. Therefore, if you are experiencing problems with it, just 
switch to RAW format.  
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Printing may be slow if the resolution setting is too high In the General 
tab, click Printing Preferences and decrease the DPI (dots per inch) setting 
selected. For instance, if you are currently using a resolution of 600 DPI or 
higher, try lowering the setting to 300 DPI or even 150 DPI.  

 
Printing may be slow if the soft fonts are not enabled In your Printer 
Preferences, select Send TrueType as Bitmaps. 

 
Printing may be irregular (e.g. no shading) or slow if using an invalid 
driver or an erroneous printer language Use a PCL language driver if 
available rather than the PostScript driver.  

 
Printing may be slow when too many applications are active Close any 
applications that you do not need to keep opened.  

 
Printing may be slow if hard disk space is too low or your TEMP 
directory is not configured properly Print jobs must be spooled to the hard 
drive before being sent to the printer. Limited hard disk space (less than 200 
megs) may reduce the processing speed of those jobs. Make sure that the TEMP 
directory in your Windows environment is referenced to a drive with sufficient 
disk space.  

 
Printing may be slow if memory resources are insufficient Keep in mind 
that if your printer evolves in a minimal environment, it will deliver a minimal 
performance. Because limited memory slows down the printing process, don't 
hesitate to install additional memory into your computer and/or printer if 
possible. The more RAM you can install on your printer, the better it will 
perform.  

 
Print jobs are performed in pieces, on separate pages The capture timeout 
setting may be too low. If there is a pause in the flow of data between the 
application and the port, and it is long enough for the timeout to end the print 
job, the next data that comes will be sent to the queue as if it were a new print 
job. The new job will be printed on a new page because a form feed is 
prompted. Misinterpreted control characters in a job may also prompt a form 
feed in the middle of the printing process. Sometimes, this problem can be 
corrected by sending the job as byte stream.  
 
There is also the possibility that the printer may not have sufficient memory to 
hold the entire page to be printed. In that case, it will print the part of the page 
it does have in memory and continue printing on the next page. This problem 
often occurs when printing large graphics jobs.  
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SELECTED FAQ ABOUT PRINTING 

 
¾ How can I reprint a tax return for production purposes? Click the Status 

information icon and remove the check mark appearing next to Printed.  
 

Alternatively, you can delete the keyword PROGRESS in the data entry screen. 
 

Either way, be sure to recalculate the client using [Alt+F9] in order to implement 
the change.  

  
 

Please refer to the DT Max knowledge base for more information.  
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T1 TRAINING GUIDES  
 
Preparing a personal tax return  

 
To prepare a personal tax return, you must use DT Max's keyword system in order to 
complete data entry. Some of the data are of personal nature and designated as 
"permanent data". Other data are fiscal in nature and more closely related to the 
contents and purpose of a tax return.  

When adding a new client, tick any relevant options from the SmartStart client outline 
screen and click Continue. A series of keywords will appear from the section Personal 
information, followed by the other sections you have ticked from the SmartStart client 
outline screen.  

The keywords listed below represent the permanent data and comprise components 
that are common to all tax returns.  
 

• LASTNAME 
• FIRSTNAME 
• RELATION 

 
 Use this keyword to indicate the nature of the relation to the family head, who is 

the cornerstone of the entire family unit.  
 
 In a typical family unit, there will be a family head, a spouse and any number of 

children or other dependants. A separate file must be created for each family 
member. Each child is linked to the family head or to the other financial support 
(spouse or common-law spouse). Since DT Max optimizes the dependant 
amounts, the specific spouse to whom a child is linked bears very little 
importance. In the case of an extended family, it is recommended to link a child 
to his/her biological parent.  

 
• SIN 
• BIRTHDATE 
• STATUS 

 
This keyword should indicate the civil status of the taxpayer as of December 31  
of the tax year. For example, if the taxpayer got married during the year, the  
option Married should be selected under that keyword.  
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• SEX 
• PROV-RES 

 
This keyword indicates the province of residence of the taxpayer as of December 
31 of the tax year. It should not be mistaken for the keyword PROVINCE, which 
is used to indicate the province of the taxpayer's postal address.  

 
• LANGUAGE 

 
 This keyword allows you to specify the language in which a production return 

should be printed. This does not prevent you from working on a return and 
viewing it in the language of your choice.  

 
• STREET 
• CITY 
• PROVINCE 
• POSTCODE 
• PHONE 
• ALONE 

 
 This keyword must be used in the file of a taxpayer who does not have a 

spouse. If omitted, DT Max will generate an error message.  
 

The other keywords required for preparing a T1/TP1 return are designed to process 
tax information.  
 

• The keyword T4 enables you to enter information from federal T4 and Quebec 
RL-1 slips.  

 
• The keyword T-SLIP includes the various types of information slips provided to 

taxpayers by the governments.  
  
• When amounts are relevant to both the federal and provincial jurisdictions,     

DT Max assumes that the provincial amounts are identical to the federal 
amounts. If this is not the case, the function key [Alt+J] allows you to enter a 
different amount, if necessary.  
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• Among the most common items to consider with respect to personal tax returns 
are the RRSP contributions and deductions.  

 
The keyword group RRSP enables you to indicate the contributions paid to an 
RRSP. When you enter the keyword RRSP:  

 
1. Choose the taxpayer's Own plan or the Spousal plan.  
 
2. Use the keyword RRSP-CONTRIB to enter the amounts of RRSP 

contributions.  
 
3. Use the keyword UNDEDPREMIUM to indicate the amount of undeducted 

premiums for past contributions.  
 
4. Open a second RRSP group in which you will select the option Room & 

limit to indicate the amount of RRSP contributions the taxpayer can pay.  
 
 This includes the amount of eligible contributions for the current year 

(calculated according to the income earned for the previous year) and the 
eligible amounts from previous years that were not contributed (sums 
which could have been paid to a RRSP but were not), designated as the 
eligible amount of RRSP contributions. Enter that amount for a new client 
only or to modify the carryforward from the previous year as calculated by 
DT Max. This amount should be identical to what the CRA determined. 

 
5. If you wish, you may use the keyword LIMIT-RRSP to limit the amount of 

RRSP contributions for the year.  
 

• The keyword INCOME-HIST is the taxpayer's income history for a given past 
year. For all new clients, you must enter the history manually. DT Max will 
automatically generate a history for the following years. This is particularly 
important for clients who pay instalments.  

 
• The keyword MEDICAL enables you to enter the medical expenses you want to 

claim for the year. The optimization made by DT Max will allocate these 
expenses among the family members. The refundable credit for medical 
expenses will be claimed if a taxpayer is eligible.  

 
• The keyword DONATIONS is used to enter the various types of charitable 

donations made in the course of the year, whereas the keyword AMOUNT-CF is 
used to carry forward the amount of donations not claimed in past years.  
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DT Max will optimize pursuant to the taxable and payable income of each spouse.  
 
• The keyword DRUG-INSUR should always appear in the file of a taxpayer who is 

filing a Quebec tax return. If omitted, DT Max will generate an error message.  
 
• The child care expenses should be entered in the file of the child for whom they 

were incurred with the keyword CHILDCARE. When processing the data for the 
family, DT Max will give the tax credits to the relevant financial supporter.  

 
 Due to certain exceptions prescribed by law, the keyword CHILD-WEEKS can be 

used in the file of the taxpayer to whom you specifically wish to allocate child 
care expenses (usually the individual with the higher income).  

 
• Use the keyword BUSINESS to select the category of activities pertaining to the 

financial data you need to enter for different types of income, such as 
 

1. business (e.g. self-employment) 
2. rental 
3. commission 
4. farming  
5. fishing 
6. professional 

 
Once data entry for the family head is completed, you can create a new file for 
another member of the family, if any, either by clicking the Add new client icon or by 
pressing [F3], or by selecting New client in the File menu.  
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Preparing the return of a newly separated or divorced taxpayer  
 

If your client separated or divorced during the last tax year, his/her new civil status 
must be taken into account when preparing the next tax return.  
 
Inactivating a spouse 
In the year of separation, one of the spouses must be inactivated. The spouse whose 
file is inactivated cannot be the family head as this would prevent tax calculations for 
the entire family. If the family head is inactivated, you must access the spouse's file 
and change their RELATION entry to Family head. This will swap the family head and 
spouse in this family.  
 
To make the spouse inactive, use the keyword INACTIVE in this person's file and make 
sure that the option Separated is selected.  
 
If you wish to prepare the return of the inactive spouse, point to their file in the client 
list, select the option Clone family members from the Tools menu, and in the dialogue 
box that appears, verify that the options Current individual only and Add to a new 
family are selected. Then check the option Make cloned family member inactive in 
original family. Click OK and DT Max will create a new family with the clone as the 
family head.  
 
Changing the civil status 
In the client's file, use the keyword STATUS and make the necessary change. Enter 
the information pertaining to the change of civil status using the keyword 
STATUSCHANGE in the file of each ex-spouse, and selecting the appropriate option.  
 
Other permanent data 
Use the keyword ALONE in the file of an ex-spouse who now lives alone, further to the 
breakup. Note that in the year of the breakup, the amount for person living alone 
cannot be claimed because the divorced or separated taxpayer had a spouse during 
part of that year. Enter the full address of the new family head with the keyword 
STREET. If this is a change of address, indicate it by selecting Yes in the keyword 
ADDRESS-NEW.  
 
Data pertaining to the ex-spouses 
Use the keyword RELATEDPARTY in the file of each ex-spouse and select the 
appropriate option from the choices available. Next, enter the data pertaining to the 
ex-spouse:  

 
• The birth date and the SIN, which are required in the year of the breakup 

(especially for efile purposes).  
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• The net income prior to the breakup, with the keyword NI-BEFCHANGE. If you 

are unable to establish this amount precisely, provide the best estimate 
possible. This information will be used among other things for the calculation of 
the spousal amount. 

 
• The amount of alimony paid or received, with the keyword ALIMONY-PAID or 

ALIMONY-REC.  
 

• Using the keyword INTERVENTION, indicate whether the ministre du Revenu du 
Québec automatically collects alimony from the taxpayer and pays the recipient.  

 
• Indicate whether the spouse transferred amounts from schedule 2 with the 

keyword SPOUSE-TRANSFER. 
 
 
If there are children ...  
Create new files for the children, now linked to the new family head, so that this 
person may claim credits available as a result of the breakup. To do so, use the 
cloning feature. There will be a duplication of the children's files. The following year, 
don't forget to inactivate the children's files that are linked to the parent who no 
longer supports them. Use the keyword TRANSFER-OV in the children's files in order to 
control the optimization made by DT Max with respect to certain deductions pertaining 
to the children.  
 
Optimization  
The keyword OPTIMIZE will allow you to control the optimization made by DT Max with 
respect to a variety of credits and transfers between the ex-spouses. You will be able 
to share certain amounts between the two individuals. 
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Preparing the return of a deceased taxpayer  
 

If your client was deceased during the last tax year, his/her new civil status must be 
taken into account when preparing the next tax return.  

 

Changing the civil status 
Enter the information pertaining to the change in civil status with the keyword 
STATUSCHANGE, in the file of the deceased taxpayer. Then enter the date of death, 
which will be printed on the first page of each return filed. You do not have to change 
the client's civil status at the date of death.  
 
Address 
In the client's file, enter the address of the estate's administrator to replace that of the 
deceased taxpayer. If, however, you would rather use the address of your firm, you do 
not have to modify the address of the deceased. Instead, simply use the keyword 
MAIL-ADDRESS. DT Max will automatically enter the words Estate of before the name 
of the deceased taxpayer, on the first page of the return.  

 
If there is a surviving spouse  
Use the keyword STATUS to modify the civil status of the surviving spouse. Select 
Widow or any other status, as relevant. Enter the information pertaining to the change 
in civil status with the keyword STATUSCHANGE, where you will indicate the new civil 
status as well as the date of the spouse's death. Use the keyword STREET to enter the 
current address of the surviving spouse, if it has changed.  
 
If there is a dependant  
For Quebec tax purposes, DT Max will allocate the dependant amounts in consideration 
of the spouses' respective income. Use the keyword TRANSFER-OV in the dependant's 
file to modify the optimization.  
 
Filing the final return and optional returns 
The keyword RETURN-TYPE is available in the STATUSCHANGE group to select the 
type of return to be filed.  
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Once the relevant type of return is selected, DT Max will specify the corresponding tax 
provision in the top right-hand corner of the first page of the return:  

 
                                        Federal   Quebec 
 
Final return                                      blank      blank 
Return for income from rights or things          70(2)      429 
Return for income of a partner or proprietor     150(4)     681 
Return for income from a testamentary trust      104(23)d) 1003 

 
Enter the final return information in the client's production file, and create a plan in   
DT Max for each optional return you may wish to file. 
 
The year following death 
Separate the spouses in the database only in the year following the death. To do so, 
use the keyword INACTIVE in the file of the deceased taxpayer, and make sure that 
the option Deceased is selected.  
 
Keep in mind that an inactive family head prevents tax calculations for the entire 
family. To process a family in the year after the death of the family head, access the 
spouse's file and change the RELATION entry to Family head. This will swap the former 
family head and spouse in the family.  
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Preparing a bankruptcy return  
 

If your version of the DT Max program includes the bankruptcy module, you will be 
able to prepare tax returns for bankrupt taxpayers. This tool will make your work 
easier namely by adjusting the calculation of credits and carrying the pre-bankruptcy 
data forward to the post-bankruptcy period, and by managing the more specific 
aspects of the production of such returns. 
 
Types of bankruptcy returns 
In the year of bankruptcy, three types of bankruptcy returns may be filed: 

 
� the pre-bankruptcy return, which comprises all the relevant tax information until 

the date of bankruptcy;  
 
� the post-bankruptcy return, which includes all relevant tax information from the 

date of bankruptcy until the end of the year; 
 
� the trustee's return, used for non incorporated businesses that are pursuing 

their activities at the date of bankruptcy under the supervision and control of a 
trustee in bankruptcy.  

 
Usually, a trustee in bankruptcy is assigned the task of having the bankruptcy returns 
prepared. They remain his responsibility whether he does the work himself or hires 
another accountant or tax preparer to do it. However, the bankrupt taxpayer is often 
required to file the post-bankruptcy return.  
 
The pre-bankruptcy return 
To prepare a pre-bankruptcy return, use the regular tax file for the bankrupt taxpayer.  
 

1. Enter the keyword BANKRUPTCY and choose the option Pre-bankruptcy return 
among the choices available.  

 

2. Use the keyword BANKRUPTDATE to enter the date of the bankruptcy and 
indicate whether you want that date printed in the top section of page 1 of the 
federal return.  

 
 Note: Although many tax preparers prefer to have the bankruptcy date printed  
 in that particular location, the CRA objects to this practice. Therefore, DT Max  
 enables you to override this selection.  
 



T1 training guides           DT MAX USER’S MANUAL 

                                                                     134   

3. Use the keyword ESTIMATES to enter relevant estimates regarding the taxpayer 
or his spouse. These estimates are required for the calculation of repayments of 
certain social programs benefits, the child tax benefit, etc.  

 
4. Enter the data for the pre-bankruptcy tax return, namely the income, losses, 

and deductions until the date of the bankruptcy. 
 
DT Max will calculate the pre-bankruptcy return as well as the amounts to be carried 
forward from it to the post-bankruptcy return.  
 
The post-bankruptcy return 
To prepare a post-bankruptcy return, use a DT Max plan. (Note that the option Keep 
blank will be selected for the purposes of the plan). 
 

1. In the client's file, display the automatic carryforwards for the post-bankruptcy 
on the right-hand side.  

 

2. Carryforwards from the pre-bankruptcy return will appear on the right-hand side 
within the BANKRUPTCY group. More specifically, you will be able to see the 
carryforward data with the keyword PREBANK-INFO. These are amounts from 
the pre-bankruptcy return, which will be necessary for purposes of the 
calculation of certain credits or deductions of the post-bankruptcy return.  

 
3. Regular carryforwards (UCC, capital cost, etc.) may also be copied from the 

right-hand side of the screen.  
 

4. After verifying the carryforwards, mark the data [F5] and copy it to the post-
bankruptcy return [Alt+C].  

 
5. Enter the data relevant to the post-bankruptcy return (income, losses, 

deductions from the date of bankruptcy up to the end of the year), which were 
not included in the trustee's return.  

 
The post-bankruptcy return is filed by the bankrupt taxpayer, and generally, the 
resulting tax refund is issued and mailed to him.  
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As an administrative policy, when the bankrupt taxpayer is not released from the 
bankruptcy or was released prior to completion of the assessment of the post-
bankruptcy return, the CRA will eventually send to the trustee the tax refund resulting 
from that return, to the extent that the trustee was careful to include with the return 
the "Authorization and direction letter" signed by the bankrupt taxpayer.  DT Max can 
generate this letter for trustees in bankruptcy. The "Bankrupt taxpayer identification 
form" is also generated whenever a bankruptcy return is calculated. 
 
The trustee's return 
To prepare the trustee's return, use a DT Max plan.  
 

1. Enter the keyword BANKRUPTCY and choose the option Trustee's return.  
 

2. Report the income or losses pertaining to the property and business of the 
bankrupt taxpayer during the bankruptcy.  

 
3. DT Max will calculate the return by canceling the basic personal credits (basic 

amount, age amount, disability amount, etc).  
 

4. No amount is automatically carried forward from a trustee's return. The 
amounts to carry forward from that return must be entered manually.  

 
The trustee's return is filed by the trustee himself. The trustee may not claim personal 
tax credits or deductions when calculating the taxable income, with the exception of 
the deductions for the losses incurred in previous years. This return must be filed by 
the end of the month of March of the following year.  
 
Non refundable tax credits 
The total non refundable tax credits claimed by a bankrupt taxpayer in the year for 
both the pre-bankruptcy and post-bankruptcy periods cannot exceed the amount that 
could be claimed as per the calendar year (ITA s.118.95). Personal tax credits such as 
the age and the disability amounts as well as the transfers of unused credits are 
prorated by the number of days in the period for which the return is produced. The 
pension income amount, the credit for charitable donations, the credit for medical 
expenses, and the tuition fees and education amounts will be based on the respective 
amounts pertaining to each period.  
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If there is a spouse and/or a dependant... 
When preparing the pre-bankruptcy return of the bankrupt taxpayer, enter the net 
income only for the spouse, for the entire year. If the calendar year is not yet over at 
the time of the filing of the return, this amount may be an estimate if need be. An 
adjustment may be made to the return at a later date.  
 
If the spouse is not bankrupt, his/her return must be calculated with the post-
bankruptcy return of the bankrupt taxpayer. Ensure that all information pertaining to 
the spouse is entered in the appropriate tax plan corresponding to the taxpayer's post-
bankruptcy return. Enter the spouse's data for the entire year.  
 
If the spouse is bankrupt as well, do not use the keyword BANKRUPTCY for both 
spouses. For the time being, DT Max does not allow for the processing of two bankrupt 
spouses within the same family unit. Instead, in order to fill out the bankruptcy return 
of the spouse, follow the steps below:  
 

1. In the client database, generate an extract.  
2. Renumber each family member.  
3. Merge the family.  
 

You will obtain a second, identical family. This time, enter the keyword BANKRUPTCY 
in the spouse's file in order to complete his/her bankruptcy return. These instructions 
also apply to the case of a bankrupt dependant.  
 
Production requirements 
The type of bankruptcy return and the trustee's number appear in the top portion of 
the first page of the tax return.  

 
The federal returns are addressed to the trustee. The option Identification in the 
Preferences menu allows you to enter the trustee's address as the alternate address of 
the tax preparer. If you must enter a different trustee number for a particular client, 
use the keyword TRUSTEE-NUM. Returns of bankrupt taxpayers cannot be efiled. 
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Preparing CAIS returns  
 

I - CAIS identification and participant profile information (keyword CAIS) 
 

1. By default, DT Max designates the tax professional as the contact person. If this 
is not the case, enter the contact's name and address with the keyword 
CONTACT-NAME.  

 
2. If the contact has changed since last year, indicate it with NEW-CONTACT.  

 
3. Specify whether you are applying for an account, maintaining an account, or 

closing an account with the keyword CAIS-ACCT. 
  

4. Specify other relevant information for the participant with the keyword 
PARTICIPANT.  

 
5. Enter the province of main farmstead with the keyword FARMSTEAD if it differs 

from the province of residence.  
 

6. Enter the first year of farming operations with the keyword FARM-OPENING.  
 

7. Enter the total cultivated area with the keyword FARM-AREA.  
 

II - Farming income & expenses 
 

1. Enter the data for each farming operation with the keyword BUSINESS and the 
option CAIS - farming (cash basis) or CAIS - farming (accrual basis).  

 
2. Enter farming income and expenses derived from commodities with the keyword 

COMMODITY, by selecting the CAIS code number of the commodity.  
 

3. Enter the related data pertaining to each commodity with the following: 
 

          commodity sales              SALES         
    commodity purchases       PURCHASES 

 



T1 training guides           DT MAX USER’S MANUAL 

                                                                     138   

4. Each COMMODITY entered heads a separate sub-group in the BUSINESS group. 
All of the data pertaining to a commodity is kept together in the COMMODITY 
sub-group. You may have multiple entries for SALES and PURCHASES, but only 
one entry is allowed for each COMMODITY.  
 
All commodities entered will be listed on the CAIS statement, without limitation. 
DT Max automatically determines whether the commodity is qualifying or non 
qualifying based on the province of residence or province of main farmstead.  
 

5. Program payments are entered with the keyword PROGRAM-PYMT by indicating 
the CAIS code number of the program.  

 
6. Repayments of program benefits should be entered as a negative amount with 

the keyword PROGRAM-PYMT.  
 

7. Enter other farming income with the keyword OTH-FARMINC. Such amounts will 
be recorded on the CAIS statement as Other farming income. 

 
8. Farming expenses are classified as eligible expenses and non eligible expenses 

on the CAIS statement. Enter the eligible expenses for CAIS purposes using the 
keyword FARM-EXPENSE, and the non eligible expenses for CAIS purposes using 
the keyword OTH-FARM-EXP. These expenses will be recorded on the 
appropriate section of the CAIS statement.  

 
III - Other account information 
Partnership information is obtained from the data provided with BUS-PARTNER. 
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Changing a fiscal year-end  
 

Converting to a December 31 year-end 
 

1. Enter the business information for the first qualifying fiscal period.  
 
2. With FISC-PERIOD, indicate Dec. 31 year-end method - first fiscal period.  
 
3. Calculate the return with [Alt+F9], and return to keyword data with [F2].  
 
4. On the Right-hand side display drop-down menu, select C/F to stub period / 

post-bankruptcy.  
 
5. Verify the right-hand side data.  

 
6. Mark the data on the right-hand side with [F5]. Then, from the right-button 

menu of your mouse, select Copy to left-hand side.  
 
7. You are now ready to enter the data for the second fiscal period. The 

keyword FISC-PERIOD will indicate Dec. 31 year-end method - second fiscal 
period, and YEAR-END.BUS will indicate 31-12-XX (where "XX" represents 
the relevant year). The business name, address, GST/PST number, and 
opening balances will also be indicated.  

 
8. DT Max will show the new UCC-OPEN in the CCA-CLASS group.  
 
9. DT Max will adjust the net income from the second fiscal period for CCA and 

farming OIA (optional inventory adjustment) to obtain the income eligible for 
the reserve known as December 31 income.  

 
10. The amounts entered under ADDIT-INCOME and BUS-RESERVE in the first 

period must be copied manually into the second period, and then deleted 
from the first.  

 
11. DT Max will claim the maximum eligible business reserve of the December 31 

income. You may limit the reserve claimed with the keyword BUS-RESERVE.  
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Electing the alternative method 
 

1. Enter the data for the business in the BUSINESS group in the usual manner.  
 
2. Do not change the YEAR-END.BUS to December 31.  
 
3. With the keyword FISC-PERIOD, indicate Alternative method.  
 
4. You only have one business statement for this business.  
 
5. DT Max calculates the estimated additional income per the stub period:  
 

number of days during which the activity was carried out 
between the end date of your fiscal period and January 1, 20XX 
----------------------------------------------------------------------- 
number of days in the fiscal period ending in 20XX 
          

6. You may override the additional income amount with the keyword ADDIT-
INCOME.  
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SELECTED FAQ’S ABOUT T1 TAX TOPICS 

 
¾ How does DT Max calculate the federal deduction and Quebec tax credit for 

child care expenses paid? Information about child care expenses paid for a child 
is entered in the file of the child using the keyword CHILDCARE. Once calculated, 
DT Max will allocate the child care expenses to the parent eligible to make the 
claim and report a child care expense deduction on the federal return and a 
refundable tax credit on the Quebec return. Generally, to obtain a deduction for 
child care expenses, both parents must have earned income (as opposed to 
investment income) and the child must be under 17 years of age unless 
handicapped. If the higher earner is eligible to make the claim, enter the keyword 
CHILD-WEEKS and indicate the relevant condition and the number of weeks 
applicable.  

 
¾ Where can I report foreign employment income with DT Max? If the T4 

reports income earned outside of Canada, or for Quebec residents, if an RL-17 is 
attached to an RL-1, enter the amount of employment income showing on the T4 
slip (or RL-1) in the T4 group, and the portion attributable to foreign income (box B 
of RL-17) in the keyword T4-INCOME.FI of the FOREIGN-INC group. 

 
 The amount entered in the T4 group will be reported on line 101 of the federal and 

Quebec income tax returns. The amount entered in the FOREIGN-INC group will not 
be reported as income on the tax return as it is already included in the amount 
entered in T4. However, that amount will be used in the calculation of the overseas 
employment tax credit or the foreign tax credit. 
 
If the taxpayer worked for a foreign employer or a Canadian employer who was not 
paying the wages from its office in Canada, there will not be a T4 slip nor will the 
income be subject to CPP/QPP contributions. Enter this amount with the keyword 
INCOME.FI in the FOREIGN-INC group. The income will be reported on line 104 of 
the federal income tax return and on line 101 of the Quebec income tax return.  
 
If an RL-17 was sent, the amount showing in box A (total deduction) must be 
entered in the keyword OVERSEASDEDQ in the group FOREIGN-INC. The amount 
will then be reported on line 297 of the Quebec return.  

 
Please note that Quebec does not offer a foreign employment tax credit matching 
the federal. A deduction is granted only if an RL-17 was issued. Boxes C to G of RL-
17 should be ignored but boxes H and I must be entered in the keywords QUAL-
DATE-1 and QUAL-DATE-2 if the federal overseas employment tax credit is claimed.  
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¾ How can I create and edit a new client letter in DT Max? 
1. First, block and copy the template below.  
2. In DT Max, select Client letter from the Preferences menu.  
3. In the tab Edit template, select Open. This will bring you into the client letter. If 

this does not work, select Create new template and click Yes until you do get 
into the client letter.  

4. Go to the end of the client letter information and paste the template.  
5. Make sure that you enter the text of your additional letter at the end.  
6. Keep in mind that the comments inserted after %* comment:  will not appear in 

the letter. They are only there for information purposes.  
 

Client letter template: 
 
%* comment: To start a new page 
%NP 
%* comment: Print the preparer's address per the user's defaults. 
%IF(%255 = 1) 
                                       %254 %NL 
                                       %253 %NL 
                                       %252, %251 %NL 
                                       %250 %NL 
%ELSE 
%* comment: If not using preparer's address, allow space for letterhead. 
%ENDIF 
%* comment: 1   title, first name, last name, care of, address 
%3 %2 %1 %NL 
%IF (%116!=0) 
c/o %116 %NL 
%ENDIF 
%4 %NL 
%5, %6 %NL 
%7 %NL 
Dear %2 %1, %NL 
%* comment: Consult the document about customizing the client letter for 
instructions 
%* comment: or for the list of client letter variables. 
%* comment: Enter your text below 
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¾ How does DT Max restrict expenses for commissioned sales people? Some 
employment expenses relating to commission income must be limited to the 
amount of commission income earned in the year. These expenses are commonly 
referred to as Restricted expenses. Expenses are not limited to the commission 
income are commonly referred to as Unrestricted expenses and include such 
expenses as office rent, office supplies, etc. More details on how DT Max restricts 
expenses for commissioned sales people are found in the detailed keyword help for 
the keyword EXPENSES. Enter this keyword and press [Ctrl+F8].  

 
¾ Why does DT Max restrict employment expenses to commission income 

earned from employment? DT Max will restrict the expenses based on the 
expense option chosen with the keyword EXPENSES. If no commission income is 
earned from employment, the restriction does not apply. If the expenses are to be 
restricted (when commission income is earned through employment), DT Max will 
restrict the expenses entered with OTH-EXP-RES. The expenses entered with OTH-
EXPENSES will not be restricted. 

 
¾ I wish to make an election pursuant to ITA section 216 regarding rental 

income earned in Canada by a non-resident. How should I proceed? Once 
the tax pursuant to ITA Part XIII has been withheld on gross rental income (25%), 
the non resident taxpayer may elect to file an income tax return in Canada, 
reporting rental income as if it were his only source of income.  
 
That election is advantageous when the tax calculated on net rental income on that 
taxpayer's return is lower than the tax withheld pursuant to Part XIII. Note that if 
that election is made, the non resident taxpayer will not be entitled to any 
deduction in the calculation of his taxable income nor to any tax credit.  
 

Enter the keyword NON-RESIDENT and choose the option Section 216 election to 
produce a section 216 return. DT Max will only take into account the entries that 
can be used on a section 216 return and will enter the information on the T1159.  
 

If the non resident taxpayer has made a commitment to the Ministère to file an 
income tax return in the six months following the end of the fiscal year (NR6), the 
tax withheld may be 25% of net rental income rather than gross income. In such a 
case, the steps described above remain applicable.  
 

¾ Can I limit the amount of non capital losses carryforwards that I want to 
apply in the current year? Yes. You can limit the amount of non capital losses 
carried from previous years to be applied in the year by entering the proper 
amounts on line 252 of the federal income tax return and on line 289 of the Quebec 
income tax return, using the keyword LIMIT.NCC in the NONCAPLOSSCF group. 
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¾ How do I enter non capital losses carried forward from previous years? 
 Use the keyword NONCAPLOSSCF and choose from the following options: 

 
� Non capital losses 
� Restricted farm losses 
� Farming/fishing losses 
� Allowable business investment losses 

  
Note that the program automatically carries forward the information for a client 
whose data was processed in DT Max the previous year. 
 

¾ How do I comply with the CRA's request for additional non resident 
information? The CRA has two schedules specifically for non-residents: 

 
� Schedule A - Statement of world income  
� Schedule B - Allowable amount of non refundable tax credits 

 
 In DT Max, the keyword WORLD-INC allows for the entry of the data required on 

schedule A. On schedule B, if the percentage is 90% or greater, the non refundable 
tax credits are fully applicable. If the percentage is less than 90%, the non resident 
rules with regards to non refundable tax credits will apply. In the keyword NON-
RESIDENT, the options Section 216 election and Section 217 election are available. 
With these options, you may easily file a section 216 or section 217 election income 
tax return. For the purpose of a section 217 election, the amount of eligible income 
is required and the keyword ELIG-INCOME is available specifically to that end. In 
both cases, the section of the election will be printed on the top of the first page of 
the federal income tax return. Note that the tax preparer is responsible for fully 
understanding elections rules and applying them accordingly. These elections do 
not apply for Quebec tax purposes.  
  

¾ How do I enter amounts received under the SPRINT program? The amount 
of training benefits showing in box 28 of the T4A must be entered by selecting the 
appropriate option from the keyword OTHER-INC.T, in the T4A group. If an amount 
appears in box B of RL-20 as a training loan, enter it with the keyword SPRINT-
LOAN, in the T4A group. DT Max will report the amount of training benefits on line 
130 of the federal return. In Quebec, these benefits are not taxable but they 
appear in schedule C as other income. As for the training loan, that amount is only 
deductible for Quebec purposes, on line 250.  
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¾ Why is the amount entered in the keyword ALLOWANCE.C not deducted on 
form GST-370? This occurs when you use the keyword group EMPLOY-EXP and 
enter Yes in GST-REBATE. The allowance received for car expenses is not included 
in the column pertaining to ineligible expenses. Verify the motor vehicle expenses 
section. If corrections are necessary, use the keyword GST-EXP-OV with the option 
Motor vehicle expenses and, with the keyword NON-ELIG, enter the total ineligible 
portion for corresponding motor vehicle expenses.  

 
¾ When and how does DT Max calculate the OAS? The user's defaults show 

whether or not DT Max calculates the amount of old age security (OAS) pension of 
a recipient taxpayer. If you have opted for automatic calculation, you can always 
modify your choice in a client's file. When calculating the amount, DT Max will 
prorate the OAS pension for taxpayers turning 65 years of age in the year, for   
the final return of a deceased taxpayer (in the year of death), and for pre-
bankruptcy and post-bankruptcy returns. If the taxpayer did not receive the 
amount calculated by DT Max because he is a recent immigrant, or if the taxpayer 
is not eligible to receive the OAS pension, override the amount with the keyword 
OAP-OV and enter the reason in the client's file. This will be printed on the tax 
return but it is safer to also enclose a note to that effect with the return as the 
printed indication is easy to miss and your client's assessment could end up 
reflecting OAS income he never received.  
 

¾ How do I enter the 45% transfer to Quebec of the federal tax paid for a 
Quebec resident who worked outside Quebec?  If your client resided in Quebec 
on the 31st of December but no tax was deducted from his income for the province 
of Quebec, enter only the federal tax paid using FIT in the T4 group. Use the PROV-
EMPLOY keyword in this group to enter the province where the taxpayer resided 
while earning this income. DT Max will perform the 45% transfer to Quebec 
automatically. 

 
¾ How do I enter the eligible and cumulative RRSP amounts if my client is 

being processed with DT Max for the first time? Enter these amounts with the 
option Room & limit in the keyword RRSP. This information only has to be entered 
once. Afterwards, DT Max will automatically carry forward to the following year the 
undeducted amount. 

 
¾ How can I enter an amount paid as a quarterly instalment? The quarterly 

instalments paid during the year can be entered separately for the CRA and RQ by 
using two distinct options of the keyword INSTAL-PAID. The amount of the 
instalment paid for March or June of the following year can also be entered with the 
help of two distinct options for the CRA and RQ. 
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¾ How do I enter the address of a taxpayer if it differs from that of other 
family members? Use the keyword STREET in the file of the taxpayer whose 
address is different and provide all required information. If required data remains 
missing, DT Max will substitute the information of the family head. The information 
for this particular taxpayer may therefore be inaccurate. 

 
¾ How do I tell DT Max that the taxpayer got married in the course of the 

current year? Use the keyword STATUSCHANGE and select the option Marriage - 
single before marriage or Marriage - common-law before marriage, as relevant. 

 
¾ How do I share the amounts for dependants between spouses? In order to 

make the sharing of dependant amounts between spouses more flexible, a group of 
keywords beginning with the keyword TRANSFER-OV was created. Note that this 
keyword must be entered in the file of the dependant. This group of keywords 
allows you to do the following: 

 
� Share between spouses various amounts pertaining to dependants  
� Determine which of the children you wish to claim as eligible dependant 
� Determine which of the children you wish to claim first on schedule A  
� Determine which of the children you wish to designate for schedule P  
� Control the transfer of medical expenses  
� Control the claim of dependant amounts by supporting persons  

 
¾ If DT Max does not produce a form, can I create it myself? You may want to 

create a supporting schedule for a particular calculation and keep it in your own 
records, send it to your client, and/or submit it to the CRA. The keyword CUSTOM-
SCHED enables you to create a customized message, form, or schedule in DT Max. 
When entering this keyword, you must tell DT Max how you wish to process a 
particular total, result or calculation. Simply make the applicable selection from the 
options offered.  

  
¾ I have a capital loss that occurred in the current year and which I want to 

carry back to a prior year. Do I have to change the client's data in the file 
from that year? No. Use the keyword CARRY-BACK in the current year's file, and 
indicate the amount of the loss that you want to carry back. DT Max will generate 
the T1A form (TP-1012 in Quebec) for you to attach to the return. Do not modify a 
return from a prior year. The government will make the necessary adjustments.  
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¾ How can I prevent DT Max from transferring tuition fees to the spouse so 
that they can be carried forward to a subsequent year instead? In the group 
TUITION-EDU, use the keyword TRANSFEROV.T and select the option Carry forward 
to use next year in order to prevent the automatic transfer of tuition fees to the 
spouse and carry the deduction of such fees to a subsequent year. 

 
¾ Why is it necessary to specify post-secondary studies or studies other than 

post-secondary in the keyword SCHOOLMONTHS? A child over the age of 18 is 
considered a dependant if pursuing full-time studies. DT Max determines that the 
child is in fact a dependant of his/her parents if the number of months entered in 
SCHOOLMONTHS is 3 or more. This is relevant for the purpose of the amount for 
dependent children indicated on schedule A. In the keyword SCHOOLMONTHS, you 
must indicate whether the studies are post-secondary or other than post-
secondary. This will tell DT Max whether the amount must be claimed on line 18 of 
schedule A. If the number of months entered is less than 6, DT Max will claim 
$1,780 for post-secondary studies, whereas if the number of months entered is 6 
or higher, DT Max will claim $3,560. Note that you can use TRIMESTRE-OV to 
override the number of semesters as school (e.g. 1 = $1,780, 2 = $3,560). 
 

¾ Can I modify the person to whom DT Max has transferred the tuition fees 
of the dependant? In the group TUITION-EDU, use the keyword TRANSFEROV.T 
in the file of the dependant. DT Max will then ask you whether you want to transfer 
the tuition fees to the head of the family, to the other supporting person, or to the 
other parent not processed. DT Max also allows you to carry forward the 
dependant's tuition fees to be used the following year, thus overriding the transfer 
already made, if applicable.  

 
¾ How does DT Max calculate the disability deduction and transfer it to a 

parent or spouse? The keyword INFIRMITY in a client's data triggers the disability 
deduction for that client. If the dependant is infirm and the income is insufficient to 
take full advantage of the disability deduction, DT Max will transfer the unused 
amount to the supporting person. If the dependant is 18 years of age or older, and 
infirm but not disabled, enter INFIRMITY in the dependant's file and indicate Do not 
use disability deduction with the keyword DISABILITY. This will entitle the 
supporting person to a non refundable credit for Amounts for infirm dependants 
age 18 or older on line 306 of the federal return and will not trigger a disability 
deduction. 
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¾ How can I produce the form pertaining to the maintenance of a self-
contained domestic establishment if my client does not have an RL-4? 
DT Max will generate that form if you enter the keyword ALONE-CERT and specify 
the reason why RL-4 is not attached to the client's return. 
 

¾ How do I enter a provincial tax credit with DT Max? Use the keyword 
PROVCREDIT, then select the relevant jurisdiction. You will be provided with a list 
of keywords relating to the credits available for the chosen jurisdiction. Note that 
some provincial tax credits are not entered through the keyword PROVCREDIT.  

 
¾ How can I enter the refundable credits for line 462 of the Quebec return? 
 Use the keyword OTH-CREDITQ and select the relevant credit among the options 

available. Note however that certain refundable credits intended for line 462 are 
not entered through this particular keyword.  

 
¾ How do I claim the real estate tax credit? For Quebec residents who own their 

residence, use the keyword RESIDENCE. For tenants, use the keyword T-SLIP and 
select the option RL-4. For Ontario and Manitoba residents, use the keyword 
RESIDENCE. Only Ontario has credits available for students in residence. For 
purposes of Ontario tax, be sure to specify the status of Indians living on reserves 
in order to prevent DT Max from granting them provincial tax credits.  

 
¾ How should I proceed to share the schedule B credits with the spouse? 
  The following credits may be shared by using the keyword OPTIMIZE: 

 
� Person living alone / age / retirement income 
� Real estate tax credit 

 
 In the keyword CONTROL.OP, select the option Share with spouse - claim amount 

(self) and enter the amount you wish to claim on your client’s own schedule B.    
DT Max will automatically transfer the balance to the spouse. 

 
¾ My client did not get the GST credit. Verify the following: 

1. You may only make one GST claim per family. 
2. DT Max will automatically give the credit to the family head. If you want the 

spouse to claim the credit, in their file, use the keyword OPTIMIZE and the 
option T1 - Claim the GST/HST credit on this tax return, then select Claim under 
the keyword CONTROL. You may also use the keyword GSTDEPENDOV to enter 
the right number of dependants.  

3. The taxpayer claiming the GST credit must be 19 or older.  
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¾ Last year, my client was using the alternative method. This year, he wants 
to convert to a December 31 fiscal year-end. Is it necessary to keep the 
information pertaining to the reserve in the first BUSINESS group? If, this 
year, you choose to convert to a December 31 year-end, you must enter the 
amounts of the keywords BUS-RESERVE and ADDIT-INCOME from the first 
BUSINESS group (1st statement) into the second BUSINESS group (2nd 
statement), then remove these amounts from the first statement.  

 
¾ How should I proceed to enter a disposition of property with DT Max? 
 All dispositions resulting in a capital gain or loss must be entered in the CAPITAL-

GAIN group. If the property disposed of is capital property, the disposition must 
also be entered in the CCA-CLASS group of the appropriate category. The price of 
disposition should be entered with PROCEEDS.CC and the ACB should be entered 
with ACB-DISP.CCA. You must also specify whether the category is now empty as a 
result of the disposition, with LIQUIDATE. The disposition of capital property must 
therefore be entered in two distinct groups, CAPITAL-GAIN and CCA-CLASS, in 
cases where a capital gain is generated because those two keyword groups serve 
different purposes. Indeed, the amounts entered in the CAPITAL-GAIN group allow 
DT Max to calculate the capital gain or loss resulting from the disposition as well as 
the capital gain exemption, if need be. As for the amounts entered in the CCA-
CLASS group, they allow DT Max to calculate the recapture or terminal loss, if need 
be, and also help reduce the UCC balance. Please note that you may not claim a 
capital loss on the disposition of capital property.  
 

¾ How do I enter a Quebec class 12 when, federally, it's a different class? 
 Certain CCA classes are treated as one class federally but as a class 12 for Quebec 

tax purposes. This would include classes 10, 39, 40, 43 and 44. To specify that the 
class in question must be treated as a class 12 for Quebec purposes, DT Max has 
introduced the keyword CLASS12-QUE. You must specify whether you want the 
class treated as a class 12 for Quebec. The default will be No. 

 
¾ Can I apply the Part XVII CCA method with DT Max? This method is 

integrated into DT Max. The CCA class is entered with CCA-PARTXVII, the purchase 
date with PURCH-DATE, the description with DESCRIPT.CA, the date of disposition 
with DATE-DISP.CC, the business portion of capital cost with COST, and the rate of 
allowance with RATE. The total allowance claimed for prior years is entered with 
PRIOR-CCA and the current year claim will be added to PRIOR-CCA and carried 
forward.  

 
¾ What should I enter in BUSINESS-ID for rental properties? If you have 

multiple rental properties, ensure that a different business name is used for each 
one. If you cannot use actual business names enter, for example, Property 1, 
Property 2, etc. You can also enter each property's civic address as its business ID. 
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¾ How do I enter the capital cost adjustment of a depreciable asset? The half-
year rule applies in the year of acquisition and is attributable to net acquisitions 
made in the year. Adjustments made to the capital cost in the year of acquisition 
may be entered with the keyword ADJUST-CURR, in the CCA-CLASS group. GST 
and PST rebates received in the year of acquisition are examples of such 
adjustments and they are entered with the keyword ADJUST-CURR. The half-year 
rule will be applied on the cost of additions, net of adjustments acquired in the 
year, in excess of net proceeds of disposition (or capital cost if less) in that year. 
Adjustments made in a year subsequent to the year of acquisition are not subject 
to the half-year rule. You may enter these adjustments with the keyword ADJUST-
UCC. GST and PST rebates received in a year subsequent or ITC claimed in a prior 
year are examples of adjustments that you would enter with the keyword ADJUST-
UCC. These adjustments would not be subject to the half-year rule.  

 
¾ How does DT Max calculate the amount of contributions to the CPP or QPP? 

DT Max uses the method of calculation used by each government respectively 
(federal and Quebec). With the CRA, the deduction of CPP/QPP contributions from 
employment income is based on the amount of CPP/QPP that was actually deducted 
on the T4 and RL-1. If there is both employment income and self-employment 
earnings, and the amount of CPP/QPP was underdeducted on the T4 or RL-1, the 
CRA will use the amount that should have been deducted on the T4 or RL-1 in order 
to determine the amount payable on self-employment earnings and optional 
earnings (line 10 of schedule 8). RQ calculates the deduction of CPP/QPP 
contributions on line 370 of the Quebec return as follows: if there is only 
employment income, the deduction of contributions will be the amount of CPP/QPP 
that should have been deducted on the T4 and RL-1.  
 
If there is both employment income and self- employment earnings, and the 
amount of CPP/QPP was underdeducted on the T4 or RL-1, the contribution payable 
on self-employment earnings will be based on the QPP workchart. Since DT Max 
uses the method of calculation that is specific to each government for the deduction 
of CPP/QPP contributions, your clients should not receive any adjustment in that 
respect on their contribution notice. If you wish to change the method used, you 
may use the keyword QPP-METHOD.  

 
¾ My client is an Ontario resident who worked in Quebec. He received a T4 

and an RL-1 but when I open the T4 group, no option is offered for 
Quebec. Enter the amounts showing on your client's T4 slip in the usual fashion, 
by using the keyword T4. Then, enter the keyword PROV-EMPLOY and select 
Quebec. This will prompt the keyword PIT to appear. Enter the Quebec income tax 
deducted. Attach RL-1 to your federal return and the CRA will sort out the 
information together with RQ.  
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¾ My client is a Quebec resident who worked in Ontario. How does DT Max 
process this type of case? Enter all the amounts showing on your client's T4 in 
the usual fashion, that is by using the keyword T4. Then, enter the keyword PROV-
EMPLOY, and select Ontario. DT Max will automatically make the 45% tax transfer 
to Quebec. 

 
¾ How do I enter data for spouses and dependants? Each family member, 

including spouses and dependants, is given a separate "file" in the DT Max 
database, whether or not that person is required to file a tax return. To add a 
spouse or a dependant to a family, go to the Client list, place the cursor on Head of 
the family and press [F3]. Select Spouse or Dependant as relevant. Usually, the 
data for each family member is entered in that person's keyword data. As the tax 
returns for the entire family are calculated, relevant information is automatically 
communicated between family members. 
 

¾ How do I enter data from T-slips? Enter the keyword T-SLIP and select the 
relevant type of slip. Alternatively, you may enter the name of the desired slip (e.g. 
T5) and DT Max will take you to the relevant option of the T-SLIP group. 

 
¾ How can I keep track of the assets on hand? DT Max provides a group to help 

you keep track of both depreciable and non-depreciable assets on hand. The 
following information may be entered in that group:   

Keyword  
 
Data 
 

 
 
ASSET  cost amount and description of the asset 

DATE-ACQ.A  date of acquisition of the asset 

BUSINESSNAME  name of business to which the asset pertains 

BUS-PORTION  business portion of the asset 

CCA-CLASS  CCA class to which the asset pertains 

NUM-SHARES.A  number of shares acquired 

FACE-VALUE  face value of the bond 

DATE-MATUR.A  maturity date of the bond 

FMV-STARTRES  

 

fair market value on date Canadian residency started 

 

 

 

If you acquired a depreciable asset in the year and entered the capital cost as 
ADDITIONS in CCA-CLASS, DT Max will automatically carry forward each addition 
separately and record the cost, description, business name, and CCA class to which 
it pertains, as well as the business portion if less than 100%. 

 

                                                                                                                       151
 



T1 training guides           DT MAX USER’S MANUAL 

                                                                     152   

¾ How can I get the right calculations for automobile expenses on a prorata 
of business mileage to total mileage? The keyword KILOMETRES, in the 
subgroup VEHICLE-EXP from the BUSINESS group, provides you with a place to 
enter the total mileage as well as the mileage travelled for work. This is where    
DT Max proceeds to prorate these expenses. Although the CCA amount showing on 
the relevant line of the depreciation category is not prorated, the amount included 
in the total CCA claimed is prorated according to the mileage covered for business 
purposes. The CCA amount must remain at 100% in the CCA worksheet so as to 
calculate the exact amount of UCC at the end of the fiscal period. 

 
¾ How do I enter business data when my client is a partner with a share of 

the business? In the BUSINESS group, use the keyword BUS-PARTNER to enter 
information about the other partners including the percent share for each partner. 
DT Max will assume the balance to be the percent share of your client. Enter the 
full amounts of business income and expenses. However, use the keywords 
PARTNER-INC and PARTNER-EXP for income and expenses respectively that are 
100% attributable to your client. Amounts in the VEHICLE-EXP subgroup may also 
be attributed to either the business or partner. Moreover, CCA-TYPE, in the CCA-
CLASS subgroups within the BUSINESS group, allows you to specify whether this 
CCA is at the business level or at the partner level. To copy business information 
between partners: 
 
1. On the right-hand side of the screen, display the keyword data for the partner 

that you want to copy from by selecting the option Other client in the drop-down 
menu titled Right-hand side display and entering the client number of the 
partner.  

 
2. Mark the data that you want to copy using the [Ctrl] key with a left click for a 

single keyword or [F5] for a block of selected keywords.  
 

3. From the mouse's right-button menu, select Copy to left-hand side.  
 

At this stage, don't forget to edit the partner information.  
 
¾ My client has rental property. He is a 50% co-owner with his spouse, and 

he occupies 50% of the premises. How do I claim CCA on his share? You 
may specify the undepreciated capital cost, additions and dispositions at the full 
cost, and DT Max will factor the amounts for both the percentage of co-ownership 
and the percentage of personal use. You may also specify the amounts per his 
share, net of personal use. To choose that option, use CCA-TYPE and select Partner 
level (enter prorated amounts). In that case, the amounts entered are not factored 
when calculating CCA.  
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¾ Where do I enter the amount from box 42 of a T3 slip? This amount 
represents a distribution or return of capital from the trust. It affects the value of 
the cost base of the mutual fund. 

This box is for information purposes only and as such, the amount should not be 
entered on the tax return.  

Note however that this amount represents a change in the capital balance for the 
mutual fund trust identified on the slip. Please refer to CRA publication RC4169 
titled Tax Treatment of Mutual Funds for Individuals for information on how to 
recalculate the ACB (adjusted cost base) in such a situation.  

 
¾ My client received a T5003. How do I enter the amounts from this slip? In 

some circumstances, namely in the case of a member of a limited partnership, the 
taxpayer will receive a T5013 slip in addition to the T5003. You may then ignore 
the amounts showing on the T5003 since that slip is provided for your information 
only. Indeed, the loss indicated in box 11 of the T5003 should match the loss 
showing on the T5013 slip. The same goes for box 10 (carrying charges), box 13 
(gift) and box 14 (federal political contributions).  

For taxpayers who receive a T5003 slip only, the loss shown in box 11 must be 
entered under the relevant keyword in DT Max. Potential keywords are BUSINESS, 
CAPITAL-GAIN (option ABIL), OTHER-DEDUCT, RESOURC-POOL, T-SLIP (option 
T101) and T-SLIP (option T5013). To figure out which keyword to use, take a look 
at box 12 to find out the principal business activity of the tax shelter. This will help 
you identify the line of the tax return where you should claim the loss shown in 
box 11.  

As for box 10, use the keyword INTCARCHARGE and enter the relevant description 
and amount. For box 13, use the keyword DONATIONS and for box 14, use the 
keyword POLITICAL. 

¾ Where should I enter the amount from box 138 of a T5013 slip? This 
amount is normally entered in a T5013 group under the keyword ITC-INVEST, 
option ITC Code 5 (at 15%). It will be carried to form 1229, part IV, and the end 
result will appear on line 6717 (total expense) of form T2038.  

¾ Where should I enter the amounts from boxes 62, 63 and 64 of RL-15? 
The amounts from boxes 62 and 63 should be entered by selecting the relevant 
options in the keyword RESOURCE-ADD within the T5013 keyword group. 

As for the amount from box 64, only corporations are entitled to the additional 
deduction. Therefore, you need not worry about entering this amount anywhere. 
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¾ Where do I enter information with respect to form T5004 (Statement of 
tax shelter loss or deduction) and Quebec form TP-1079.6 (Statement of 
losses, deductions and tax credits respecting a tax shelter)? DT Max will 
automatically fill out form T5004 from the tax shelter data entered (e.g. 
T5003/T5013) with the loss or deduction.  
Use the option Items to be added to schedule T5004 from the keyword T5004 only 
if you have more items to add to form T5004 as a result of DT Max not carrying 
the data automatically for one or more tax shelter losses or deductions claimed in 
the year.  

 
If DT Max does not generate form T5004, use the option T5004 - Override from 
the keyword T5004 to complete the form manually.  
 

¾ Why is DT Max not allowing me to limit the amount of tuition fees to be 
used federally by my client? The amount of tuition fees that a student must use 
in a given year is determined on line 13 of their schedule 11.  

Indeed, it is not possible for a taxpayer to claim a lesser amount of tuition fees in 
order to increase his/her taxable income for the purpose, for instance, of being 
able to take advantage of a dividend tax credit.  

¾ How do I tell DT Max whether or not my client is a hobby farmer?  
In the program, the phrase "hobby farmer" refers to a farmer whose farming 
activities are not the main source of income. That person may be a farmer on a 
part-time basis, or as a pastime. In order to indicate to DT Max that your client is a 
hobby farmer, enter the keyword HOBBY-FARM and select Yes. DT Max will then 
restrict the farm loss according to the lesser of the following amounts:  
 
(a) the farm loss for the year, or 

 

(b) $2,500 plus the lesser of:  

  (i) 1/2 (farm loss less $2,500) or 

  

  (ii) $6,250 
 
 If you enter a T5013 and select the option Farming, DT Max will assume that your 

client is a hobby farmer. The instalments will therefore be calculated on a quarterly 
basis rather than on an annual basis. 
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¾ My client paid foreign tax but cannot claim the full foreign tax credit on 
form T2209. Will DT Max calculate the deduction under subsection 20(12) 
automatically? Yes. However, DT Max does not always claim the optimal amount 
of deduction under section 20(12). In order to claim a different amount than what 
DT Max has calculated, use the keyword FOREIGN-OV with the option Deduction 
under section 20(12). 

¾ How do I limit the amount of net capital losses to be applied this year for 
my client? Use the keyword NET-CAP-LOSS and the option Limit of net capital 
losses to use.  

¾ Where should I enter the amount representing the closing inventory 
(including raw materials, goods in process, and finished goods) from line 
8500 of form T2124 for a taxpayer with business income? This information 
must be entered with the keyword INVENTORY in the option Inventory - end of 
year. It will be used in the calculation of the cost of goods sold on line 8518 of 
form T2124.  

¾ Before my client moved to another province from Quebec during the year, 
he was subject to the Quebec prescription drug insurance plan. Is he still 
required to file a Quebec tax return? Yes, the taxpayer must file a Quebec tax 
return reporting his income for the full year.  

To do so in DT Max: 

1. Access your client's file. 

2. Go into a plan. 

3. Change the province of residence (keyword PROV-RES) to "Quebec" and enter 
your client's information (you may also copy it from your production file). 

4. Using the keyword DRUG-INSUR, select the option Que. prescription drug 
insurance plan, exception, followed by Other, became resident of another 
province, and select the months your client was a resident of another 
province. 

5. Use the keyword OVERRIDE to override lines 450 and 465 of the Quebec tax 
return with the appropriate amounts.  

Print out the Quebec tax return and attach a note explaining that your client 
became resident of another province during the year.  
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¾ How do I handle the return of a client who paid instalments to RQ but 
moved to another province during the year? According to RQ, a taxpayer who 
wishes to have instalments reimbursed should file a tax return reporting no 
income.  To do so in DT Max: 

1. Access your client's file.  

2. Enter the Quebec instalments under the option Quebec instalments for the 
year of the INSTAL-PAID keyword. 

¾ How do I enter employment expenses? Use the keyword EMPLOYMENT-EXP to 
open a group that lets you enter the relevant data. In the keyword GST-REBATE, 
select Yes to enable the automatic calculation of the GST rebate application (form 
GST370) with respect to these expenses. The same procedure applies for the QST 
rebate, using the keyword QST-REBATE.  

 
¾ How do I enter data for the education or tuition credit and transfers? In the 

student's file, enter the keyword TUITION-EDU and select the option Taxpayer's 
own tuition and education amounts. Then, use the keywords SCHOOLMONTHS and 
TUITION-FEES to enter the number of months spent at a post-secondary institution 
and the amount of tuition fees paid, respectively. DT Max will transfer all or part of 
a student's credits to his or her spouse, parent or grandparent while taking into 
account the student's net income and personal credits. Use the keyword 
TRANSFEROV.T to modify the choice made by DT Max, e.g. if you want the unused 
tuition and education amounts to be carried forward rather than transferred.  

 
¾ How do I enter data for pensioners? DT Max uses the date of birth to calculate 

automatically the government old age security benefits received by a client. If, for 
some reason, the client did not receive the amount as calculated by DT Max, use 
the OAP-OV keyword to enter the actual amount received. For other keywords 
related to pension, press [F8] or the Keyword help index icon in the keyword data 
editor, select Alphabetical subject help, and view the entries for Pension.   
 

¾ How can I override DT Max's optimization of items such as as dividend 
transfers, medical expenses, charitable donations, provincial tax credits, 
etc.? To modify the optimization applied by DT Max to such items, enter the 
keyword OPTIMIZE in the file of the family head and use the options offered to 
specify how you wish to change the calculations. 

 
Please refer to the DT Max knowledge base for more information. 
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T2 TRAINING GUIDES  
 
Preparing a corporate tax return  
 
In order to complete a basic corporate income tax return with DT Max, the following 
data entry will be required.  

When adding a new client , tick any relevant options from the SmartStart client 
outline screen and click Continue. A series of keywords will appear from the section 
Identification, followed by the other sections you have ticked from the SmartStart 
client outline screen. (Please refer to the document titled The DT Max SmartStart input 
assistant for detailed information about this feature.)  
 
Use the keyword NAME to enter the name of the corporation. The fiscal year-end will 
be entered in YEAREND. A menu is provided for the keyword CORPTYPE, thus allowing 
the tax preparer to identify the particular type of corporation, for tax purposes.  
 
The keyword ACTIVITY is also provided with a menu. If, however, the relevant 
description is not found in the list, a customized description may be entered in the 
option Regular corp. (specify activity). The keyword PRODUCT allows the tax preparer 
to detail the main products and services provided by the corporation.  
 
The corporation's head office must be specified as well. The keyword ADDRESS heads 
a group of entries for all information pertaining to the company's head office, mailing 
address and location of books and records. Use the keywords CARE-OF, STREET, CITY, 
PROVINCE and POSTCODE to enter the relevant information. The tax preparer may 
use the keywords MAILADDRESS, BOOKSADDRESS and SENDINSTAL to specify the 
address to be used for these locations, thus preventing the need to re-enter addresses 
that have already been provided. The keyword CONTACTNAME should provide the 
name of the person responsible for handling inquiries. The keywords PHONE and FAX 
should be used to enter the relevant numbers.  
 
The keyword LANGUAGE allows the tax preparer to specify in which language the tax 
return should be printed. This only applies to the production copy of the tax return. 
The user still has the option to work and view the display in one language while 
designating another for printing.  
 
The keyword INCORPDATE is used to enter the date of incorporation. BEGINDATE 
indicates the beginning of the corporation's activities and is used for calculation. If a 
corporation's beginning date has not been entered and it is necessary for calculation 
purposes, DT Max will default to the incorporation as the beginning date.  
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The keyword JURISDICTION must be used at least twice. One entry will be necessary 
to provide the federal jurisdiction information (BUS-NUMBER and PAYROLLACCT), 
whereas a second entry will designate a provincial jurisdiction. Multiple provincial 
jurisdictions may be entered when needed.  
 
The group headed by the keyword CORPOFFICERS has multiple functions. It provides 
the information requested on the provincial jackets. It also allows you to designate a 
signing officer. To do so, you must select a combination among the options offered for 
this keyword. The NAME, SIN and TITLE are to be entered in the proper keywords. The 
individual's address would be entered in the keyword ADDRESS-OFFR, with specific 
information in CITY.E, PROVINCE.E, POSTCODE.E, PHONE.OFFR, and FAX-OFFR. Any 
signing date may be entered in the keyword SIGNDATE, also in this group.  
 
The financial information necessary to complete the corporate income tax return is 
first entered in the GIFI group. The GIFI (General Index of Financial Information) is an 
extensive list of financial statement items where each has a unique code (e.g. cash is 
"1001"). Use GIFI to indicate the source for the data, i.e. whether it is entered directly 
into DT Max from financial statements or imported from third party software. For more 
information on entering GIFI data in DT Max, see General Index of Financial 
Information (GIFI). 

Next is the group headed by the keyword NETINCOME. This amount represents the net 
income (loss) per the financial statements. Adjustments to net income for tax 
purposes would be made by using the keywords NET-INC-ADD and NET-INC-DED, 
which have a menu of the most common adjustments, although a more specific 
adjustment may also be entered under Other (specify). The keywords SALES and 
GROSSREVENUE allow for the entry of the relevant information as requested on 
various provincial tax returns.  

If the corporation makes a donation to a charity, use the keyword group CHARITY to 
enter the donation. Enter the actual amount and the charity number in the keyword 
AMOUNT.CH.   
 
A corporation's taxable capital information will be entered in the TAXONCAPITAL 
keyword group. At first, a question is asked as to whether or not the corporation is 
exempt from paying capital tax. The answer is usually negative. The keyword 
PAIDUPCAP includes a menu with a comprehensive listing of the various types of 
capital that are subject to capital tax. This keyword will be repeated until the tax 
preparer has completed the data entry and is ready to move on to the next relevant 
keyword.  
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A common item for most corporations is a capital cost allowance (CCA). Data entry 
begins with the keyword group CCA-CLASS. The tax preparer is first required to 
choose the appropriate class from the menu that comes with this keyword. Having 
done this, the opening undepreciated capital cost (UCC) should be entered in the 
keyword UCCOPEN. If this is a new CCA class, then the cost of the asset should be 
entered in the keyword ADDITIONS. An [Alt+J] function is available for these 
keywords, allowing the tax preparer to detail different jurisdictional amounts. A 
description of the asset may be entered in the keyword DESCRIPT-UCC.  
 
In addition, the tax preparer may specify whether the half-year rule should apply by 
using the keyword HALFYR-CCA, and indicate the purchase of an asset in the keyword 
DATEACQUIRED. Finally, the tax preparer can limit the amount of CCA claimed by 
using the keyword CCALIMIT.  
 
A corporation may claim a deduction for instalments that it has already paid with the 
keyword group INSTALPAID. This keyword comes with a menu allowing the tax 
preparer to specify the jurisdiction to which the data entered applies. The keyword 
TAXTYPE-INST also comes with a menu to identify the tax to which the payment 
applies. The keyword DESCRIP-INST allows the tax preparer to choose the type of 
remittance, whereas AMOUNT&DATE allows the tax preparer to specify what amount 
was paid, and when. The keyword group INSTALREC allows you to enter information 
required for instalments to be calculated for the next fiscal period.  
 
The last group of keywords in a client's data is CORPHISTORY. Normally, this merely 
consists of a carryforward of relevant data from the corporation's previous year's tax 
return. However, a situation may arise where even though a corporation has been in 
existence for quite a few years, this is the first year that the tax preparer is handling 
its return or that the DT Max program is being used to that end. In either case, 
relevant keywords are made available to enter the data requested on the various 
forms of the tax returns or used in certain calculations. Data commonly carried 
forward may be the prior year's taxable income (TAXABLEINC), fiscal year-end 
(PRIORYEAREND), and type of corporation (CORPTYPE.HIS).  
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Preparing CAIS returns  
 
I - CAIS identification and participant profile information (keyword CAIS) 
 

1. By default, DT Max designates the tax professional as the contact person. If this 
is not the case, enter the contact's name and address with CONTACT-NAME.  

 
2. If the contact has changed since last year, indicate it with NEW-CONTACT.  

 
3. Specify whether you are applying for an account, maintaining an account or 

closing an account with the keyword CAIS-ACCT.  
 

4. Specify other relevant information for the participant with PARTICIPANT.  
 
5. Enter the province of main farmstead with the keyword FARMSTEAD.  

 
 

6. Enter the first year of farming operations with the keyword FARM-OPENING.  
 

7. Enter the total area cultivated, owned or rented with the keyword FARM-AREA.  
 

8. Enter the method of accounting for CAIS with the keyword METH-ACCOUNT.  
 

II - Farming income & expenses 
 

1. Enter farming income and expenses derived from commodities with the keyword 
COMMODITY, by selecting the CAIS code number of the commodity.  

 
2. Enter the related data pertaining to each commodity: 

 
     commodity sales               SALES.N         

    commodity purchases        PURCHASES 
 
3. Each COMMODITY entered heads a separate sub-group in the CAIS group. All of 

the data pertaining to a commodity is kept together in the COMMODITY sub-
group. You may have multiple entries for SALES.N and PURCHASES, but only 
one entry is allowed for each COMMODITY. All commodities entered will be listed 
on the CAIS statement, without limitation. DT Max automatically determines 
whether the commodity is qualifying or non qualifying based on the province of 
main farmstead.  
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4. Program payments are entered with the keyword PROGRAM-PYMT by selecting 

the CAIS code number of the program.  
 

5. Enter repayments of program benefits as a negative value with PROGRAM-PYMT.  
 

6. Enter other farming income with the keyword OTH-FARM-INC. Such amounts 
will be recorded on the CAIS statement as Other farming income.  

 
7. Farming expenses are classified as eligible and non eligible expenses on the 

CAIS statement. Enter eligible expenses using FARM-EXPENSE, and non eligible 
expenses using OTH-FARM-EXP. These expenses will be recorded on the 
appropriate section of the CAIS statement.  

 
III - Other account information 

Partnership information is obtained from the data provided with PARTNER-INFO. 
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The General Index of Financial Information (GIFI)  
 
If this is the first time that you are entering GIFI data for a given corporation, you 
may find it helpful to display the typical GIFI data entry template on the right-hand 
side. Similarly, if this corporation's previous year data is available in DT Max, right-
hand side display will make current year data entry easier for you.  
 
You can also use the "edit-in place" feature to edit T2 GIFI data. In order to show GIFI 
totals in the editor, ensure that the box Show automatically calculated GIFI totals in 
the editor is checked in the option User interface of the Preferences menu.  
 
Entering your financial statement data directly into DT Max 
To enter GIFI data using DT Max, you must first enter the keyword GIFI. This keyword 
opens up a sub-group containing the keywords GIFI-FILE, GIFI-FORM and GIFI-
NOTES. Use the appropriate option depending on whether you will enter your financial 
statement data directly into DT Max or import a file. If you choose that option:  
 

1. Use the keyword SYNCHRONIZE and select the option Update NETINCOME and 
TAXONCAPITAL from GIFI to update the information from these keyword 
groups.  

2. Use the keyword GIFI-FORM to select the financial statement for which you 
want to enter data. Each financial statement may only be chosen once, except 
for the Supplementary income statements, which may be used as often as 
necessary.  

3.    For each financial statement selected, use the keyword GIFI-FIELD to enter or 
choose the relevant codes and amounts. Press [Enter] or double-click the field 
to open the GIFI code selector dialogue box. In this box, choose the option 
which corresponds to the financial information that you wish to record, then 
enter the applicable amount. DT Max will automatically total the amounts 
entered and place the result in the appropriate field. However, if you chose to 
enter data for Supplementary income statements,  
 

a. indicate the operating name of the operation with NAME-OP 
b. enter a description of the operation with DESCR-OP 
c. enter the sequence number for the operation with SEQUENCE 
d. before you begin to enter the relevant field codes and amounts.  

 
4. To submit notes to your financial statements with the GIFI, use the keyword 

GIFI-NOTES and enter the notes in text format.  
 



DT MAX USER’S MANUAL                                                                  T2 training guides           
 

                                                                                                                       163
 

5. Use the keyword CHECKLIST, available under the option Notes checklist in the 
sub-group GIFI-FORM, to select the option which best identifies who prepared 
the financial statements and the extent of their involvement. Under GIFI-
OTHER, in the GIFI-FORM sub-group, you may answer YES to other questions 
about the preparation of the financial statements by selecting the relevant 
option. Note that if you fail to select an option, DT Max will default to the 
answer No.  The CRA requires the notes checklist to be submitted with the 
GIFI data whether the T2 return is filed on paper (T2RSI) or electronically 
(EDI).  
 

Importing GIFI information from a file 
Standard GIFI files produced by third party software such as Simply Accounting or 
Caseware can be imported into DT Max. To import a file generated by accounting or 
audit software, simply go to the keyword GIFI and select Import in the data entry 
screen, or select Import GIFI from the File menu after opening the target corporation 
from the client list.  
 

1. Begin by entering the full path and filename of the GIFI file to be imported, or 
click Browse to navigate and locate the proper file on your system.  

 
2. Select the GIFI sections you wish to import: balance sheet, income statement 

and/or notes to financial statements. Generally, all these boxes should be ticked 
in order to import the complete GIFI file. Note that any existing data in the 
selected GIFI-FORM options will be overwritten by the imported data.  

 
3. You may also tick the box labeled Update NETINCOME and TAXONCAPITAL 

group data from GIFI. The information for these keyword groups will be updated 
from the GIFI data. Note that it is possible to update this keyword information 
without importing by unticking all items in the section Select sections of the GIFI 
file to import and only ticking the box labeled Update NETINCOME and 
TAXONCAPITAL group data from GIFI. 

 
 To proceed to the next step in the import process, click OK or Cancel to end the 

procedure.  
 
 
GIFI file import confirmation 
After selecting import options, you will be asked to confirm the GIFI file creation date, 
corporation name, and fiscal year-end as obtained from the GIFI import file.  
 
Click OK if this is the correct GIFI information and you want it imported into the 
current client, or click Cancel. 
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 SELECTED FAQ’S ABOUT T2 TAX TOPICS  

 
¾ Can a corporation fill out an Ontario CT23 tax return even though it 

qualifies for the Ontario filing exemption? Yes. By using the keyword CT23-OV 
and choosing the option Yes, you can produce a CT23 return despite being exempt 
from filing one. 

 
¾ Does DT Max optimize the provision for taxes? If you choose the option 

Optimize provision for taxes in the keyword OPTIMIZE, DT Max will determine the 
optimal amount of the provision for taxes that should be reflected in the financial 
statements of the corporation, and produce a schedule indicating the proposed 
adjustments for purposes of the optimization. Note that for a Quebec jurisdiction, 
two optimization methods are available. For more information, press [Ctrl+F8] on 
the keyword OPTIMIZE. 

 
¾ What is the best method for entering GIFI data in DT Max? Use the 

accounting closing trial balance as a reference. Note that a negative amount on the 
trial balance must be entered as a negative value for GIFI purposes as well. For 
instance, field 8500 titled Closing inventory is normally entered as a negative 
value.  
 

¾ How do I fill out GIFI form 140 titled Summary of income statements? GIFI 
form 140 is only required if a corporation produces more than one income 
statement, in which case the additional statements must be entered in option 125 
Supplementary income statements, under the keyword GIFI-FORM. Enter the 
sequence number in the SEQUENCE keyword. If multiple income statements are 
entered or imported, DT Max will produce GIFI form 140 automatically.  

 
¾ What is the difference between GIFI fields 8000 and 8089? Field 8000 - 

Trade sales of good and services should be used to show the total amount of sales 
whereas field 8089 - Total sales of goods and services is automatically calculated 
by DT Max. Therefore, you do not need to fill in that field unless you wish to 
override the result generated by DT Max.  

 
¾ What do I do if the financial data used to generate the GIFI import file 

changes? If, after importing the GIFI file, the financial data changes and an 
updated GIFI import file is produced, then the updated GIFI file must be imported 
into DT Max. Alternatively, if there are few changes or they are minor, you can 
manually edit or add individual GIFI items in DT Max. Of course, if you import again 
after having manually edited the data, these changes will be overwritten.  
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¾ How does DT Max handle GIFI contra account items? Contra account items 
such as accumulated amortization may appear as negative values in the original 
third-party software and GIFI import file, but will appear as positive values in      
DT Max after importing. This is intentional. DT Max subtracts the absolute value in 
calculations involving these items.  

 
¾ Does DT Max support the production of tax returns for insurance 

corporations and other financial institutions? DT Max will produce part I.3 and 
part VI tax returns in accordance with the option chosen in PART-I3-INST. Be sure 
to choose the appropriate option in the keyword ACTIVITY.  

 
¾ Where do I enter data for purposes of determining the capital deduction 

available for part VI tax?  In order to determine this deduction, enter the 
necessary data in the keyword group RELATEDPARTY. 

 
¾ Where do I enter the data needed to determine the tax on capital for a life 

insurance corporation? Enter the necessary data in the appropriate keywords, 
within PART-I3-INST. 

 
¾ How can I elect to pay a dividend from the capital dividend account with 

DT Max, pursuant to subs. 83(2) of the Act? Use the keyword DIVIDENDPAID 
and the option Div. paid out of the CDA (ITA 83(2). DT Max will then generate form 
T2054 (CO-502 for Quebec residents). You may also use CDA-BALANCE to enter 
the cumulative data used in the calculation of the balance of the capital dividend 
account. DT Max will produce a schedule showing the historical information for the 
capital dividend account.  

 
¾ Where do I enter eligible life insurance policy proceeds for purposes of the 

calculation of the capital dividend account? Use CDA-LIFEINS in the CDA-
BALANCE group to enter the eligible amount of life insurance policy proceeds. 

 
¾ How do I enter the information pertaining to multiple dispositions of 

depreciable assets within a CCA class? You can enter multiple dispositions 
within each relevant CCA-CLASS by using the keyword DISPOSAL. However, if the 
CCA class is liquidated, you must also select Yes in the keyword LIQUIDATE then 
enter the net proceeds.  

 
¾ Where do I enter taxable preferred shares in DT Max? Enter information 

pertaining to taxable preferred shares in the PREF-SHARES keyword group. 
Schedules 43 (elections) and 45 (agreements) pertaining to taxable preferred 
shares may be completed by using the keywords ELECTION-PS and PART-VI1 
respectively. 
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¾ How do I calculate a capital gain refund with DT Max? Use the keyword 

CGDIV-PAID to open the group of keywords that will allow you to calculate the 
capital gain refund on federal schedule 18. 

 
¾ How can I generate schedule 47 (Canadian film or video production tax 

credit) with DT Max? To produce that particular form, use the keyword CRED-
FILM and select the form that you wish to generate among the options available. 
DT Max will then provide you with the necessary keywords to fill out the desired 
schedule.  

 
¾ Where do I enter relevant information to complete form T106? The 

keywords necessary to complete the T106 (Information return of non-arm's length 
transactions with non-residents) are available in the NONRES-TRANS keyword.  

 
¾ How do I enter information on foreign affiliates in DT Max? Use the keyword 

FOREIGN-AFF to open the group of keywords that will allow you to enter the 
information necessary to complete federal schedule 25. 

 
¾ Where do I enter information to identify a person to whom labour 

payments were made? Enter the appropriate amount in the keyword 
COSTOFWORK, found in the LABOUR-COSTS group, and you will then have access 
to the keywords that are required for the entry of information relating to the 
identification of that person.  

 
¾ Where do I enter the data needed to fill out an application for the forest 

producers' real estate tax refund in Quebec? Enter the relevant data in the 
keywords found in the option Quebec of the LOGINCOME group. DT Max will 
calculate the real estate tax refund on form FM-220.3. 

 
¾ How can I limit the non capital losses applied to part IV tax? DT Max 

automatically reduces part IV tax by the previous year's unused non capital losses, 
or by the current year's non capital losses. Use the keyword LOSSLIM to limit the 
amount of losses being applied and choose Non capital loss as the type of losses 
you wish to limit. Then, under the keyword TAXREDUCED, select the option Apply 
to part IV tax and enter the amount you wish to apply.  

 
 
¾ Why doesn't the program produce a schedule 27 when I indicate with 

M&PPROFITS that the corporation is eligible for the M & P deduction? In 
addition to indicating that the corporation is eligible for the M & P deduction, the 
corporation's activity must be indicated as being either Canadian M & P or Other 
manufacturing & processing with the keyword ACTIVITY. 
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¾ The amounts I entered in the SR&ED keyword group are not reported onto 

form RD-1029.7. To complete form RD-1029.7, you must enter the amounts in 
the SR&EDTAXCRQ keyword group. 

 
¾ Why am I unable to produce an RD-1029.7 (supp.) form even though I 

appear to have entered all the necessary data? In order to produce this form 
titled Partnership workchart for eligible salaries and wages, you must ensure that 
the entry in the keyword NAME.RE, in the RELATEDPARTY group, is identical to the 
entry made in the PARTNER-NAME keyword, in the SR&EDTAXCRQ group. You must 
also enter a value in the keyword MEMBER-INT, in the RELATEDPARTY group. 

 
¾ How do I enter a capital gain reserve that was claimed in the prior year, 

and one that I want to claim this year? DT Max will automatically bring into 
income the amount of the reserve that was taken last year unless you override this 
amount by entering a different value in the IN-INCOME keyword, in the RESERVE 
group. Use IN-RESERVE to enter the amount of the reserve claimed this year with 
respect to capital gains reserves on current year disposals. 

 
¾ Does DT Max produce resource schedules? Resource schedule 12 will be 

produced when data is entered in the RESOURCE keyword group. This schedule is 
used by corporations claiming resource-related deductions. Undeducted resource 
expenditures will be carried forward under the keyword RESOURCEPOOL.  
 

¾ How do I enter adjustments to Ontario net income for purposes of 
calculating the CMT base on schedule A of the CT23 return? If the filing 
corporation is subject to CMT, use the keyword ONTCMTADJUST found in the 
NETINCOME keyword group to enter adjustments to net income on schedule A of 
the CT23. 

 
¾ How do I enter a corporation's change of status or address, a new fiscal 

period, or other changes that occurred during the current fiscal period? 
 Use the keyword STATUSCHANGE, then select the option pertaining specifically to 

the information that you wish to modify. 
 
¾ How do I indicate a change of directors that occurred in the year? If there 

has been a change of directors since the last annual return was filed, use the 
keyword CHANGE-DIR in the CORPOFFICERS group to indicate the change. Then, 
use the keyword DATE-ELECTED to enter the date that a new director was elected, 
and use the keyword DATE-CEASED to indicate the date that the previous director 
stepped down, if applicable. 
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¾ I need to file an annual return in accordance with the Canada Business 
Corporations Act. Can I do it with DT Max? Yes. You can complete an annual 
return with DT Max by using the appropriate keywords found in the keyword group 
ANNUALRETURN. 

 
 
¾ How do I fill out form T1141 (Information return in respect of transfers or 

loans to a non resident trust)? The keyword FOREIGN-INFO will open the group 
and allow you to select which information return you would like to complete. 
Choose T1141 and the keywords needed will be available.  

 If a person, or a foreign affiliate of a person, transferred or loaned property to the 
non resident trust or to a non resident corporation controlled by the trust, use the 
keyword TRUST-INFO to enter the name of the non resident trust.  

 The keyword TRUSTPARTY will allow you to identify the various types of parties 
involved with the trust. Based on the choices made, the relevant keywords will be 
made available for entry of requested information.  

 All transaction summaries may be entered in the appropriate keywords which will 
be provided once you indicate the type of transactions you will be reporting with 
the keyword TRUST-TRANS.  

 

¾ How do I fill out form T1142 (Information return in respect of distributions 
from and indebtedness to a non resident trust)? The keyword FOREIGN-INFO 
will open the group and allow you to select which information return you would like 
to complete. Choose T1142 and the keywords TRUST-INFO, TRUST-DISTR and 
TRUST-INDEBT will be available.  

 Use the keyword TRUST-INFO to enter the name of the non resident trust from 
which the reporting taxpayer, at any time in the taxation year, received funds or 
property, or to which he was indebted.  

 The keyword TRUST-DISTR will allow you to indicate the type of foreign property 
that you will be reporting as received from a non resident trust. Once you choose 
the type of foreign property, the relevant keywords needed to complete the form 
will be made available for data entry.  

 If the reporting taxpayer was indebted to a non resident trust at any time in the 
taxation year, use the keyword TRUST-INDEBT to open the group of keywords 
needed to complete this section of the T1142 form. 
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¾ How do I indicate that a corporation is eligible for a tax reduction or 
holiday in a particular province? The keyword PROVTAXREDUC should be used 
to indicate that the corporation is claiming a province's tax reduction or holiday.  
DT Max will then calculate the income tax based on the amount of the allowable 
reduction or holiday. 

 
 
¾ In DT Max, how do I indicate that the corporation has ceased its activities 

for purposes of box 29 (status change) on page 1 of the CO-17 return? Use 
the keyword STATUSCHANGE and the option Final year due to winding up. 

 
 
 

Please refer to the DT Max knowledge base for more information.  
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T3 TRAINING GUIDES 
 
Preparing a trust tax return   

 

In order to complete a basic trust return with DT Max, the following data entries will 
be required.  

When adding a new client, tick any relevant options from the SmartStart client outline 
screen and click Continue. A set of keywords will appear on the screen from the 
permanent sections Identification and Income, and from any other sections you have 
ticked from the SmartStart client outline screen.  

Use the keyword TRUST-NAME to enter the name of the trust. Use the keyword ACCT-
NUMBER to enter the federal account number for the trust, and the keyword ID-
NUMBER if the trust is a resident of Quebec. The fiscal year-end is entered under the 
keyword YEAR-END. The keyword LANGUAGE allows you to specify in which language 
the tax return should be printed. This only applies to the production copy of the tax 
return. You still have the option to work and view the displayed tax return in one 
language while designating another for printing. Use the keyword TRUST to select 
either Testamentary or Inter vivos from the drop-down menu, then expand the group. 
Use the keyword TRUST-TYPE to select the correct type of trust. Use the keyword 
RESIDENCE to select the province or territory of residence of the trust. Use the 
keyword DATE to enter the date of death (testamentary) or the date of creation of the 
trust (inter vivos). If filing a return for a testamentary trust, enter the social insurance 
number of the deceased.  

Use the keyword TRUSTEE to enter the name of the trustee, the keyword TITLE to 
enter their title, and the keyword ADDRESS to enter the trustee's address that will 
automatically appear both as the mailing address on the return and as the issuer's 
address on the information slips generated by DT Max. If you wish to have a different 
address than that of the trustee's appear as the mailing address on page one of the 
return, use the ADDRESS keyword in the TRUSTEE group and select the option Mailing 
address (if different than trustee's). Enter the signing date of the return under the 
keyword SIGN-DATE.  

Use the keyword BENEFICIARY to enter the status of the recipient of income from the 
trust. If no income is to be allocated, the beneficiary information is not necessary. In 
the BENEFICIARY keyword group, use the keyword ALLOCATION to specify how the 
income of the trust is to be allocated to each beneficiary. Enter as many beneficiaries 
as required.  
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Use the keyword ALLOCATION-TYPE to enter the type of allocation to trust 
beneficiaries (either by percentage or fixed amount). Use the keyword INCOME-TYPE 
to specify the type (income, capital gains, or income AND capital gains) and 
percentage or amount of income to be allocated.  

The following example illustrates how DT Max allocates the income of the trust in the 
case of multiple beneficiaries:  

Beneficiary A is to receive a fixed amount of $ from all sources of income, 
while beneficiary B is to receive a % of only the residual income of the trust. 

Method 

Enter beneficiary A using ALLOCATION-TYPE and Fixed amount, then INCOME-
TYPE and Income and capital gains, and enter the ($) amount to be allocated. 

Enter beneficiary B using ALLOCATION-TYPE and Percentage, then INCOME-
TYPE and Income, and enter the (%) value to be allocated. 

The tax liability generated by the unallocated income of the trust, which is 
remaining in the trust, will then be calculated as payable by the trust.  

Use the keyword INCOMESOURCE and select the appropriate type of income of the 
trust (pension, foreign pension, dividends, other investment, foreign investment, 
limited partnership (loss), other). If none of the options available apply, leave this 
keyword blank.  

Use the keyword CAPITALPROP to enter the relevant type of capital property.  

Use the keyword BUSINESS to enter the business type and prepare a statement of 
business income and expenses.  

Use the keyword TOTAL-INC-DED to enter the various types of deductions and 
expenses used to arrive at net income.  

The keyword DONATIONS is used to enter the various types of charitable donations 
made in the course of the year, whereas the keyword AMOUNT-CF is used to carry 
forward the amount of donations not claimed in prior years.  

Enter the type of taxable benefits with the keyword TAX-BENEFIT, and the amount 
with AMOUNT.  

Use the keyword LOSS-CF to enter the type, year, and unused amount of losses 
carried forward from prior years. Note that for existing clients, this information is 
automatically carried forward by DT Max.  
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Use the keyword LOSS-CB to enter the type, year, and amount of losses to carry back.  

Use the keyword group INSTAL-PAID if you want the trust to claim a deduction for 
instalments already paid.  

The keywords OTHER-FIT and OTHER-PIT enable you to enter other federal or other 
provincial income tax deducted at source. 

Use the keyword TAX-CREDITS to select the jurisdiction of the tax credit and then 
select applicable credits for that jurisdiction.  

The keyword CAP-HISTORY allows you to enter the capital gains (losses) historical 
information from prior years. Note that for existing clients this information is 
automatically carried forward by DT Max.  

In the case of a T3 slip (Quebec RL-16 in Quebec) and T3 summary (no Quebec 
equivalent), if the trust is testamentary, the words "Estate of" will precede the name 
of the trust by default.  

The keyword NOTES allows you to enter any notes or reminders you wish to keep for 
future reference.  
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SELECTED FAQ’S ABOUT T3 TAX TOPICS 

 

¾ Where would I find detailed information with respect to amounts being 
allocated to the beneficiaries of a trust? DT Max produces an in-house form 
entitled Beneficiary income allocation that provides detailed information regarding 
trust income and capital gains as well as taxes and credits to be allocated to each 
beneficiary.  

 A separate schedule will automatically be generated for each beneficiary entered 
under the BENEFICIARY keyword group.  

 

¾ How does DT Max handle the apportionment of expenses to different 
source of income? The apportionment of expenses to different sources of income 
is done in such a way as to allow for the maximum flow-through of credits to the 
beneficiary. 

For example, if the beneficiary has both interest income and dividend income,      
DT Max will allocate the expenses to the interest income first because this way, the 
beneficiary can get a dividend tax credit.  

 
 

Please refer to the DT Max knowledge base for more information.
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SOFTWARE SUPPORT 
 

The Dr Tax software support service  
 

The best ways to get software support 
If you need help using DT Max, you can contact our support team via the methods 
described below.   
 
Support is available year-round during normal business hours (9:00 a.m. to 5:00 p.m. 
Monday through Friday). During March and April, support hours are expanded (8:00 
a.m. to 9:00 p.m. on weekdays, and 9:00 a.m. to 5:00 p.m. on Saturdays and 
Sundays).  

 
We offer assistance by email, by fax, by telephone, and on our Web site. Greatest 
speed and efficiency will occur in this order.  
 
The basic package provided to our clients includes the two or three CD versions 
released every year, and the assistance provided by our support team. When deemed 
necessary, interim versions and patches are available on our Web site only.  
 
Help yourselves! 
The fastest and most efficient method of support is helping yourself. Use the 
knowledge base to find answers to your questions. Better yet, set someone up to be 
the DT Max expert in-house, then make sure that he or she gets all the information 
required to fully understand the program. Have them attend DT Max workshops!  

 

The DT Max knowledge base 

The knowledge base, accessible by pressing [F7] or by selecting Knowledge base from 
the Help menu, provides you with an online information database which should have 
all the information you need to support yourself and your firm throughout the tax 
season. You can view all the DT Max documentation and jump easily between 
references and documents by clicking the hyperlinks that connect related information.  

 
Among its many features is the What's new? bulletin, which informs you of the latest 
changes to the program and refers you to relevant files in the knowledge base to look 
up further information, whereas the FAQ’s (frequently asked questions) report typical 
questions asked by our users and which we feel may be of interest to all. Among those 
are the Known issues, which document glitches encountered in using the program.  
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Installing the knowledge base 
To install the knowledge base, DT Max will create a sub-directory named "kb" from 
your main DT Max directory. Do not delete this sub-directory. When installing DT Max, 
you will be given the option to install the knowledge base in one language only or in 
both languages. If you choose not to install it in both languages, note that the button 
that gives access to the other language (if you are viewing the knowledge base with 
Netscape or with Internet Explorer) will still appear on the documents. It will prompt a 
"URL not found" message as it will not be active.  

 
Updating the knowledge base 
The knowledge base is updated as new information becomes available. This may 
include tips and hints on how to use the program better, answers to frequently asked 
questions (FAQ's), information on changes, improvements or problems in the program. 
After receiving the first version, new documents will be mentioned in What's new? and 
include hyperlinks to the corresponding, more complete document.  

 
You will receive updates to the knowledge base with every new version of DT Max. 
However, you may download updates on a more timely basis from our Web site. We 
encourage you to do so.  
 
Remember that the online knowledge base is updated daily during the tax season. 

 
Access to the knowledge base 
To access the knowledge base from DT Max, choose any of the following options:  

 
� Go to the Help menu, and choose Knowledge base. 
 
� Press [F7].  
 
� Press [Ctrl+F8] while in the client data entry screen. (In this case, DT Max will 

bring you to the explanation of what the keyword does, not to the knowledge 
base index.)  

 
� Press [F1] from various places in the program. (In this case, DT Max will provide 

context-sensitive help about that particular area.)  
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The easiest way to access our site from within DT Max is by choosing DT Max on the 
Web from the Help menu and then clicking Knowledge base on the top bar. From 
outside DT Max, run your browser and open the file that you want. If you access it 
frequently outside DT Max, it may be useful to set "bookmarks" to the index to the 
knowledge base and the index to frequently asked questions if you use Netscape. If 
using Internet Explorer, set those pages as "Favorites".  
 
Context-sensitive help 
 

How to use [F1] 
If you need help using DT Max, first consult the context-sensitive online help, 
available at almost every stage of the program simply by pressing [F1].  

 
How to find a keyword with [F8] 
While working on a client's file, pressing [F8] or clicking the Keyword help index 
icon will give you three ways to locate a keyword: by reference to a subject index, 
to a line number on the jacket, or to a form number.  
 
Find out what a particular keyword does [Ctrl+F8] 
If you want to know what a particular keyword does, or how DT Max handles a 
particular calculation, press [Ctrl+F8] when a keyword is selected in a client file or 
in the [F8] help, and a brief explanation will appear.  

 
Support methods 
 

By email 
To get an answer as quickly as possible, send your questions and receive your 
replies by email. Use the Dr Tax software support request form, accessible by 
selecting Software support from the Help menu in the DT Max program. 
Alternatively, you can access any email program, provide the same information and 
email it to us at support@drtax.ca.  
 
Over the Internet 
To enable you to get software support quickly and without spending time waiting 
on the phone, you may wish to consult the DT Max knowledge base on our Web 
site. On the DT Max knowledge base page, select the Search option on the left and 
enter key items you wish to search for in the entire knowledge base. All references 
to these terms will be returned. Select the appropriate documents from the results 
and you should find the answer you are looking for.  
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By fax 
Select the Software support option from the Help menu, and click Software support 
request form. Fill out the form, print it and fax it to Dr Tax at (514) 733-8058. A 
member of the software support team will quickly get back to you by fax or by 
telephone.  
 
By telephone 
If you wish, you can also reach our software support team by calling the Dr Tax 
support lines at (514) 733-8355 in Montreal, or toll free at 1 (800) 663-7829.  
 
Please be prepared to provide our dispatchers with the following information:  
 

• Your name 
• The name of your firm 
• Your licence number (found in your licence file) 
• The support category of your question (one of the following):  

1. Installation and setup  
2. DT Max features  
3. Keyword help  
4. T1 tax calculations  
5. T2 tax calculations  
6. T3 tax calculations 
7. Efile errors  
8. Electronic transmissions  
9. Printing  
10. Other  

 
The user who calls for software support should be the person most familiar with   
DT Max in your office. When they call, a software support file will be opened and 
this person's name will be entered as the contact. This file will remain open and 
retain its position on the support queue until all questions from your firm have been 
addressed. Any additional questions will be added to that support file. This will 
enable us to monitor our support service more efficiently, ensure that you maintain 
your priority on the telephone queue, and that the caller (possibly your DT Max 
expert) has all the information required to help support your firm.  
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Answering your call 
When a support person handles your call, they will seek more specific details regarding 
your problem and will then look it up in the knowledge base. If the problem is 
documented and the solution has already been released, they will show you how to 
find it. This will help prepare you to support yourself the next time.  
 
If the problem is documented but the solution has not yet been sent to you, the 
support person will send it immediately by email or by fax.  

 
If your problem has previously been brought up and an answer is currently being 
prepared, the support person will let you know.  

 
If the problem is not yet documented, they will ask you to send all the relevant 
information needed to diagnose the problem. An expert will work on the problem and 
someone will contact you when a reply is ready.  

 
This procedure will save us all a lot of time and will help ensure that the solution you 
are given is satisfactory.  
 
Support tools 
 

The software support request form 
Use the software support request form to contact Dr Tax and be sure to provide all 
the information requested. This will enable our support team to proceed faster and 
more efficiently.  
 
The Dr Tax licence number 
Whenever you need to get in touch with us, please have your Dr Tax licence 
number handy. This will give us easy access to your support file.  
 
The anonymous extract 
If you have a data entry problem which you feel requires providing Dr Tax with the 
client's keywords, create an anonymous extract. The anonymous extract gathers all 
the information contained in your client's file, with the exception of the client's 
name and social insurance number. This feature is available in the DT Max Help 
menu, under Software support.  
 



Software support            DT MAX USER’S MANUAL 

                                                                     180   

The diagnostic report 
If you have a technical support problem that requires you to provide Dr Tax with 
information about your system, you can create a diagnostic report. From the Help 
menu, choose Software support, then Diagnostics, and click the button “Generate 
report”. This will generates audit reports detailing the software and hardware 
configurations of your machine. Audit reports help diagnose and solve problems 
related to configuration such as missing files, wrong DLL versions and incorrect 
registry entries.  

 
Information required for technical support 
If you have any of the following problems, be ready to provide the information listed 
below when contacting Dr Tax for technical support service.  

 
Problems installing DT Max  
� make and model of your computer 
� amount of memory (RAM) 
� size of the hard disk 
� list of memory resident programs being used (if any) 
� type and version number of network software being used (if any) 

 
Problems running DT Max  
When you create a diagnostic report, the information displayed on your screen 
provides a great deal of detail about your computer system and the environment in 
which DT Max is running. This will help in diagnosing problems.  

 
Problems with tax calculations  
� description of how the results differ from your expectations  
� printout of the database record of the client (and family) or anonymous extract 
� version number of DT Max program used for this specific calculation 

 
Problems with printing  
� make and model of your printer 
� copy of the Windows printer test page 
� copy of the printer's technical manual  
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The Dr Tax software support request form  
 
The software support request form is the most efficient way to contact Dr Tax and get 
support quickly. It is available from the Software support option of the Help menu. 
 
Please provide all the information requested so that we can expedite your request as 
quickly as possible.  
 
Procedure 
In the software support request form dialogue box: 

 
1. Fill in the identity information fields 

Identity information defaults to the tax preparer information but can be further 
customized. If your request is a follow-up question, please include the original 
support number you have been assigned. If the name or email address of the 
support person who initially helped you are not known, enter "support" and 
"support@drtax.ca" respectively. 

 
2. Describe your problem 

First, click Please select the topic that best corresponds to your problem. The 
button Show FAQ's brings you to the knowledge base and allows you to look 
for existing FAQ's related to the topic you have selected. You can also try using 
the Search tool in order to find other related documents. Once you are done 
with the knowledge base window, close it, go back to the previous window, 
and click Continue if you still need help on this topic. Complete your request by 
describing your problem as best you can. Please be as specific as possible so 
that your request can be assigned to the support person who is most qualified 
to solve that particular type of problem. 

 
3. Select attachments as relevant 

If you crash or encounter errors, please attach a diagnostic report. Similarly, if 
you experience tax calculation problems, attach an anonymous extract to your 
email. Anonymous extracts are automatically created when ticked for the 
current client or marked clients. Note that attachments are not part of the 
Print function. 

 
4. Click Email to Dr Tax or Print 

Select Email to Dr Tax or select Print in order to fax your request to Dr Tax 
support at (514) 733-8058. 
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